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1 INTRODUCTION

Nucleus is an operation and management system that controls fuel and general merchandise sales.
The system supports a maximum of 24 fueling points and 24 Customer Activated Terminals (CATS).
Nucleus uses an Ethernet link for system communication and a satellite for communication with the
credit card network.

2 NUCLEUS EQUIPMENT
The system is built around the following:
e Store Controller
e Up to 8 Indoor Processing Terminals (IPTs)
Each Nucleus IPT supports the following peripheral equipment:
e Touchscreen
e Cash Drawer
e Receipt Printer
e PIN Pad (ICAT)
e Customer Display Unit (CDU)
e Report Printer (Store Controller)
e UPS
e Bar Code Scanner (optional equipment)
e Satellite Communications (Store Controller only)
e QWERTY keyboard (used for configuration and programming only)
e Mouse (used for configuration and programming only)
NOTE:Access pathways to all windows included in this manual are specified in bold.

Become familiar with the Nucleus components in the following diagram.
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OPTION #1
— Receipt Printer Cable
_ : . (5) 120V AC
(5) 120V AC Receipt Printer Cable Power Outlets s ol
Power Outlets — Scanner Cable \ canner Cable
AV
| / \e -
(o)
i
Fujitsu ~ —11— o Iﬁ Ed
geport/4
D_Edgeponm SciPT
| 000 | "
? [ Ethernet | [ae] 16" MIN. (] 167 MIN.
Hub
O g —
o
— . Co [ !
T
[ i I Report Ethernet Primary
Report Fujitsu SC/IPT Primary ~ Printer Hub Distribution
Printer Distribution UPS Cabinet
uPs Cabinet
. W=42" MIN.
re—————— W=40" MIN. ———— D=21" MIN.
D=21" MIN.
OPTION #3
 Receipt Printer Cable
(5) 120VAC -
Power Outlets
Scanner Cable
= 1l )
Fuiitsu -I: Iﬁ Edgeport/4
SC/IPT il
= 18" MIN.
|
L Ethernet Hub
[TTm M1 Primary
Distribution
Cabinet
Report - L- Report
upPs — Printer Printer
Transformer
W=40" MIN.
D=10" MIN.
Figure 2-1 Nucleus Hardware Components (Under Counter)
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Figure 2-2 Nucleus Hardware Components (Above Counter)
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3 NUCLEUS PROGRAMMING MAP

- Save Logs
File Close
Ring Up
- Operations_
Programming
Policies Site Setup
Each
About / Tier Timer
Clock
Employ Site
Tank This
Pump // Logos
IPT
CAT —_— | Site
- Security Camera [T Each
Peripheral Configuration Logos
Backup Settings
Back Office Configuration Backup Configuration
Tier/Feature Save Backup to CD
Loyalty
Site Group
Mannatec Department
Machine Configuration Grade
Port Configuration
Money Order Interface / Group
Audit Backup CD Department
Product
Fuel / Car Wash
Tender Time Restrictions
Financial ——m™ Lottery
Discount Classifications —]
Tax Fuel Prepay
Price Modification Opening Balance
Service Charge Closing Balance
House Accounts Safe Drop
Vendor Accounts Paid In
Currency Setup Paid Out
Cash Back
Current BAC Refund
Sales AR Collect
Configuration Safe Loan
Period to Date
Bill Acceptor Refunds Offerings
PLU List Mix-N-Match
SKU Combo
Hourly Sales Iltem List
Tank Inventory
Mix-N-Match Unsecured
PLU Z / Secured
Iltem Sales Query
Mail
Full Serve Attendant Reports Components
Carwash Cash Reconciliation Variable Tracking
Employee Time Tracking PTD Configuration
Archived Terminal Z
Setup Full-Serve Attendant
Pump Totalizers
Network Configuration PLU and SKU Configuration
SSIMS Configuration Day Configuration
Echo Test
Parameter Download
Print Parameter Table
Toggle React Flag
Stick Reading
Manual Fuel Drop
Close Batch

Figure 3-1 Nucleus Programming Map
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4 PROGRAMMING OVERVIEW

This chapter contains information about programming the Nucleus system. The programming
instructions are presented in the same order that they are shown in the programming menus.

The management and programming functions are accessed from the Indoor Payment Terminal
Touchscreen (IPT) or from a QWERTY keyboard. The IPT is the terminal from which a person may
control the activities of the Nucleus system. The QWERTY keyboard is used to enter any text
required in certain programming selections.

5 MAKING PROGRAMMING SELECTIONS

Access programming menus from the Operation Screen using the IPT. See the following screen in
Figure 5-1.

;43 19 Thu 11429/07
WAYNE ACCESS[4]

Credit Card

Cash Change Due:

Cancel
| Journal
| View

Quantity

Tax

Total

Figure 5-1 Operations Screen

/N cauton

Wayne recommends performing all programming changes to the Nucleus system on the Store
Controller /IPT 1. Accessing the database and making changes to the database from more than
one IPT at atime can yield unpredictable results.

The ability to make programming changes to the system is limited by pre-programmed security
levels assigned to the user. This screen is displayed when the system is operating normally and a
cashier is logged onto the system. From this screen, you can access the various system
management and programming menus.

15
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5.1 Accessing Programming Menus from the IPT

16

For ease of use, the remainder of this document will reference different areas of programming
assuming that the user is already at the Programming Access window. Command pathways will be
listed in each example as beginning from the Programming Access window.

NOTE:Throughout this manual examples of programming screens will be shown that will have
some areas grayed out. This is an indication of a function that is not supported in the present
configuration.

1. To access the Programming Access window, touch the Nucleus Button on the IPT
touchscreen.

Lls,—_.tw 19 Thu 11429707
BT 2 WAYNE ACCESS[4]

Figure 5-2 Nucleus Button

2. The Nucleus button pull down appears after you touch the Nucleus button. Touch the
Programming option.

Logoff

Security Override
One Shot
Programming
Save Logs
Change Password

Figure 5-3 Nucleus Button Pull-down

3. The Programming Access window will appear. See Figure 5-4.

Programming Access[ 4]

File Security System Cash Register Reports  Mebwork

Figure 5-4 Programming Access Window

The Programming Access window is the access point for system programming. Command
pathways used in the remainder of the document will assume that the user is already at this window.

4. Touch or use the mouse to select any of the choices displayed above to enter that area’s
programming. Continue touching/selecting menu options until you access the programming
window that you want to program.

Example: System > Pump > Each > Modify will take the user to the Pump Options window.
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5.2 Accessing Menus Using the QWERTY Keyboard

1. To access menus on a system with the QWERTY keyboard attached, touch the Nucleus button
on the IPT. Select Programming to display the window shown above.

2. Once in the administration level, you make selections at the Programming Access Window by
pressing the appropriate alphabetic (alpha) key on the QWERTY keyboard while holding down
the ALT key. The alpha key for the command is underlined in the name of the function in any of
the programming screens. (For example, the F in the File function and the S in the Security
function in Figure 5-4.)

3. Navigating through the remainder of the programming screens using the QWERTY keyboard
does not require that you hold down the ALT key to select menu items. Simply press the alpha
key to access these screens.

5.3 File Function Pulldown

To see the main selections under the File pull-down, hold down the ALT key and press F. The
system displays the Save Logs and Close selections. See Figure 5-5.

Programming Access[ 4]
FEM Security  System  Cash Register  Reports  Mebwork

Save Logs
Close

Figure 5-5 Programming Window - File Pulldown

e Use Save Logs when instructed by the Wayne Help Desk. The purpose of the Save Logs is to
capture the environment of the system at the time of the problem. If you press S on the
keyboard the Save Logs function is activated and the system will save the log files to a zip file.
The following prompt will appear which is asking for confirmation that the save logs function has
been requested.

Do you want ta zave the log files?

Figure 5-6 Save Logs Confirmation
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e Click OK to proceed. The utility will save logs and create a zip of the contents and assign a
name to it upon completion. A window similar to the following acknowledgement window will
appear.

Logs zaved ta file: 0F0E1119.2IF

Figure 5-7 Save Logs Acknowledgement Window

The Save Logs acknowledgement window comes up showing what file name the log files were
saved to. Press Close to exit the Save Logs window and return to the Programming Access window.

e The other option under the File pulldown is Close which is used to exit the Programming Access
window and return to the Operations screen.

NOTE:File Close should always be used when exiting the programming screen. Exiting the
programming screen using other methods such as touching outside of the programming box to
return to the Sales screen may cause problems when trying to re-enter programming later.

18

Part No. 2-920494 Rev. G August 2008



6 SECURITY LEVELS PROGRAMMING

This chapter contains information about setting up the security levels for cashier Ring Up
operations, security for system Operations and system Programming security. During programming,
each employee is assigned a system security level. When an employee is signed on and performing
a transaction or task, the system compares the employee’s security level to a currently-selected
function. If the security level for the employee does not match, or is not higher than the required
access level, the system bars the employee from using that function and displays the message,
“Insufficient Security Level.”

Four levels of security are available and may be selected for the areas displayed in the Security
Levels Window if the present user is logged on with Level 4 access. Typically four security levels are
sufficient.

e Level 1 allows selection and operation of the least number of functions, while Level 4 allows
selection and operation of the majority of the other functions. Assign Level 4 as the site
manager’s security level.

e Level 5isreserved and Level 6 is available only through the One Shot utility.
IMPORTANT:Any settings in the default database that have been set at Level 6 are grayed-out.

Assign higher levels to experienced employees involved in the management of the station that
require access to more security sensitive parts of system programming and operation. In turn,
assign lower security levels to new and less experienced employees to minimize the chance for
accidents.

6.1 Ring Up Security Levels

Ring Up security levels control what security level a cashier has to have to perform a Cancel Item,
Refund, or Price Override. To access the Security Level programming section of the system, per-
form the following steps.

1. From the Programming Access window select Security. The system will display the Security
pull down menu. See Figure 6-1.

Programming Access[ 6]

File BN System  Cash Register Reports  Bebwork
Ring Lp
Operations
Prograrnming
Palicies
Security Tools
CISP PABP Compliance

Figure 6-1 Programming Access Window

2. Select Ring Up to display the Ring Up Security Levels menu. SeeFigure 6-2.

19
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6.2

20

Ring Up Security Levels

Cancel Item:

Refund:

Price Override:

A -
1 -
1 -

Ok | Lancel |

Figure 6-2 Ring Up Security Levels Window

3. Select the Cancel Item pull down menu to program the appropriate security level to perform a
cancel function. See Figure 6-3.

Ring Up Security Levels

Cancel ltem: 1 P

Refund:

Frice Override: 1 P

Figure 6-3 Ring Up Security Levels Window

4. Select the Refund pull down or the Price Override pull down to program the appropriate
security level.

5. Touch OK to save and exit or Cancel to exit without saving.

Operation Security Levels

Operation security levels control what security level a cashier must be to perform functions that usu-
ally require a manager, such as closing the day and generating a Day Report or closing a shift. Cash
register functions such as No Sale and Credit Return also fall under this category. Ringing up an
undefined item is included in the Operation Security Levels programming screen to limit the ability of
a cashier to ring up undefined items which do not appear with a price in the database.To access the
Operation Security Level programming section of the system, perform the following steps.

To access the Operation Security Level programming section of the system, make sure you have
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the proper security level then perform the following steps.

1. From the Programming Access window select Security > Operations. The Operation Security
Levels window opens as shown in Figure 6-4 below.

Operation Security Levels

Mame Security Level
Report Operation | ay 2
Fieport Operation | Cloge Shift
Purmp Operation | Allow Postpay

Purmp Operation | Prepay Only

Cash Register Operation | Mo Sale

Sales Lag Dperation | Print

Feport Operation | Cloge IPT

Purnp Operation | Manual Tank Reading

Purnp Operation | Manual Fuel Drop

Cazh Register Operation | RingUp Undefined ltem
Cash Register Operation | Credit B eturn

waf | of o rafraf raf e wo | ro |8

Lloze |

Modity selected entry

Figure 6-4 Operation Security Level Window

2. Select the name of the operation that you want to modify then choose Modify. The
programming window for that operation is shown in Figure 6-5 below.

Report Operation | Close Day

Security Level e

Ok | Lancel |

Figure 6-5 Security Level Modification Window

3. Select the appropriate Security level from the Security Level pull down menu.

4. Press OK to save and exit or select Cancel to exit without saving.

21

August 2008

Part No. 2-920494 Rev. G



6.3 Programming Security Levels

Programming security levels control what security level a cashier has to have to setup or modify
certain programming parameters of the Nucleus system. Programming the system should be done
by managers or trained Wayne service technicians. To set up the Programming Security Level
section of the system, perform the following steps.

NOTE:Read and Write security levels cannot be programmed for values higher than the security
level of the current user who is logged on.

1. From the Programming Access window select Security > Programming. The Programming
Security Levels window opens as shown below in Figure 6-6.

Programming Security Levels

Write Level

Read Level

Operations
Security Levels | Programming
Security Levels | Policies

Cash Register | Fuel | Group
Cash Reqister | Fuel | Department
Cash Register | Fuel | Grade
Cash Register | Mon-Fuel | Group
Cash Reqister | Mon-Fuel | Department
Cash Register | Mon-Fuel | Product
Cash Reqister | Mon-Fuel | FLU
Cash Reqister | Tender

Cazh Renister | Tandear | Check

Y [y ey Y N Y P P Y ey
I FS S PR S TP

Lloze |

Modity selected entry

Figure 6-6 Programming Security Levels Window

2. Choose the programming section that you want to set a security level for, then touch Modify.
The Security Levels Modification window opens as shown in Figure 6-7.

System | Employee

Read Security Level: Thaaaaae -
‘wiite Security Level 3 -

Ok | Lancel |

Figure 6-7 Security Levels Modification Window
3. Set both the Read Security Level and the Write Security Level from the pull down menus.

NOTE:Read Security Level refers to the security level required to view settings. Write Security
Level refers to the security level required to change settings.

4. Press OK to save and exit or Cancel to exit without saving.

6.4 Security Policies

Security Policies programming is used to program the system password functionality to be CISP
compliant. To access this screen the user must have a security level 6. The options of the Security

22
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Policies window are detailed below. .

NOTE:For details on Employee Security Levels programming see Section 8.3 on page 20.

1. From the Programming Access window select Security > Policies. The Security Policies
window opens as shown below in Figure 6-8.

Security Policies _

— Lockout Settings

Logon Attempts Allowed: I 3
Lockout Time in Minutes: I a0

¥ | Require Fassword Expiration

[~ Require Entering of ser Mame on Logon Screen

¥ Lock User Out on Lagarn Failure &ttermpts

¥ Use Strong Pazswords B F'tas.sword Settihg 1

Minimum S ecurity Level For Strong Password: |1_

Password Strength——————————————————— Minimum Length For Employes Mame: Ig_
¥ | Allovw &lphanumeric Characters Iinimum Length For Indoor Password: I?_
I Humbers Minimum Length For Dutdoor Pazsword: |2_

¥ Lawerease Lefiers Default Days Before Pazsword Expires: |35_

I Uppercase Letters M aximumn D ayz Before Pazsword Expires: Igg_

I Allow Special Characters Mumber of Expired Passwords: |4_

Mote: Pazsword szettings will be enforced for all new employees. modified
employees. and as old passwords expire.

Ok | Lancel |

Figure 6-8 Security Policies Window

Require Password Expiration - Enabling this option will require password expiration at the
site. This means that at the end of a predefined period of time, the current password will
expire and a new password will need to be chosen before the user will be allowed to logon.

Require Entering of User Name on Logon Screen - Enabling this option will require the
user to enter the User Name during logon rather that selecting the user name from the drop
down list. This setting is disabled by default.

Lock User Out on Logon Failure Attempts - Enabling this option will require that the user
account that has failed to logon after 6 failed attempts, is locked out. The lockout for that
user account will remain in force for 30 minutes - no exceptions. The lockout however does
not affect other IPTs or other user accounts. This setting is enabled by default.

Use Strong Passwords - Enabling this option will require all system users to begin using
“Strong” passwords. Any user that is not currently using a strong password will be required
to change to a strong password at their next logon. This setting is enabled by default.
“Strong” passwords are defined as consisting of:

* minimum of 8 alpha-numeric characters
e cannot contain more than 3 consecutive characters from the employee id
» contains elements from the two criteria listed below:

- lowercase letters (a through z)

- humbers (0 through 9)

NOTE:Full-serve outdoor attendants will continue to have only numeric passwords.
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*  Password Strength - This section allows the use of additional password elements to
enhance the strength of the employee logon passwords. Numbers and lowercase letters are
enabled by default for “strong” passwords. Uppercase Letters and Special Characters (
i.e. l, #, $, etc...) can be enabled to add additional strength to the password.

*  Lockout Settings - Logon Attempts - Enter the number of failed logon attempts that will
be allowed prior to the account being locked out. (default = 6).

*  Lockout Settings - Lockout Time - Enter the number of minutes that the locked out
account will remain unavailable following a lockout. (default = 30).

*  Minimum Security Level for Strong Password - Defines the minimum security level that
Strong passwords will be required. (default = 1)

*  Minimum Length for Employee Name - Defines the minimum number of characters that
are required for an employee account name. (6 to 12 characters) (default = 6)

*  Minimum Length for Indoor Password - Defines the minimum number of characters that
are required for an indoor employee account password. (7 to 14 characters) (default = 7)

*  Minimum Length for Outdoor Password - Defines the minimum number of characters
that are required for an outdoor employee account password. (2 to 14 characters) (default =
2)

*  Default Days Before Password Expires - Defines the number of days that a password will
be valid. (default = 35)

*  Maximum Days Before Password Expires - Defines the maximum number of days that
can be used for the previous entry. This value is fixed and cannot be changed.

*  Number of Expired Passwords - This is the number of expired passwords that are
remembered by the system and not valid as new passwords. (default = 4)

2. Touch OK to save and exit or Cancel to exit without saving.

Security Tools
The Security Tools window provides access to security functions that are used to enhance the secu-
rity of the Nucleus system.

From the Programming Access window select Security > Security Tools. Three options are
available in the Security Tools window. See Figure 6-9.

Security Tools

(" Clean Drive Space
= Mask Account Mumbers
 Delete Old Sales Logs

Erecute

Figure 6-9 Security Tools Window
» Clean Drive Space - This utility should only be run by trained Nucleus service personnel.
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As part of the the Nucleus upgrade process and to be CISP PABP compliant, two options are
available here which are meant to deal with the old or archived Sales Logs that may have customer
account numbers in the clear. The user will have the option to either:

» Mask Accounts in Old Sales Logs - Enable this option to mask all of the account numbers in
the archived journals.

» Delete Old Sales Logs - Enable this option to delete old reports, sales journals, and the
back-up directories.

Select the option to run and click Execute.

NOTE:Only one option at a time may be selected.

CISP PABP Compliance

The CISP/PABP Compliance window is a view-only status of the current state of the security func-
tions that are a requirement of CISP/PABP Compliance. This view provides information only and the
check-boxes cannot be checked or unchecked with the exception of the Enable CISP Compliance
box..

When the Enable CISP Compliance check-box is disabled then the individual programming options
listed in the status section can be modified. When this check-box is enabled then the individual pro-
gramming options listed in the status section can only be modified to bring the system into CISP
Compliance. Once the individual programming options have been changed to be CISP compliant
then further modification will not be allowed as long as Enable CISP Compliance is enabled. The
system has reached full CISP compliance once all of the check-boxes have been checked.

From the Programming Access window select Security > CISP PABP Compliance. See Figure 6-
10.

CISP PABP Compliance

= Statu %
) ) The following criteria must be checked off to
Security functions b be in compliance:
status [¥ Cleaned free space on hard drive

¥ Updated/Deleted archived sales logs

¥ Employes passwords expie

¥ Using strong passwords

¥ Employes pazswords comply with CISP PABP
¥ Lock out employes on falled logon attempts
¥ Automatic Pause set at or below 15 minutes
¥ Encryption Key is current

¥ FTF iz dizabled

¥ Methios iz dizabled

QK Lancel

| )

Figure 6-10 CISP PABP Compliance Window

6.6.1 Inactive Employee IDs

In order for Nucleus to be CISP compliant, there is a requirement that any employee ID that has
been inactive for 90 days will be automatically removed from the system. Nucleus tracks employee
IDs for activity and when an ID has been unused for 90 days it will be removed automatically by the
3 A.M. cleanup process.
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7 SYSTEM PROGRAMMING

System programming allows you to set up the basic operational structure for the Nucleus system.
The following window displays the programming options located under the “System” menu.

Programming Access] 6]

File Security WM Cash Register Reports  Metwork

About;

Clock.

Employee

Tank

Purnp 3

IPT ¥

AT 3

Security Camera
Peripheral Configuration
Backup Settings

Back Office Configuration
TierjFeature

Loyalty

Site

Mannatec

Machine Configuration
Part Configuration
Money Order Interface
Audit Backup CD 3

Figure 7-1 Programming Access Window

7.1 System About
The About Nucleus screen contains information about what version of software is currently installed.
1. From the Programming Access window select System > About. The system displays the

“About Nucleus” window which details the Nucleus application version number, the Nucleus
base version number, and the Nucleus database version information. See Figure 7-2.

About Nucleus

Model Nucleus
Manufacturer : Dresser Wayne. Dreszer. Inc.
Application Yersion: CHO400 db: 40.0004

Base Yersion: N1700D db: 17.0005
Database: RORD

NTEP CC No.: 96-159

Copyright 1994-2006 Dresszer. Inc.
All Rights Reserved

Figure 7-2 About Nucleus Window

2. Touch OK to return to the Programming Access window.
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System Clock Programming
1. Access this window by selecting System > Clock.

2. The system displays the Set Time and Date programming window. Use this window to program
the time and date for the Nucleus system. See Figure 7-3.

Set Time and Date

Hour Min :
Time
27 i i
-
Maonth Day Year
7 B 2004

| Lancel |

Figure 7-3 Set Time and Date Window
3. Choose OK to save changes and exit or choose Cancel to exit without saving changes.

NOTE:The Chevron Host Network automatically updates the date and time. If the date and/or time
are incorrect on the Nucleus system, contact the Retail Technology Support Center (RTSC) at 1-
800-435-7277 for assistance.

System Employee Programming
The employee programming section allows you to create, alter, or delete employee information.

/N WARNING

WARNING!

Do not delete the employees entitled “WAY NE ACCESS’

Doing so may prevent the system from functioning properly.

WARNING!

The Nucleus system is equipped with Employee Security features which are designed to limit
access by unauthorized users to restricted areas of the system programming. Employee access is
controlled by a Security Level which is assigned to each employee when that employee is
programmed into the system. The Employee Security Level also controls access to certain functions
in the system that can be restricted to employees with a higher security level. See the following list
of security features for details.

e Employee passwords can be programmed to expire after a certain number of days. This
prevents old employee IDs and passwords from remaining active indefinitely.
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Nucleus will remember the 3 previous passwords used by an employee. This will prevent the
same password from being used by an employee over and over.

Employees can change their password at any time. If an employee feels that his or her
password has been compromised then the password can be reset immediately.

A minimum of 6 alphanumeric characters must be used for a User Name.

A minimum of 7 alphanumeric characters must be used for an indoor employee account
password. This prevents the use of short passwords that might be guessed easily.

A minimum of 7 numeric characters must be used for an outdoor employee account password.
This prevents the use of short passwords that might be guessed easily.

NOTE:If an employee type is programmed as an Outdoor Attendant then the password length can
be as few as two characters.

2.

Passwords will not be viewable. This prevents someone with mid level security from obtaining
the password of an employee with a lower security level.

Passwords can only be reset by users with a Security Level 4. This prevents employee
passwords from being deleted by unauthorized persons and also requires that only authorized
users be allowed to assign employee passwords.

Security Level 4 is the highest level available for an employee.

Duplicate user names will not be allowed.

The system can be programmed to enter a “Paused” state after a certain time period of
inactivity. The currently logged on employee will need to re-enter the user password to return
the system to normal operation. A pause override feature will allow a user with a higher security

level to resume a paused session. The user who resumes the session is recorded in the journal
but sales are still tracked to the original user until that user is logged off.

A Service level password will be required to obtain access to the XP Desktop. This password
can only be obtained through the Chevron RTSC at 1-800-435-7277. Refer to the Nucleus
Operations manual for information on the Oneshot function.

Access the Employee Programming window by selecting System > Employee. The system
displays the following window. See Figure 7-4.

Employee Programming

Employes Employee D Security Language -

Englizh [L.5.] .

WwWATYNE ACCESS 1 4 English [L.5.)

Bemove | Modify | Clone... | Lloze |

Add a new entry into the database

Figure 7-4 Employee Programming Window

Use the Employee Programming window to add or remove employees and to modify the
security level of new or existing employees.
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7.3.1 Adding Employees

1. To add an employee, open the Employee programming window. Access this window by

selecting System > Employee.

2. Choose Add to open the Modify Employee window.

Modify Employee

Employee Type

" Dutdoor Attendant

™ DOther Employee

&+ |ndoor Cashier/Manager M ame:

Employee |d:

Pazsword:
Confirm Password:

Security Level: Language

I =] [Engishius) =l

Dayps Until Password
Expires

e

Feset Password | Ok | Lancel |

Figure 7-5 Add Employee Window
3. Enter the Employee Type

* Indoor Cashier/Manager - for employees and managers who use the Nucleus system
indoors to ring up sales and who may pump gas as an Outdoor Attendant.

* Qutdoor Attendant - for employees who pump gas and perform transactions at the island
only.

*  Other - any other person employed at the site who will be clocking in and out of the Nucleus
system but is not a cashier or outdoor attendant.

4. Enterthe Employee Name, Password, Confirm Password, Security Level and the number of
days before the employee password expires. See Figure 7-5.

NOTE:For a site to be CISP/PABP compliant, employees must have complex passwords. A
complex password consists of 8 characters using elements from three of the four criteria listed
below:

*  uppercase letters (A through Z)

*  lowercase letters (a through z)

*  numbers (0 through 9)

* non-alphanumeric characters (i.e. !, #, $, etc...)

NOTE:Employee type must be programmed properly for the Time Tracking feature to work
correctly.

NOTE:Language programming is not supported in this release.

NOTE:A minimum of 6 alpha-numeric characters, spaces and underlines are valid characters to
use in the Name field. A minimum of 7 alphanumeric characters are allowed in the Password field
and the Confirm Password field for indoor cashiers.

NOTE:If an employee type is programmed as an Outdoor Attendant then the password length can
be as few as two characters. This is a limitation of the keypad that an outdoor attendant has
available to use. A two character password for use by an outdoor attendant is still CISP compliant.
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5. Select Reset Password to delete the employee password so that a new password can be
entered. (A security level of 4 or greater is required to perform this function)

6. Press OK to save and exit or Cancel to exit without saving.

NOTE:If on a multi-terminal system, a new employee is created on one terminal and another
terminal is at the logon screen but a name has not yet been selected, then the new employee will
not become available on the second terminal until the <CLEAR> button is pressed then the <Sales>
button is pressed.

7.3.2 Removing Employees

To delete an employee, highlight his/her entry in the Employee Programming window and select
Remove. A Confirm Remove Operation window will be displayed which will require the user to press
OK. See Figure 7-6.

The file record is deleted from the data window. A security level of 4 is required to perform this
function.

Confirm Remoye Operation g|

?/I OF ko Remave item From Employee List?

e
Ok | Cancel |

Figure 7-6 Confirm Employee Deletion

7.3.3 Modifying Employee Programming

1. To modify an employee, open the Employee programming window. Access this window by
selecting System > Employee.

2. From the Employee Programming window touch Modify.

Modify Employee

Employee Type Employee Id: l—
+ Indoor Cashier/Manager Marme: o
" Dutdoor Attendant Pazsword:
" Other Employee Confirm Password:
Security Level: Language

I =] [Engishius) =l

Dayps Until Password
Expires

e

Feset Password | Ok | Lancel |

Figure 7-7 Modify Employee Window
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3. The Modify Employee window allows you to modify the employee type, employee name,
password, security level and set the number of days before the employee password expires.
See Figure 7-7.

NOTE:For a site to be CISP/PABP compliant, employees must have complex passwords. A
complex password consists of 8 characters using elements from three of the four criteria listed
below:

e minimum of 8 alpha-numeric characters
e cannot contain more than 3 consecutive characters from the employee id
» contains elements from the two criteria listed below:

- lowercase letters (a through z)

- numbers (0 through 9)

NOTE:A minimum of 6 alpha-numeric characters, spaces and underlines are used in the Name
field. A minimum of 7 alpha-numeric characters are allowed in the Password field and the Confirm
Password field since the keypad for logon now contains alpha-numeric characters.

NOTE:If an employee type is programmed as an Outdoor Attendant then the password length can
be as few as two characters. This is a limitation of the keypad that an outdoor attendant has
available to use. A two character password for use by an outdoor attendant is still CISP compliant.

4. Select Reset Password to delete the employee password so that a new password can be
entered.

NOTE:A security level of 4 or greater is required to perform this function.
5. Choose OK to save and exit or Cancel to exit without saving.
6. Touch Close on the Employee Programming window to exit.

7.3.4 Full Serve Attendant Programming

If an employee type is programmed as an Outdoor Attendant then the password length can be as
few as two characters. This will enable the Outdoor attendant to log onto the CAT using just the two
character password.

7.3.5 Cloning Employees

To add an employee entry with duplicate programming to the Employee Programming window,
highlight the entry that you want to duplicate, then select Clone. Highlight the new entry, select
Modify and make changes if necessary.

7.3.6 Full Serve Attendants

When an employee type is programmed as Outdoor Attendant, the password length restriction will
be removed to allow the entry of only 2 digits, so that an Outdoor Attendant can log onto the CAT
with the entry of only 2 numbers as the password. Only employees marked as Outdoor Attendant or
Indoor Cashier/Manager will be allowed to log on to Full-Serve CATs.

If a site has employees that work both as cashiers and outdoor attendants, they can create an
Outdoor Attendant employee record with the Employee Type set to Outdoor Attendant. That
employee can use the employee id and the shorter password from the Outdoor Attendant employee
record when signing on outside and use their name and indoor cashier employee record when
signing on to Nucleus or clocking in/out.
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7.4 Tank Programming

The Tank Programming window displays the grades for each tank and allows you to enter new
grades. The station’s underground fuel tank setup determines the grade you assign to a tank. The
programming window allows you to select the correct fuel type that resides in a specific tank.

NOTE:Grades must be programmed into the system prior to tank programming. Access the grade
programming by selecting Cash Register > Fuel > Grade.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the programming to take full effect. For additional information on performing a shutdown
and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of the
Operations Manual (Part No. 1-920494).

From the Tank Programming window, tank to grade information can be added, removed, or
modified. These features allow individual tanks to be defined and its grades to be selected.

Access this window by selecting System > Tank. See Figure 7-8.

Tank Programming

Tank Grade -~
Tank 2 Unleaded
Tank 3 Supreme
Tank 4 Digzel
Bemove Modify... | Clone... | Lloze |
Tank Gauge Configuration. .. |
Add a new entry into the database

Figure 7-8 Tank Programming Window

7.4.1 Adding Tanks
1. To add a tank, touch Add to display the Tank Programming window. See Figure 7-9.

Tank Programming

Name: Tark 1

Grade: Plus Unlead -

= (¥, s 0 0 0 0 0

Tank Gauge Mumber
o ®E2 @7 Wi @5 ®E @7 W@

WARMING: System must be restarted for these
changes to take effect.

Qg Lancel
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Figure 7-9 Tank Programming Modify Window

2. Enter the name of the tank you wish to add, then assign a grade to the tank from the Grade pull-
down menu.

3. Select OK to save and exit or choose Cancel to exit without saving.

7.4.2 Removing Tanks
NOTE: You will not be allowed to remove tanks unless all references to the tank are removed from

the Grade Assignments window.

1. To remove a tank, select the name of the tank that you want to remove then touch Remove.
2. The Confirm Remove Operation will appear. Select OK to confirm the operation.

3. Select OK to save and exit or choose Cancel to exit without saving.

7.4.3 Modifying Tanks

1. Select Modify from the tank programming window and choose which tank gauge number to
assign to the tank/grade being programmed. See Figure 7-8.

NOTE:If the tank gauge is not enabled, the Tank Gauge Number group is grayed out.

2. Select OK to save and exit or choose Cancel to exit without saving.

7.4.4 Tank Gauge Programming

Nucleus does not understand the tank ID used by the Tank Gauge to uniquely identify the fuel tanks
and fuel product grades. In order to maintain synchronization with the Veeder-Root compatible tank
gauge, an ID field is used to map a fuel product grade to a tank ID. This tank ID is used as the
address to communicate with the TLS-250. The Tank ID must match the wiring and setup of the tank
ID at the TLS.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the Tank Gauge programming to take full effect. For additional information on performing
a shutdown and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of
the Operations Manual (Part No. 1-920494).

To program the Tank gauge select System > Tank > Tank Gauge Configuration. The Tank Gauge
Configuration window will appear. See Figure 7-10.

Tank Gauge Configuration

[~ iTLS-250 Compatible Tank Gauge Installed

WARMING: System must be restarted for this
change to take effect.

Ok | Lancel |

Figure 7-10 Tank Gauge Configuration Window

1. To enable Tank Gauge, check the box labelled TLS-250 Compatible Tank Gauge Installed. To
disable Tank Gauge, un-check the TLS-250 box.

2. Press OK to save and exit or Cancel to exit without saving.
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7.5 Pump Programming

Pump programming allows you to select programming options that are necessary when setting up
the pumps in a station. Nucleus now supports Competitive Pump programming from within Nucleus.
See Site Programming on page 88. Also see the Competitive programming section which details the
programming of Gilbarco or Tokheim dispensers.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the programming to take full effect. For additional information on performing a shutdown
and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of the
Operations Manual (Part No. 1-920494).

7.5.1 Pump Programming - Site

1. Access this window by selecting System > Pump > Site Setup.

2. Use the Pump Site Programming window during station startup programming to enable Price
Levels, Tiers, Service Levels, and Full Service. If tiers are enabled, you can program the
names for tiers 1 and 2 as Day or Night.

Pump Site Programming

Tiers: Service Levels: [~ Enable Price Levels: [~ Enable
. T -
frigh o =] :

FullServe: [~ Enable

WARMING: System must be restarted for the ch below to take effect.
Duplex 1| Submerzible Pump Contral Fuel Yalume Limit
Electranic [~ Site
CC Interface 930

Enabled  Board Board  Channel  Addiess [™ Unattended Ornly
H| SFC 1 & 1 30

[~ spC2 1 & 2 30

Ok | Lancel |

Figure 7-11 Pump Site Programming Window

a. Check the Enable box to activate the use of Price Levels if available. If Price Levels is not
enabled then the system will use Credit Price as the sole unit price of fuel, if however Price
Levels is enabled then both Credit Price and Cash Price will be available for programming.

NOTE:The Price Levels function is only available with Wayne dispensers.

NOTE:Chevron does not support the use of dual pricing at the dispenser. Cash and Credit pricing
should be the same. Consult with your local Business Consultant before implementing this feature.

NOTE:"Some state laws governing the display of motor fuel prices on dispensers or price
signs include requirements and limitations on the display of a motor fuel price discount.
Users are responsible for knowing and complying with any such laws that may apply to
them. Users should not use any feature that allows for discounting the price of motor fuel
unless they have determined that the feature may be used without violating any such law."
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Check the Enable box to activate the use of Tiers. When programming tiers, make sure
Tier 1 is the less expensive level. If tiers are disabled, any pumps set to Tier 2 must be reset
to Tier 1.

Check the Enable box to activate the use of Full Serve at the pumps. This will enable an
attendant to handle the fuel purchases as well as any items such as oil that may be
available for purchase at the island. The attendant will be able to handle most cash or credit
transactions at the pump.

Check the Enable box to activate the use of Service Levels. When setting up service
levels, make sure the service levels are unique. For example, Self and Full are acceptable
settings, but Self and Self are not. Also be sure Service Level 1 is the less expensive level.
Normally Service Level 1 is set to Self and Service Level 2 is set to Full. Mini is a service
level that is used in Oregon and for sites that sell fuel but no other services. If service levels
are disabled, any pumps set to Service Level 2 must be reset to Service Level 1. See
Figure 7-11.

Fuel Volume Limit - The Fuel Volume Limit field is used to enter the maximum fuel volume
amount that may be dispensed from a pump during any one transaction. This is useful for
meeting the safety requirements for an unattended site or for gas rationing purposes. Click
the Site checkbox to turn the fuel volume limit on for the entire station. Click the Unattended
Only checkbox to turn the fuel volume limit on for the entire station only during the times
that the system has been put into Unattended Mode.

NOTE:When using the Fuel Volume Limit function with Gilbarco pumps, keep in mind that Gilbarco
pumps do not support both money and volume limits. As a result, whenever the Fuel Volume Limit is
set, the lowest priced fuel grade at the time of the transaction will be used to calculate the dollar
amount of fuel that can be dispensed. This dollar amount is set prior to the selection of a fuel grade
and will be used to determine when to stop the pump regardless of the grade selected.

NOTE:Unattended mode is not for use in Canada due to local safety regulations.

NOTE: Consult with your local Business Consultant before implementing this feature.

3.

4.

The Duplex Il Submersible Pump Control programming section is used for setting up sites
that are installing SPC interface units that use additional communication lines for optional
equipment to be installed at the pump.

Select OK to save and exit or choose Cancel to exit without saving.

7.5.2 Pump Programming - Each

The Pump Programming window shows the number of fueling points controlled by the system and
each pump’s Auto Auth and Auto Pay settings. Access this window by selecting System > Pump >
Each. See Figure 7-12.
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Pump Programming

No Auto Auth

1
2 Day Mo Auto Pay
3 [ay Mo Auto Auth Mo Auto Pay
4 [ay Mo Auto Auth Mo Auto Pay
5 [ay Mo Auto Auth Mo Auto Pay
E [ay Mo Auto Auth Mo Auto Pay
7 Day Mo Auto Auth Mo Auto Pay
8 [ay Mo Auto Auth Mo Auto Pay

Remave | Muodify... | Clone...

-]

Lloze |

Add a new entry into the database

Figure 7-12 Pump Programming Window

7.5.2.1 Adding and Modifying Pumps

To add a pump to the list of dispensers, select Add. To change pump settings, select Modify. When
you select Add or Modify, the Pump Options window appears. See Figure 7-13. This programming
window allows you to set Pump type options, authorization and payment options, and tiers and
levels of service selections.

This window also allows you to program Fuel flow rates and volume pre-cutoff amounts,
Communications settings, Grade to fueling point position, Pump tier and price level, and Push to

Start Prompts.

Pump Options

Make and Model: |/ z00e <_\
Ty Push To Start Tier
v & None + Day v Allow PostPay
" MGD UniHoze C ™ Might I~ Allow PostPay Toggle
& (" Start Bar Level ¥ Has
&+ SELF
& " “ellow Fuel Key
& UL
-
W alid Positions
-~ } ¥,
MGD with Buttons v 1 v 2 v 3 4 = E &
WARMING: Syst must be ted for these ch to take effect.
Settings... FPositions.... Fuel Flow... ‘ ‘ Comm...

x|

LCancel ‘

This window will
display the currently
defined dispenser
brand. Either Wayne,
Gilbarco or Tokheim

Figure 7-13 Pump Options Window for Dispensers

From the Pump Options window, you can program:

e Number

The number window shows the fueling point number currently being programmed.
e Make and Model
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The Make and Model window displays the currently programmed pump manufacturer for the pumps
at the site. This information is programmed from Programming > System > Site.

e Type
The Type programming option defines the pump type. Available options are:

*  MGD Multi Hose - Multi-grade dispenser with multiple hoses (Use this option for Gilbarco
brand dispensers)

*  MGD Uni Hose - Multi-grade dispenser with one hose (Use this option for Gilbarco brand
dispensers)

*  FRB - Fixed ratio blender dispenser
*  VRB - Variable ratio blender dispenser
*  VRB PLUS - Variable ratio blender dispenser plus one pure grade

*  MGD with Buttons - Multi-grade dispenser, usually a Wayne DL style dispenser with grade
select/push-to-start buttons

e Tier

Use Tier programming to enable Day and Night price tiers for different fuel prices for different
periods of the day.

NOTE:Auto Auth and Auto Pay options can also be set for different tiers. The options available are
Day and Night.

e Level

Level programming allows you to select one of two pricing levels for service types: SELF or FULL.
*  SELF - Customer dispenses fuel.
*  FULL - Attendant at pump provides full service to customer.

e Allow Post Pay and Allow Post Pay Toggle

This programming option enables or disables the Allow Post Pay and Allow Post Pay Toggle
options.

*  Allow Post Pay - This option allows the cash customer to pump fuel prior to payment.

*  Allow Post Pay Toggle - This option allows the cashier to enable or disable the Post Pay
function from the Options screen. Only pumps that have this option set will toggle the Post
Pay function when commanded.

NOTE:If Allow Post Pay toggle is enabled and the Pre-Pay Only button in the Pump Operations
window is pressed then the pump/site will reflect in the CAT idle prompt that the customer must pre-
pay the fuel purchase. However while in this mode if a nozzle is lifted the pump will call the system
for authorization and the cashier may authorize the pump for a post pay fuel sale if desired. In
addition any or all pumps may be authorized while in Pre-Pay Only mode either individually or by
using the All Auth button.

e Push to Start - Prompts

Push to Start - Prompts configures Nucleus to require the customer to press a button in order to
begin fueling.

*  None - Does not require a button press but will require a second action such as a lift to start
mechanism or a slide to start mechanism to begin fueling.

*  Select Grade - Requires that a Grade selection be made to begin fueling.

*  Start Bar - Requires that a Start Bar be pressed to begin fueling.
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*  Yellow Fuel Key - Requires that the Yellow fuel key on the CAT keypad be pressed to begin
fueling.

e Valid Positions

This programming option defines the positions at each fueling point. Valid positions are
automatically set (highlighted) when the pump is identified. For example, 4 positions are available
with the MGD. In order to verify correct operation, you must confirm the pump type and positions
programmed at the pump is required.

e Settings
Select Settings in the Pump Options window to bring up the Day Settings window. See Figure 7-14.

Day Settings

Authorize Pay
} % Mo Auto Pay

O IF At Auth
i Auto Pay

Ok | Lancel |

Figure 7-14 Day Settings Window

*  Authorize - The authorization options No Auto Auth and Auto Auth allow the user to select
the type of authorization control required for each fueling point. Selecting the Day or Night
tier from the Pump Options screen in Figure 7-13 allows the user to program authorization
options for day or night.

*  No Auto Auth - This option requires the operator to authorize each calling pump when
a nozzle is lifted (post pay or cash sale). The fueling point is under IPT control.

NOTE:No action is required from the cashier if a credit or debit card is used at the pump and the No
Auto Auth option is selected.

*  Auto Auth - This option allows the Nucleus system to authorize the fueling point
automatically when the nozzle is lifted (post pay or cash sale). This setting does not
prevent the card reader from taking over the sale as long as the card swipe takes place
before fueling begins.

*  Pay - The pay options No Auto Pay, If Auto Auth, and Auto Pay allow for fuel payment
control at the site.

*  No Auto Pay - This option requires the cashier to clear and finalize all cash sales.
Sales must be paid at the terminal.

* |f Auto Auth - Sales automatically authorized are automatically cleared through the
terminal. These sales require no cashier control.

*  Auto Pay - This option allows the system to clear and finalize the sale at the pump
without a cashier present. Sales are automatically paid through the terminal. No action
is required by the cashier. The Auto Pay option allows the sale to be recorded in the
Auto Pay Details totals in the Shift and Day Reports.

IMPORTANT:Dispensers with CATs utilizing the SELF level of service require settings to be No
Auto Auth and No Auto Pay.

e Positions
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Select Positions from the Pump Options window to bring up the Positions window. See Figure 7-15.
Programming options allow you to assign grades to the fueling point positions.

Tank/Grade

Position 1 Tank 2 - Lnleaded (Low]
[ Tank 1 - Plus Unlead
|Tank 3 - Supreme [High)

Pasition 2

Pasition 3

L Lefled LefLefLefLs

Ok | Lancel

Figure 7-15 Positions Window

1. Access the pull-down menu for the position being programmed to select a Tank/Grade option.

2. Repeat as necessary for the remaining positions.

3. Choose OK to save and exit or choose Cancel to exit without saving.

The following table shows the fueling point positions available for different Wayne dispenser types.

Table 7-1 Wayne Dispenser Type Fueling Point Positions

Dispenser Types

Model Number

Fueling Point Position

4-Product Multi-grade
3-Product Multi-grade
Data Link Blender

3-Hose Fixed Ratio Blender

Variable Ratio Blender

V490D1
V390D1

V590D1

V580D1, V590D1/U, V580D3,
V590D3/U, V585D1, V395D1/
U, V395D1

Positions 1 - 4
Positions 1 - 3

Positions 1,3-7 (2 is
reserved)

Positions 2 - 4 (1 is reserved)

Positions 1,3-7 (2 is
reserved)

NOTE:The system classifies grades in two ways: pure (stored) grades and blended (mixed)
grades. Incorrect assignment of blended grades prevents the system from authorizing the pump.

NOTE:When programming Positions on a Variable Ratio Blender (VRB), the pure grades will not be
displayed and cannot be assigned to a position. Only the blend grades are available from the pull-
down when assigning positions. See Figure 7-16.
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Tank/Grade
| = Positions
Pasiion3  [Lius Hlend = EL?E(;?)T\,nmmg
Poszition 4 Ius blend
Pogition 5

[~
| [

ok | LCancel ‘

Figure 7-16 Positions Programming Window on a VRB
e Fuel Flow

Select Fuel Flow from the Pump Options window to bring up the Fuel Flow window. See Figure 7-
17.

Fuel Flow

Wolume Pre-Cuteff: B Wolume
Ok ‘ Lancel l

Figure 7-17 Fuel Flow Window

The Fuel Flow programming window allows you to select Volume Pre-Cutoff, Fuel Flow Rate, and
the Maximum fuel volume and monetary amounts allowed at the selected pump.

*  Volume Pre-Cutoff -Use the Volume Pre-Cutoff field to enter the volume at which a

remaining preset or prepaid fuel amount is to be dispensed at a lower fuel rate. The

recommended value is 0.200 (two tenths of a unit of either gallons or litres). The maximum
pre-cutoff volume is 9.999.

Fuel Flow Rate -The Fuel Flow Rate field is used to enter the rate at which a pump
dispenses fuel.

NOTE:The Fuel Flow Rate field is grayed because it is not a programmable option in the current
release. The fuel flow rate default is 1 unit per minute.

*

Choose OK to save and exit or choose Cancel to exit without saving.
e [Feedstock
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If the dispenser is a Fixed or Variable Ratio Blender (FRB, VRB, VRB Plus), the high and low
feedstocks are defined under the Feedstock window.

NOTE:The pump has to be defined as a blender in the Type field of the Pump Options window
before this option will become available. See Figure 7-13.

1. Select Feedstock from the Pump Options window. The Feedstock window appears.

High Feedstock:

Tank 3-Supreme
LowFeedstock:  [Tank 2. Unleaded =

Ok | Lancel |

Figure 7-18 Feedstock Programming Window
2. Use the High Feedstock and Low Feedstock pull-down menus to select a tank.
3. Choose OK to save and exit or choose Cancel to exit without saving.
e Communications

Select Comm from the Pump Options window to access the Communications window.

Communications

CC Board Electronic Interface Board
i i i (O { e
Channel
& 1 r o2 Address |1—
Ok | Lancel |

Figure 7-19 Communications Window

*  The Communications programming window is where the CC Board, Electronic Interface
Board, Channel, and Address can be programmed.

IMPORTANT:The 4 programming options in the Communications programming window will be
programmed when Nucleus is installed at the site. Only qualified service technicians should make
changes to these options.

*  CC Board - The CC Board (Serial Communications Controller Board) is where the
software that controls pumps and CATs is run. The CC Board is always programmed to
1.

*  Electronic Interface Board (EIB) - The Electronic Interface Board controls the fueling
points at the site. If a site has more than 16 fueling points, then it will have two EIBs.
EIB A controls fueling points 1-16 and EIB B controls fueling points 17-24. The system
will automatically select which EIB the pump will be assigned to.

*  Channel - The Channel is an output from the EIB. Each EIB has two pump channels
and each pump channel controls up to 8 fueling points. The pumps must be distributed
evenly between the pump channels. Only qualified service technicians should make
changes to this option.
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*  Address - The Address is the unique identifying number programmed into the pump.
Nucleus will automatically assign the next available Address to each pump that is
added into the system.

*  Choose OK to save and exit or choose Cancel to exit without saving.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the Communications programming to take full effect. For additional information on
performing a shutdown and restart, see the Countertop Reference manual (Part No. 8-920494) or
Section 2 of the Operations Manual (Part No. 1-920494).

7.5.2.2 Removing Pumps

1. To remove a pump from the list of dispensers in the Pump Programming window, select the
number of the pump that you want to remove, then select Remove.

2. Click OK in the Confirm Remove Operation window that appears.

7.5.2.3 Cloning Pumps

The Clone function allows you to create a new pump using the programming of an existing pump of
the same type. This eliminates the need to hand program every pump at a site as long as the pumps
to be cloned are of the same model.

1. From the Pump Programming window, select a pump whose programming is to be duplicated
and choose Clone.

2. The Pump Options window will appear with the pump number assigned to the next available
pump address.

Modify any programming values as needed.
Select OK to save and exit or select Cancel to exit without saving.

7.5.3 Pump Programming - Tier Timers

Fuel Tier Timers are used to automatically set different fuel prices by programming the start and
stop times of the second fuel tier.

The timers can be programmed to start at any time of the day or night and stop at any other chosen
time or day. Individual pump programming can be set to have different pumps running on Tier 1 or
Tier 2 pricing, but when the Tier Timer activates, all pumps will switch over to Tier 2 pricing,
regardless of their individual pump programming. When the Fuel Tier Timer reaches its End time
then all pumps revert to their previous setting.

NOTE:Tiers must be enabled under System > Pump > Site Setup for the Tier Timers function to
be enabled. See Figure 7-11.

Access the Fuel Tier Timers window by selecting System > Pump > Tier Timer. The following
programming options are available from this window. See Figure 7-20.
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Fuel Tier Timers

! : Change Cycle
i * OneTi " Dail ekl
[ 24 Hour Format i M L 2
Start Time End Time
Hour Hour
i+ i+
" Monday 12 " Monday 12
" Tuesday Min " Tuesday Min
i Wednesday i) i Wednesday i)
" Thursday " Thursday
™ Friday ™ Friday
" Saturday + Abd " Saturday + Abd
" Sunday " PM " Sunday " PM
Ok | Lancel |

Figure 7-20 Fuel Tier Timers Window

e Enable Tier Timers - Enables or disables the use of Tier Timers.

e 24 Hour Format - Enables or disables the use of the 24 hour time format used in programming
Tier Timers.

e Change Cycle - Enables the use of a One Time cycle of the Tier Timer or allows use of the Tier
Timer on a daily or weekly basis.

e Start Time - Programs the time that Tier Timers will begin using Tier 2 fuel prices. This can be
an every day occurrence or only on certain days, at certain times that the system will
automatically switch to Tier 2 pricing.

e End Time - Program the time that the system will discontinue the use of Tier 2 pricing. This can
be any time following the start time that was programmed eatrlier.

NOTE:Ensure that the Start time and the End time are programmed such that the End time comes
AFTER the Start time, otherwise unexpected results may occur.

7.5.4 Pump Programming - Prepay Hours

The Prepay Hours programming area is used to configure the Nucleus system to automatically
switch to Prepay sales mode at a pre-programmed time of the day or night. This is useful to prevent
drive-offs or at certain times when there is a reduced staff present.

The Prepay Hours timer can be programmed to start at any time of the day or night and stop at any
other chosen time of day or night.

The only restriction in programming of the timer is that if the Everyday option is selected then the
time period cannot cross the 12 midnight hour which would change days. For example, to program
the system to switch to Prepay mode everyday between 10 PM and 6AM of the following day you
would need to select the Everyday option and then program two separate entries to cover the two
different days involved. See Figure 7-21 for an example of Prepay programming.

NOTE:Note that the use of the Allow Post-Pay button under the Pump Operations button will
override the Prepay Hours programming done here.
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To program one or more fueling points at a station to use the Prepay Hours function you will need to
perform the following steps.

1. Access the Pump Options window by going to Programming > System > Pump > Each. Select
the fueling point that you want to set up to use the Prepay hours function then press Modify.

2. In the Pump Options window, enable Allow Postpay and Allow Postpay Toggle then press
OK. If you get a pop-up titled Prepay Hours Warning then press Yes then Close. Refer to
Section 7.5.2.1 for information about Allow Postpay and Allow Postpay Toggle.

NOTE:If only certain fueling points need to follow a Prepay Hours schedule then perform the above
step only on those fueling points. Be sure that the Allow Postpay Toggle option is disabled for

fueling points that you don’t want to follow the the Prepay Hours schedule.

3. Next go to the Prepay Hours window by selecting System > Pump > Prepay Hours. The
following window will be displayed. See Figure 8-21.

Prepay Hours

[v Enabled

Enabled Box '

Prepay Hours List

Start Day

Everyday

Start Time
10:00:00 PM
| 12:00:00 AM

End Day

Everyday

End Time -~
11:55:59 PM
E£:00:00 At

Add button

1

Add

Remove

Modify

7]

Close |

4. Click the Enabled box to begin programming.

Figure 7-21 Prepay Hours Window

5. Click the Add button to program a new time period. The following window will be displayed.
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Prepay Hours Window

Select Start of Prepay Hours

Start Day Start Time
Friday ~|  [1zooooeM -
Select End of Prepay Hours
End Day End Time
Sunday  w|  [10:00:00 aM -

()8 ‘ Cancel |

Figure 7-22 Prepay Hours Programming Window

6. Click the Everyday box to enable the programming down in this window to be applied to
everyday of the week.

Enter the Start day and time then the End day and time for the Prepay restriction to be in force.
Click OK to save and exit or Cancel to exit without saving.

7.6 IPT Programming

The Indoor Terminal windows allow you to configure Indoor Processing Terminals (IPTs) for use with
your system.

7.6.1 IPT Programming - Site

The site-wide options allow you to program settings common to all IPTs at your site. You can
program the system to display a CDU advertisement or slogan, allow sales with the cash drawer
open, configure the receipt printer, or control the number of stacked sales to allow.
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Indoor Terminal

— COU Advertizsing
f
Idle Seconds: ID

¥ Allow Sales with Drawer Open —Safe Drop Receipt— — Credit Beceipt
¥ Scanning Defaults to Minimurn Pack Size for UPC |1 hd I £ Print Once
& Print Twice

I~ Open Cash Drawer on Last Tender Only

[~ Enable Suggestive Selling for Mix-N-tatch

—Paid In/Out Receipt— — CAT Message Alert
I~ Allow Mis-M-Match/Comba Promations with Fuel Prepays m o Alert with pop-up, needs
acknowledgement

[~ Optional Clase of Cashier Report at Sign-0ff ™ Mo pop-up, alert with sound

[~ Print UPC on Receipts

— Pump Stack

I~ Prompt Cashier to Clock In/Out at Logon 3 2
Max Mumber of Unpaid Sales in Stack:

v Allow Authorization of Prepay Only Purmp m

[~ Enable MultiCurrency at this site WARNING! System must be restarted

for these changes to take effect.

Minutes before login automatically paused : | 15

ICAT Timeouts... | Limits... | UPLC E=pangzion... |

Ok | Lancel |

Figure 7-23 Indoor Terminal Window
Access this window by selecting System > IPT > Site. See Figure 7-23.

e CDU Advertising - CDU advertising allows you to enter a message of up to 80 characters that
appears on the CDU when the system is not processing transactions. You can also set the time
(in seconds) that the CDU remains idle after a sale until the advertising begins to scroll. Choose
any number of seconds from 1 through 999 to tell the CDU how long it needs to wait following
the end of the last sale to start advertisements.

NOTE:You must change the value to something other than zero to enable CDU advertising.
Leaving the CDU idle seconds time at O prevents the CDU from displaying a message.

e Allow Sales with Drawer Open - This option allows you to make sales while the cash drawer is
open. Check the box to allow sales with the drawer open. Un-check the box to disable this
feature. If this feature is disabled, an error message that says “Close Cash Drawer First!” will
pop up on the Sales screen if the drawer is open and a sale is attempted.

e Scanning Defaults to Minimum Pack Size for UPC - The Nucleus system is configured for
multi-pack defaults. Nucleus defaults to single pricing, but the system can be configured to
prompt the cashier to indicate whether a sale item is single or multi-pack. Check the box to
enable the Nucleus single pricing default. An example of single pricing is the price that is
scanned for a single canned drink. An example of multi-pack pricing would be the price that is
scanned for a six pack of drinks. The UPC is scanned from one of the items in the six pack to
determine the price of the entire six pack.

e Open Cash Drawer on Last Tender Only - Use this feature to limit at what point during the
transaction the cash drawer will open. Generally this option is useful during a split tender
transaction. If the cash drawer only opens when processing the second tender of a split tender
transaction, then the cashier knows that the sale is complete when the cash is put into the
drawer.

e Enable Suggestive Selling for Mix-N-Match - Use this feature to program the system to
automatically remind the cashier to ask the customer if she or he would like to purchase an item
when all but one item in a Discount Classification have already been rung up. Check the box to
enable this feature.

47
August 2008 Part No. 2-920494 Rev. G




Allow Mix-N-Match/Combo Promotions With Fuel Prepays - Use this feature to program the
system to automatically remind the cashier to ask the customer if she or he would like to
purchase a Mix-N-Match or Combo promotion if the customer qualifies for the promotion based
on the fuel prepay being tendered.

Optional Close of Cashier Report at Sign-Off - Nucleus can be programmed to leave the
cashier report open whenever the cashier signs off of the terminal. This feature allows the
cashier to sign off and sign on multiple times during a shift without having to close the cashier
report. This will allow the cashier report to remain open until EOS or EOD.

Print UPC on Receipts - Use this feature to program the system to print the UPC of the item
purchased on the receipt.

Prompt Cashier to Clock In/Out at Logon - Use this feature to program the system to prompt
the cashier to Clock In/Out whenever the cashier logs onto Nucleus.

Allow Authorization of Prepay Only Pump - Select this option to enable the cashier to
authorize a pump which was previously programmed for Prepay only operation.

Enable MultiCurrency at this site - Use this feature to enable the use of different country’s
currency.

NOTE:This option is only available with Level 6 Access. Once this option is enabled then the
Currency Setup function will be enabled under Programming > Cash Register > Currency Setup.
See section 19 on page 180.

Minutes Before Login Automatically Paused - Enter the number of minutes of inactivity that
the system waits before going into a paused mode. To return from pause the cashier enters the
login password used by the cashier who originally logged on.

Pump Stack - Use the Pump Stack option to program the maximum number of unpaid sales in
a stack that will be allowed at the site. Select a number from the pull-down menu. The minimum
is 1 and the maximum is 3.

*  If the Max Number of Unpaid Sales in Stack equals 1, then the stack can contain either 1
unpaid/incomplete sale and 2 paid sales or it can contain 3 paid sales.

*  If the Max Number of Unpaid Sales in Stack equals 2, then the stack can contain up to two
unpaid/incomplete sales and the remainder can be paid sales.

*  If the Max Number of Unpaid Sales in Stack equals 3, then the stack can contain up to 3
unpaid/incomplete sales.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the Pump Stack programming to take full effect. For additional information on performing
a shutdown and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of
the Operations Manual (Part No. 1-920494).

48

Safe Drop Chit - The Safe Drop Chit printing option allows you to select the number of times
you want to print the Safe Drop chit (1 - 4).

Paid In/Out Chit - The paid In/Out Chit printing option allows you to select the number of times
you want to print the Paid In/Out chit (1 - 4).

Credit Receipt Printing - The Credit Receipt Printing option allows you to select the number of
times you want to print the receipt (Once or Twice). Most sites use the twice option and give one
copy to the customer and the site keeps the signed copy.

CAT Message Alert - Use this feature to program the system to alert the cashier that there is a
CAT message available. CAT messages are usually generated from error conditions at the CAT
such as Card Rejected messages. The system can be programmed to either alert the cashier
with a pop-up which requires acknowledgement or an audible alert which will not require
acknowledgement.
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7.6.1.1 ICAT Timeouts
1. Select ICAT Timeouts from the Indoor Terminal window to access the ICAT Timeouts window.

Timeouts programming allows you to set the timeout values for prompts which are displayed on
the ICAT pin pad. See Figure 7-25.

ICAT Prompt Timeouts

Selection Prompts Timeout: [30] Seconds

Approved Card Prompt Timeout: |4 Seconds

—

WARMING: System must be restarted for
ANY of the ABOVE chanaes to take

Ok | Lancel |

Figure 7-24 ICAT Timeouts Window

*  Enter a Selection Prompt Timeout value. This value controls how many seconds the ICAT
will display prompts asking the customer transaction related questions.

*  Enter an Approved Card Prompt Timeout value. This value controls how many seconds
the ICAT will display the card approval prompt.

*  Enter a Pin Entry Prompt Timeout value. This value controls how many seconds the ICAT
will display the prompt asking the customer to enter the pin number.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the ICAT Prompt Timeouts programming to take full effect.

2. Choose OK to save and exit or choose Cancel to exit without saving.

7.6.1.2 Limits

1. Select Limits from the Indoor Terminal window to access the Drawer Limits window. Limits
programming allows you to set up IPT drawer limits to enhance security for your site. This
feature, when utilized, will prompt the cashier to make a safe drop when drawer limits are met.

See Figure 7-25.

Frimary Hour  Minute

[200.0

Alternate

o

:|oo

Enable Time

Hour

i

o am ¢ pm

te

[$0.00

o

:|oo

o am ¢ pm

Lancel |

Figure 7-25 Drawer Limits Window
NOTE:Setting the Primary and Alternate times to zero disables the Drawer Limits function.
*  You have the option of setting Primary and Alternate cash-in-drawer limits.
*  You can also set the time that the respective cash-in-drawer limits go into effect.

2. Choose OK to save and exit or choose Cancel to exit without saving.
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7.6.1.3 UPC Expansion

1. Selectthe UPC Expansion button from the Indoor Terminal window to access the UPC
Expansion window. See Figure 7-26.

UPC Expansion

[v Expand UPC-E to LIPC-4 Farmak

Qg | Lancel |

Figure 7-26 UPC Expansion Window

*  Expand UPC-E to UPC-A Format - This feature causes all keyed and scanned UPC-E
codes to be expanded to UPC-A codes. If the Back Office system is using all UPC-A codes
then the box should be checked. If the Back Office system is using UPC-E only or a
combination of UPC-A and UPC-E then the box should not be checked.

2. Choose OK to save and exit or choose Cancel to exit without saving.
7.6.2 IPT Programming - This
The IPT programming options allow you to program settings for the IPT that is currently being used.

1. Access this window by selecting System > IPT > This on the IPT you want to program. See
Figure 7-27.

[ Automatically Print Receipts

[v Open Cash Drawer at Log on / Log off

[~ Prompt for Opening/Clozing Balance

™ Cash Drawer Connected to Printer

WARMING! System must be
restarted for this change to
take effect.

Ok Lancel

Figure 7-27 IPT 1 Window
The IPT window allows you to determine certain functions for a given IPT:

e Print Chit at Sign-On/Sign-Off - This feature allows you to select options for sign-on or sign-off
chit printing.

e Automatically Print Receipts - This feature allows you to select whether or not you want the
system to automatically print cash receipts.

e Open Cash Drawer at Log On / Log Off - Use this feature to program the system to open the
cash drawer when a cashier logs on or logs off. Check the box to enable this feature.
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e Prompt for Opening/Closing Balance - Use this feature to program the individual IPT to
prompt the cashier for an opening and closing balance. Check the box to enable this feature.
For details on the opening/closing balance refer to the Operations manual (Part No. 1-920494).

e Cash Drawer Connected to Printer - Check this box to tell the system if the cash drawer
communication cable is connected to the receipt printer.

2. Choose OK to save and exit or choose Cancel to exit without saving.

7.6.3 IPT Programming - Logos
Logo programming allows you to create logos for the top and bottom of your indoor receipts.

1. Access this window by selecting System > IPT > Logos. See Figure 7-28.

Header
Line 1: |

Line 2: |
Line 3: |

Footer

Line 1: [Thank You

Line 2 [Call Again
Line 3: |

Ok | Lancel |

Figure 7-28 Logos Window
2. Enter Header and Footer information from the QWERTY keyboard.
*  Note that there are 19 spaces that can be used per line.

*  Messages can be centered by simply typing in the message. Although the logo information
appears aligned to the left on your window, the printed logo is centered on the receipt
automatically.

*  Use leading spaces before the text to right justify the message.

*  Use the TAB key on the QWERTY keyboard to go from line to line and from the Header to
the Footer sections.

3. Choose OK to save and exit or choose Cancel to exit without saving.

7.7 CAT Programming

The CAT programming windows allow you to configure Customer Activated Terminals (CATSs) for
use with your system. The options available will be different if you have Gilabarco or Tokheim
dispensers and they have been programmed correctly under Programming > System > Site.

7.7.1 CAT Programming - Site

The site options allow you to program settings common to all CATs at your site. Access this window
by selecting System > CAT > Site. See Figure 7-29.
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DSM Encryption
—

Figure 7-29 Customer Activated Terminal Window - Wayne Dispensers

[~ ihwuth Before Obtaining Metwork Approvat
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[~ Force Outdoor Receipt Printing

[ Allow Seling of SKUAPLU Items at Full-Serve CATs
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[ Print Cash Prepap Receipt at CAT
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Full Serve... | CAT Timeouts... |
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—Advertizing Motebook
Motebook Editor... | Import Matebook. .. |

WARMING: System must be restarted for these ch

to take effect.
CAT Keypad Setup... |

[ Bill Acceptaors Active
[~ Touchscreen Active

[~ DSM Encryption

Ok | Lancel |

7.7.1.1 DSM Encryption - If the station supports DUKPT Encryption and there is a DSM
installed in the Primary Distribution Cabinet, then enable DSM Encryption by checking the

DSM Encryption box.

[~ #wuth Befare Obtaining Metwark Appraovat

[~ Operatar Consent

[~ Force Outdoor Receipt Printing

[ Allow Seling of SKUAPLU Items at Full-Serve CATs

[ Allow Seling of Age Restricted ltems at Self-Serve CATs
[ Print Cash Prepap Receipt at CAT

CAT Coupon... | Max SELAPLU items allowed at CAT: |4

Full Serve... | CAT Timeouts... |
PBromations... |

—Advertizing Motebook
Hotebook Editor... | Import Matebook. .. |

GSM Encryption

T

WARMING: System must be restarted for these ch

to take effect.
CAT Keypad Setup... |

[~ Touchscreen Active

¥ GSM Encryption
f* DUKPT & MAC

Ok | Lancel |

Figure 7-30 Customer Activated Terminal Window - Gilbarco Dispensers

7.7.1.2 GSM Encryption - Enable this option if a GSM is installed.

*  Enable DUKPT for US sites

*  Enable MAC for
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[ Auth Before Obtaining Metwark Appraval

[~ Operatar Consent

[~ Force Outdoor Receipt Printing

[ Allow Seling of SKUAPLU Items at Full-Serve CATs

[ Allow Seling of Age Restricted ltems at Self-Serve CATs
[ Print Cash Prepap Receipt at CAT

CAT Coupon... | Max SELAPLU items allowed at CAT: |4

Full Serve... | CAT Timeouts... |
PBromations... |

—Advertizing Motebook
Hotebook Editor... | Import Matebook. .. |

WARMING: System must be restarted for these ch

CAT Keypad Setup... |

to take effect.

Ok | Lancel |

Figure 7-31 Customer Activated Terminal Window - Tokheim Dispensers

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the programming to take full effect. For additional information on performing a shutdown
and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of the
Operations Manual (Part No. 1-920494).

7.7.1.3 Auth Before Obtaining Network Approval

Select this option to allow credit card authorizations at the CATs prior to receiving an approval from
the network. Check the box to enable this feature.

/N WARNING

If the credit card is denied, the pump will automatically stop and the cashier must tell the cus-
tomer to come inside to pay for the fuel dispensed.

NOTE:Chevron recommends that this feature not be used.

7.7.1.4 Operator Consent

This programming selection requires operator approval before CAT authorization of a pump is
allowed. Check the Operator Consent box to have Nucleus prompt the cashier for approval
whenever a credit card is used at the pump.

NOTE:This option is separate from the AutoAuth/No AutoAuth options in Pump programming which
control authorization options for post pay sales at the pump.

7.7.1.5 Force Outdoor Receipt Printing

This programming selection allows you to set the system to automatically generate an outdoor
receipt based on sale data at the pump.

NOTE:When a Bill Acceptor (BAC) refund is due or a car wash has been purchased or awarded,
the system always prints a receipt at the CAT.
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7.7.1.6 Allow Selling SKU/PLU Items at Full-Serve CAT

Enable this option to allow the attendant to use a pump which has been programmed for Full Serve
to sell SKU/PLU items to the customer. The attendant can sell a variety of items such as oil,
windshield wipers or ice to a customer using the CAT keypad.

7.7.1.7 Allow Selling of Age Restricted Items at Self-Serve CATs

Enable this option to allow CAT sales of items that have an age restriction on them. This is used
when a full serve attendant wants to sell beer, cigarettes or other age restricted items to a customer
at the full serve island.

7.7.1.8 Print Cash Prepay Receipt at CAT

Enable this option to have the CAT print a receipt for a cash prepay when the customer finishes
fueling.

7.7.1.9 CAT Coupon

The CAT Coupon feature will allow you to enter text to print on a CAT coupon. The CAT coupons are
printed at the CAT on a separate chit after the CAT receipt is printed. This feature can be used to
encourage site loyalty by printing a store coupon redeemable for goods or services at the site.

1. Selectthe CAT Coupon button and the CAT Coupon window appears. See Figure 7-32.

CAT Coupon

u i
| 12

WM o~ M = W R =

10

|

|
| |
| |
| |
| 15
| 7 |
| |
| |
| |

[~ Enable ok | Cancel |

Figure 7-32 CAT Coupon Window

Check Enable to activate this option.

There are 20 lines available for use and each line is 20 characters long. Use the arrow keys on
the QWERTY keyboard to move between the lines. The lines on the coupon are not
automatically centered and spaces can be used to center or right justify messages.

4. Choose OK to save and exit or choose Cancel to exit without saving.

7.7.1.10 Full Serve

Full Serve or Attended Mode is when an attendant is present at the Card Activated Terminal (CAT)
and handles dispensing fuel and handles the transaction for the customer. This includes swiping a
customer’s credit or debit card, accepting cash for transaction payment, answering receipt and
carwash prompts, and completing the sale. Sales are finalized at the CAT without assistance from
an indoor cashier, except for error conditions that cannot be properly handled at the CAT.
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Full Serve sales at a CAT require an attendant to sign on to the CAT as if it were an Indoor Payment
Terminal (IPT). Commands are entered at the CAT keypad to control the sale and the pump. Full
Serve operates in two different states or modes.

e Session Mode - allows an attendant to sign on, perform a sale, complete the sale, and then
wait for another customer.

e Transaction Mode - automatically logs the attendant off of the CAT after the transaction or sale
completes so that multiple CATs can be manned by one attendant.

The Full Serve feature must be enabled by going to the Programming access window and selecting
System > Pump > Site Setup and check the Full Serve Enable box. To allow the individual pumps
to switch between Full and Self Serve, the Service Levels Enable box must be checked. If this box is
unchecked then the service level programming for each individual pump will be grayed out and the
pump will remain in it's current state until the Service Levels Enabled box is checked again. See
Figure 7-33.

Pump Site Programming

Tiers: [~ Service Levels: [~ Enable Price Levels: [~ Enable

i v
Service Levels Enable Box — -
foh [Fu =
Full Serve Enable Box T
WARMING: System must be restarted for the ch below to take effect.

Duplex 1| Submerzible Pump Contral Fuel Yalume Limit

Electronic ™ Site
CC Interface 930
Enabled  Board Board  Channel  Address [ Unattended Only
| 5FC 1 s 1 a0
W EFEE A 2 30

Ok Lancel

Figure 7-33 Pump Site Programming Window

Once the Full Serve feature is enabled, individual pumps can be switched to Full Serve operation by
going into System > Pump > Each > Modify and selecting Self or Full service level. Be sure that
Has CAT for Full Serve has been checked for proper Full Serve operation. See Figure 7-34.
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Pump Options

Make and Model: |

—

i

" MGD Uni Hose C
e #
e #

-

-~ }
MGD with Buttons v

Tuvpe Push To Start

MNone

Start Bar

ellow Fuel Key

Walid Positions

1 v 2

W 3

Tier
o Day

" Might

Level
&+ SELF

" FULL

4

v Allow PostPay

[~ Allow PostPay Toggle

= E giic

v 1

Settings... FPositions,

WARMING: System must be restarted for these changes to take effect.

Fuel Flow... ‘

‘ Comm...

o |

LCancel ‘

Select ‘Has CAT

[~ for Full Serve’

~_ Select ‘Full
Serve Level’

Figure 7-34 Pump Options Window

Full Serve CAT commands and Security levels can be modified by going into programming and
select System > CAT > Site > Full Serve. This window allows the user to view and change the Full
Serve Key Commands and Security levels required to perform each of the actions. Any number from
1 through 9 can be programmed for the commands. The default commands are shown below and
will be used if a site does not change them. For any changes to take effect, the system must be

restarted.

NOTE:Full Serve commands and security levels should not be changed while sales are in
progress. If changes to the Full Serve commands or Security levels are made while attendants are
signed on then the attendants should sign off and the system rebooted for changes to take effect.

NOTE:For Full Serve operations to execute normally, the site must not have Auto-Auth and Auto-
Pay enabled for pumps programmed as full serve.

Full Serve Keyboard Configuration

Commands:
Sign Off

Autharize

oid Last

effect.

Pump

Preset Fuel
Tender Sale
Start Pump

Sell SKUAPLU Items

Item

Security Level
—

E [Level 1 |
[7 [Level 1 |
E [Level 4 |
E [Level 1 |
5 [Level 1 |
B [Level 1 |

Cancel

WARMING: System must be restarted for these changes to take

Figure 7-35 Full Serve Keypad Configuration Window
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7.7.1.11 Entering Commands at the Full Serve CAT

The Full Serve attendant enters commands at the CAT by pressing the key on the CAT which
represents the command desired followed by the ENTER key. When entering data or commands at
the CAT the ENTER key must always be pressed to enter the command. The YES and NO keys are
the only keys that do not require the ENTER key to be used. In the above Full Serve Keyboard
Configuration screen the commands are listed on the next page:

* 1 <ENTER>= Sign the attendant off of the CAT

* 3 <ENTER> = Authorize the pump and begin dispensing fuel

* 7 <ENTER> = Enter a preset dollar amount of fuel to dispense

* 9 <ENTER> = Enter the amount of cash received from the customer
* 8 <ENTER> = Starts a pump that has been previously stopped

* 5 <ENTER> = Enables the entry of a PLU or SKU number of an item for sale at the Full
Serve island.

* 6 <ENTER> = Voids the last PLU or SKU item entered.

NOTE:The Full Serve Attendant report will not automatically close and generate a Z report if an
attendant is still signed on at the CAT when the close shift or close day is performed. An X report will
be generated instead.

7.7.1.12 Promotions

The Promotions programming screen is where you define the names of the promotions (up to 16
characters) that will be displayed at the CAT which the customer may select. Go to Programming >
System > CAT > Site and see the example in Figure 7-36. The names of the promotions that you
wish to display at the CAT need to be defined here first, then the individual promotions are defined in
the Combo Classifications section of the system programming manual. See 'Combo Programming”
on page 128.

CAT Promotion Messages

Frimary Prompts Selection Prompts

1] |Moming Special

2-Line Test:

‘Wwant a Discount? 2 |Lunch Special
RSzl 3 |Evening Special
4-Line Test/Graphic: 4 |Nigh‘r Special
Want a Discount? 6 |

“es or Mo

B]|

?]|

8]|

9]|

Ok Lancel

Figure 7-36 CAT Promotion Messages Window
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7.7.1.13 Max SKU/PLU Items Allowed at CAT

Use this value to set the maximum number of PLU/SKU items that can be sold by the attendant at a
Full Serve pump.

NOTE:The Dry Product Detail component needs to be added to the Outdoor Attendant report to
track PLU and SKU sales by the Full Serve attendant.

7.7.1.14 CAT Timeouts

Select the CAT Timeouts button to access the CAT Timeouts programming screen where you can
set the various CAT timeout values for the CATs at the site. Go to Programming > System > CAT
>Site > CAT Timeouts, Refer to Figure 7-37 for an example.

CAT Prompt Timeouts

Pump Mozzle Lifted Prompt Timeout: Seconds
Pump Lever Lifted Prompt Timeout: {180 Seconds
Fuel Pulses Begun Prompt Timeout: (17 Seconds
Fay Attendant Frompt Timeout: IT Seconds
Fieceipt Frompt Timeout: IT Seconds

Fir Entry Frompt Timeout: W Seconds
Unattended Mode Pump Stop Timeout: Ig_ Seconds
Loyalty ‘wait For PaymentTimeout: IT Seconds
Ask For Loyalty Timeout: W Seconds

Loyaly Meszage Timeout: Ig_ Seconds

Loyaly Account Entry Timeout: W Seconds

Qg Lancel |

Figure 7-37 CAT Prompt Timeouts Window

e Pump Nozzle Lifted Prompt Timeout - This value controls how long the system will display the
prompt telling the customer to lift the nozzle that is displayed following pump authorization.

e Pump Lever Lifted Prompt Timeout - This value controls how long the system will display the
prompt telling the customer to either select a grade, press the start bar, or press the yellow fuel
key, which is displayed following nozzle lift.

e Fuel Pulses Begun Prompt Timeout - This value controls how long the system will display the
prompt telling the customer to begin fueling following pump authorization.

e Pay Attendant Prompt Timeout - This value controls how long the system will display the prompt
telling the customer to pay the attendant after fueling is complete on a post pay sale. It also
controls the amount of time that the message will be displayed that indicates that a successful
preset has occurred.

e Receipt Prompt Timeout - The Receipt Prompt Timeout value controls the amount of time that
the CAT will display the prompt that asks the customer if they would like a receipt.

e PIN Entry Prompt Timeout - PIN Entry Prompt Timeout allows you to control the amount of time
a customer is given to enter a PIN at the CAT. In the current release, the PIN Entry Timeout is
set to the default value of 60 seconds and cannot be changed.

e Unattended Mode Pump Stop TImeout - If errors occur while operating in unattended mode, the
pump will go into a pump stop state as it normally does. This timeout value sets the amount of
time that the dispenser will wait before resetting itself back to the idle state.
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e Loyalty Wait for Payment Timeout - This value controls how long the CAT will display the prompt
telling the customer to insert a payment card after a Loyalty card has been accepted.

e Ask For Loyalty Timeout - This value controls how long the CAT will display the prompt asking
the customer for a Loyalty card after a payment card has been swiped.

e Loyalty Message Timeout - This value controls how long the CAT will display the prompt telling
the customer that the Loyalty Card has either been accepted or declined.

e Loyalty Account Entry Timeout - This value controls how long the CAT will display the prompt
asking for the customer to enter the Loyalty Card/Account number.

7.7.1.15 Notebook Editor

The Notebook Editor feature allows you to select various advertising chains for use with CATs.
Notebook Editor also allows you to manage the creation, configuration, and selection of various
advertising messages for display at the CAT.

Select Notebook Editor from the Customer Activated Terminal window and the Advertising Chain
Programming window appears. See Figure 7-38.

Advertising Chain Programming

Chain Mame -~

techron graphics
techron text

-]

Bemove | Modify... | Clone... | Lloze | IimeSIots...|

Figure 7-38 Advertising Chain Programming Window

Advertising Chain Programming - This programming selection allows you to Add, Remove,
Modify and assign a Time Slot for messages to run at the CATs. The Advertising Chain
Programming window also allows you to manage the creation, configuration and selection of various
advertising messages for display at the CAT. See Figure 7-38.

1. Select Add or Modify at the Advertising Chain Programming window to display the Advertising
Chain Editor window.

Advertising Chain Editor -The Advertising Chain Editor allows you to select and modify text and
graphics to display at the CAT. See Figure 7-39.

59
August 2008 Part No. 2-920494 Rev. G




Advertising Chain Editor,

Chain Mame Frames of Chain
|techr0n graphics

0z graphtechz

Dizplay Type 03 graphtechs
04 graphtechd
™ Text Dizplay 05 graphtechs
. . 0& graphtechs
{+ Graphics Display 07 graphtech?
0% graphtechs
0% graphtechs

’7 Add. | Remave |

Clone... |

| Move Down |

v [ e

Figure 7-39 Advertising Chain Editor Window
The following options are available from the Advertising Chain Editor window:
e Chain Name - A 30-character name that allows you to identify each advertising chain easily.

e Display Type - Allows you to select either text or graphic display for the advertising chain. Each
chain consists of multiple images or frames. Up to 30 frames can be programmed depending on
the amount of CAT memory available in the application.

After the images are stored in Nucleus, they must be organized into advertisement chains, which
function similarly to report chains. Each frame is either a text message or a graphic RAM image.
Note the difference between a Text Only Chain and a Graphic Chain.

*  Text Only Chain - Text messages are advertisements that contain text without graphics.

Text-Only Chain programming allows you to create and make changes to the advertising
messages shown at the CAT. See Figure 7-40.

** Soft Drink Special **
12-Pk Cokes
$2.99

Figure 7-40 Text Advertisement

The text messages consist of 2 lines of 16 characters, while the graphics display
consists of 4 lines of 21 characters.

The default message is present in each chain until reprogrammed. Program at least 1
of the 6 messages with a message. This can be a prompt reminding the customer to
replace the nozzle before leaving the station.

IMPORTANT:One default text message must remain programmed in the system.

*  Time-sensitive information such as pricing should be displayed in these messages

because they do not require graphics.
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*  From this window, you can set the time span of the text messages display, as well as
turn certain messages on and off. Text mode CATs cycle text messages while
customers are fueling unless a message is turned off.

*  Text messages are programmable at the IPT and can be modified by the station
manager when necessary.

*  Graphic Chain - Graphic display advertising messages are sequences of commercial
messages that run while a customer dispenses fuel. Graphic Chain programming allows
you to display advertising artwork on your CAT to enhance fueling instructions or increase
the effectiveness of an advertising message. See Figure 7-41.

21 HOT COFFEE TO GO
O ONLY b94¢

Figure 7-41 Advertisement Graphic

*  The graphic image shown includes text built into the graphic. The text is part of the
picture.

NOTE:To produce graphic images at the CAT, your CAT must be equipped with a graphics display
board and the corresponding hardware.

*  The Nucleus system stores advertisement images as RAM (Random-Access Memory)
and these images are stored as IMG files. The system can store up to 52 RAM images.

*  The station manager has control over which images run, as well as the display time and
sequence. Only, the Authorized Service Organization (ASO) representative can change
graphic chain images using system software. These prompts cannot be altered by the
station manager, except to modify the display sequence.

e Chain Statistics - Shows you the details of the chain presentation such as the amount of time
the chain displays at the CAT, the amount of CAT memory the chain occupies, and the number
of graphic images used.

e Frames of Chain - Displays a frame by frame list of the chain of graphics and text frames that
make up the complete message shown at the CAT. The Frames of Chain control buttons allow
you to place, rearrange, or delete individual frames within the advertising chain. Figure 7-42
shows the Frames of Chain control buttons.

Add... | Remove |
Modify... | Clone... |
Maove Up | Mowe Daown

Demo...

Figure 7-42 Ad Chain Control Buttons

*  Add - Allows you to create a new frame by opening the Frame Editor window. See Figure 7-
43 below.
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Frame Mame Dwration (0.1 - 9.9 sec)

|graphic ad 1 1

Display On CAT R

" 2Line Text

" 4 Line Text

|
|
I * Graphic Image

Brewed Fresh ?

}
Inside

Image To Add

COFFEE3IMG

hatdog3.img
Qg | Lancel |

Figure 7-43 Frame Editor Window

The following options are available from the Frame Editor window.

*  Frame Name - Shows the name used to identify an individual frame.

*  Duration - Allows you to determine the length of time (between 0.1 and 9.9
seconds) that each frame is displayed.

*  Display On CAT - Allows you to view text and images associated with each frame.
The chain name and frame number appear above the text from the frame.

*  Frame Type - Allows you to select the type of image information contained in a 2
Line Text, 4 Line Text, or Graphic Image frame.

* Image To Add - Allows you to incorporate stored images into the advertising chain.

Remove - Allows you to delete the frame currently displayed in the window.

Modify - Allows you to make changes in the highlighted frame through the Frame Editor
window. See Figure 7-43.

Clone - Allows you to copy the settings of the currently selected frame and use it elsewhere
in the chain.

Move Up - Allows you to move the highlighted frame to the position just above it. The
highlighted frame and the frame above switch positions in the chain.

Move Down - Allows you to move the highlighted frame to the position just below it. The
highlighted frame and the frame below switch positions in the chain.

Demo - Allows you to view the chain animation as it will appear at the CAT. When you select
Demo, the Ad Chain demo plays. See Figure 7-44 below.

NOTE: System operations may exhibit a slow-down when in Demo Mode.
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Brewed Fresh

Inside

Beplay |

Figure 7-44 Demo Chain Window

The Demo Chain window has three selections available:

*  Replay - Returns to the first frame in the advertising chain and plays the demo.

*

Stop - Halts the demo of the advertising chain display.
*  Close - Exits the Demo Chain window.

2. To Remove a chain from the Advertising Chain Programming window, highlight the name of the
advertising chain and select Remove.

3. Select Time Slots from the Advertising Chain Programming window to program the times that
specific advertising chains will be displayed. See Figure 7-38 and Figure 7-45.

Slot | Text Dizpla Graphic Display Startiry Ending | Active |«
text eszage n | 1201 am

2 12:01 am | 12:01 am Mo

3 12:01 am | 12:01 am Mo

4 12:01 am | 12:01 am Mo

Lloze ‘

Figure 7-45 Time Slots Window

e Select the time slot that you want to assign to an advertising chain then choose the Modify
button.
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Starting Time Ending Time Time Slot Status

Hour: &AM Hour: |42 o AM " Active
Minute: | 2 " PM Minute: |4 " PM + |nactive

Text Display: Graphic Display
text ad meszage j + Mone
e
oK | Lancel |

Figure 7-46 Time Slots Programming Window
e Programming options available in the Time Slots window are:
*  Starting Time - This is the time you want the ad chain to begin.
* Ending Time - This is the time you want the ad chain to stop.
*  Time Slot Status - This is the flag that determines if the ad chain is Active or Inactive.

*  Text Display pull-down - This pull-down menu has all of the available text chains that can
be run.

*  Graphic Display - Choose None to tell the system that there are no graphics displays at
the CATs available. Choose Select from List to enable the pull-down menu containing a list
of graphics ad chains to choose from.

e Choose OK to save and exit or choose Cancel to exit without saving.

7.7.1.16 Bill Acceptors Active
If the station supports bill acceptor sales, check this box to activate all of the bill acceptors.

NOTE:Bill Acceptor support for Gilbarco and Tokheim dispensers will be available in a later release
of software.

7.7.1.17 Touchscreens Active
NOTE:The current release does not support outdoor touchscreen hardware.

NOTE:The Nucleus application must be shutdown and restarted for changes to this option to take
effect. For additional information on performing a shutdown and restart, see the Countertop
Reference manual (Part No. 8-920494) or Section 2 of the Operations Manual (Part No. 1-920494).

7.7.1.18 CAT Keypad Setup

The CAT Keypad Setup button is used to access the CAT Keypad programming window. Go to
Programming > System > CAT > Site to access this feature.

NOTE:Access to this function is controlled by user access levels defined within the Programming
Security Levels area. Modifications to the CAT Keypad Setup function should only be done by
trained service personnel. See the Chevron Nucleus Installation manual PN 920641.
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The CAT Keypad function is used to program Nucleus to communicate with a wide variety of CAT
keypads. The setup function can also be used to customize the button programming to match the

CAT keypads which are installed at the site. Select the CAT Keypad Setup button and the following
window will be displayed.

Cat Keypad Setup

MHO
6

Apply Modify ‘ Lancel

Figure 7-47 CAT Keypad Setup Window

Use the Keypad Setup pull-down to select from different pre-programmed keypad layouts. See
Figure 7-48

Cat Keypad Setup

Apply ‘ Modify ‘ Lancel

Figure 7-48 CAT Keypad Setup Pull-down Menu

If none of the pre-programmed keypad layouts match the site’s keypads then the programming can
be customized to match the layout and function of the CAT keypads.
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Drefault K.eypad - Chevron Generic

Wwapne Standard Keyboard

MNO
6

Prezz key on layout to modify

Modify |

Figure 7-49 CAT Keypad Modification Window

Apply ‘ Lancel

Select Modify to begin keypad customization.

Select a location on the keypad map that you wish to reprogram by touching it.

Choose a function from the Select Key Function pull-down that you wish to assign to a keypad
location. Be sure that the function that you assign to a location matches the CAT Keypad layout.
See Figure 7-50.

=

pard——

HO

CANCEL

Default K.eypad - Chevion Generic

Select Key Function

TV

CLEAR ] ENTER

Prezz key on layout to modify

Modify | LCancel

Figure 7-50 Select Key Function Pull-down

Apply ‘

4. Select OK then select the next location to program. Touch the Apply button when programming
is complete and you wish to save and exit.
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7.7.2 CAT Programming - Each

The individual CAT programming options allow you to program settings for individual CATs at your
site.

1. From the Programming Access window select System > CAT > Each. See Figure 7-51.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the programming to take full effect. For additional information on performing a shutdown
and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of the
Operations Manual (Part No. 1-920494).

Customer, Activated Terminal (CAT) Programming

CAT Mode -~
2 Session
&) Session
4 Session
5 Session
3 Session
Bemove | Modify... | Clone... | Lloze |
Add a new entry into the database

Figure 7-51 CAT Programming Window

2. Select Add or Modify to bring up the Customer Activated Terminal Options window which will
allow you to program an additional CAT or modify an existing CAT. See Figure 7-52 below.

Customer, Activated Terminal Options

l_ Make and Model:
Display Size: |'wiapne 2416 -
'S Communications...

[v Bill Azceptor attached to this CAT:

WARMING: System must be restarted for these ch to take
effect.

v Activate Bill Acceptor Upon Menu Exit

Ok | Lancel |

Figure 7-52 CAT Options Window
e Program the display size from the Display Size pull-down menu.

If Gilbarco has been selected as a pump manufacturer, (See Site Programming on page 88), and
the Display Size has been set to either Monochrome or Infoscreen then the following information
about Gilbarco CRINDs is applicable.
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Customer, Activated Terminal Options

CAT Number: [1 Make and Madel

Nucleus will support the
use of the 8 softkeys on
the CRIND display when
either of these two CRIND
types are selected

Gilbarco Multi-Line
Gilbarco Infoscreen

WARMING: System must be restarted for these ch to take
effect.

-

Ok | LCancel |

Figure 7-53 Gilbarco Display Type Programming

The Gilbarco CRIND softkeys will be used when the Monochrome or Infoscreen display type is
selected. These softkeys will be used instead of the Yes and No on the CRIND fixed keypad. They
will also be used to display car wash product choices.

The Gilbarco support does not include graphics animation in the ad chains like that which is
available on Wayne CATs. However, a single graphic or a single ad message can be displayed
during fueling.

e Program the type of Full Service Mode for the CAT, by selecting either Session or
Transaction.

*  Session mode means that an attendant can sign on to a CAT and remain signed on for
multiple transactions. The session does not end until the attendant signs off.

*  Transaction mode means that an attendant must sign on for every transaction. The CAT
automatically signs the attendant off after every transaction.

e Check the Bill Acceptors Attached to this CAT box if a bill acceptor is present.
e Check the Activate Bill Acceptor Upon Menu Exit box to activate the station’s bill acceptors.

NOTE:Check the Activate Bill Acceptor Upon Menu EXxit box to activate the station's bill acceptors.
Enable this feature after enabling the Bill Acceptors Active programming under Programming >
System > CAT > Site. See Figure 7-29.

NOTE:BIll Acceptor support for Gilbarco and Tokheim dispensers will be available in a later release
of software.

e Touch Communications to display the Communications window. See Figure 7-54.
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Communications

CC Board Electronic Interface Board

i i i (O { e

Channel

& 3 4 Address |1—
Ok | Lancel |

Figure 7-54 Communications Window

*  The Communications programming window is where the CC Board, Electronic Interface
Board, Channel, and Address can be programmed.

IMPORTANT:The 4 programming options in the Communications programming window will be
programmed when Nucleus is installed at the site. Only qualified service technicians should make
changes to these options.

*  CC Board - The CC Board (Serial Communications Controller Board) is where the
software that controls pumps and CATs runs. The CC Board is always programmed to
1.

*  Electronic Interface Board (EIB) - The Electronic Interface Board controls the fueling
points at the site. If a site has more than 16 fueling points, then it will have two EIBs.
EIB A controls fueling points 1-16 and EIB B controls fueling points 17-24. The system
will automatically select the correct EIB programming for the CAT.

*  Channel - The Channel is an output from the EIB. Each EIB has two CAT channels and
each CAT channel controls up to 8 fueling points. The CATs must be distributed evenly
between the CAT channels. Only qualified service technicians should make changes to
this option.

*  Address - The Address is the unigque identifying number programmed into the CAT.
Nucleus will automatically assign the next available Address to each CAT that is added
into the system.

*  Choose OK to save and exit or choose Cancel to exit without saving.

3. Toremove a CAT, select the CAT that you want to remove from the Customer Activated
Terminal (CAT) Programming window and press Remove. Confirm the Remove in the Confirm
Remove Operation window by pressing OK.

4. Choose OK to save and exit or choose Cancel to exit without saving.

69
August 2008 Part No. 2-920494 Rev. G




7.7.3 Logos Programming
The Logos programming window is used to program the headers and footers for the receipts
generated at the CATs.

1. From the Programming Access window select System > CAT > Logos, to open the Logos
window. See Figure 7-55.

Header
Line 1: [Tom's Chevian

Line 2 100 Anpstrest

Line 2t anptown, TX
Line 4: [5TH 0001100

Footer

Line 1: [THANK ¥OU FOR
Line 2 [CHOOSING CHEVRON
Line3: |

ok | Lancel |

Figure 7-55 Logos Window

2. Use the QWERTY keyboard to enter data for the Header and Footer to be printed on the CAT
receipts.

NOTE:Each site must put its station ID in Line 4 to conform to Chevron host specifications.
e Note that there are 19 spaces that can be used per line.

e Messages can be centered by simply typing in the message. Although the logo information
appears aligned to the left in your window, the printed logo is centered on the receipt
automatically.

e Use leading spaces before the text to right justify the message.

e Use the 1AB key on the QWERTY keyboard to go from line to line and from the Header to the
Footer sections.

Input your station ID in Line 4.

Choose OK to save and exit or choose Cancel to exit without saving.

7.8 Security Camera

The Security Camera programming window is used to activate the port that the Security Camera is
plugged into. The port must be activated using this feature because Nucleus will not recognize the
presence of the Security Camera automatically.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the programming to take full effect. For additional information on performing a shutdown
and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of the
Operations Manual (Part No. 1-920494).

e From the Programming Access window select System > Security Camera. The Security
Camera window opens as shown in Figure 7-56 below.
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Security Camera

WARMING: System must be restarted for this
change to take effect.

Ok | Lancel |

Figure 7-56 Security Camera Window

e Check the Security Camera Installed box if a camera is plugged into the Nucleus system.
e Choose OK to save and exit or choose Cancel to exit without saving.

7.9 Peripheral Configuration

This feature allows the user to specify the location for printing each report using a programming
option. Go to Programming > System > Peripheral Configuration to access the programming
screen. An option called Report Printer Installed has been added to the Peripheral Configuration
screen which allows a site to specify whether there is a report printer installed. If the option is
checked then the “40 Column Printer” and “80 Column Printer” options will be enabled.

NOTE:If there is no report printer connected, the system will use the receipt printer connected to
the Store Controller.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the programming to take full effect. For additional information on performing a shutdown
and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of the
Operations Manual (Part No. 1-920494).

From the Programming Access window select System > Peripheral Configuration. The Peripheral
Configuration window opens as shown in Figure 7-57 below.

e Report Printer Installed - Check this box if a Report Printer is installed.

Peripheral Confi

¥ Report Frinter Installed

Fepaort Printer Types
€ B0 Column Frinter

WARMING: System must be restarted
for thiz change to take effect.

Ok | Lancel |

Figure 7-57 Peripheral Configuration Window

e Choose 40 Column Printer as the Report Printer Type installed at the site.
e Choose OK to save and exit or choose Cancel to exit without saving.

NOTE:Chevron Stations use a 40 column thermal printer for the Report printer. The default setting
of “40 Column Printer” should not be changed.
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7.10

72

The programming option for Printer Location and the “Cycle Location” button in the Report > Setup
> Component screen will be available if the Report Printer Installed option has been checked.
The Printer Location options will be “Local Printer”, “Report Printer”, and “Ask”.

Report Components

Feports Compaonents Aszigned to Beport Compohents Available to Report
Auto Print Location Mame - Frint Tupe MHame - Print Tupe |Name -
FReport Printer |BALC Detailed Bill Tatalz
Yes Report Printer | BAC Refund
Yes Fieport Frinter |Batch
Mo Fieport Frinter | Canmash Cash Rec Ap
Mo Fiepart Frinter | Cashier
Yes Report Printer |Day
Yes Report Printer |Hrly Sales
Yes Report Printer | kail
Yes Repart Printer | Mix-M-k atch
Yes Report Printer | Dutdoor Attendant
Yes Fieport Frinter |PLU Feport
Yes Fiepart Frinter |PTD j ﬂ ﬂ

Togale Auta Print ‘ Move Up ‘ Bemaowe > |

£ Azsign

tove Down | E_lgc:leF'rintT_l,Jpe|

Cloze

Cycle Location

Figure 7-58 Report Component Programming Window

This will allow the default location for specific report components to be assigned to specific printers
or the user can be prompted to specify a location when printing reports. This is useful if the report
printer happens to be locked in the manager’s office after hours or if the report printer is low on
paper.

Backup Settings

The Backup Settings programming window is used to set up Nucleus for unattended and manual
system backups. Each backup contains an entire database backup, some configuration files and the
sales log. The backup utility will store 10 days of unattended backups in a rolling format with the
most recent backup being saved in the E:\backups\Nucleus01 directory and the oldest will be in the
E:\backups\Nucleus10 directory.

1. Select System > Backup Settings to access the Backup Settings window. See Figure 7-59
below.

2. ltis highly recommended that you check the Enable Unattended Backups box in the
Unattended Settings box to activate unattended backups.

a. Enter the Start Time and Days to perform the backup and program accordingly.

b. Select the Destination Directory where the files are to be stored from the pull-down menu.
The default directory for Unattended Backups is e:\backup.

3. Inthe Manual Settings section, select the Destination Directory from the pull-down menu to
use for any manual backups. The default directory for manual backups is e:\ManualBackup.

4. Choose OK to save and exit or choose Cancel to exit without saving.
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Backup Settings

Unattended Settings
[v Enable Unattended Backups
: + AM
Start Time ,2_ : W ~ EM Days: v Monday
- v Tuesday
v ‘wednesday
v Thursday
v Friday
[v Saturday
v Sunday
Destination Directory: |e:\backups J
Manual Settings
Destination Directory: |e:\ManuaIBackup J
Ok | LCancel |

Figure 7-59 Backup Settings Window

7.11 Back Office Configuration

Nucleus has added support for a NAXML compliant Back Office System. Select Programming >
System > Back Office Configuration to access the Back Office Configuration window.

Back Office Configuration i

Back Office Type

Import Frequency

{~ WOME & chi ™ Send ltem Adjustment Recaord ta Back Office
O ift

" NLINK [~ Send PLU/SKU Frogramming Records

" PDI STANDARD " Day

 NAxML [~ FTP Server Enabled

c . ¥ MetBios Enabled
[~ Back-Office iz Sunrize 2005 Compliant

Back Office Location Ma: ID MHAxML Configuration |

WARMING: System must be restarted for the above changes to take effect.

Check Digit Option Blackpipe Configuration
¥ Back-Office Sends Check Digit to Nucleus [~ Enable Blackpipe
F¥ Send Check Digit to Back-Office P el
Ok | Lancel | Ex=port Report Archives. .. |

Figure 7-60 Back Office Configuration Window
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NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the
changes in the programming to take full effect. For additional information on performing a shutdown
and restart, see the Countertop Reference manual (Part No. 8-920494) or Section 2 of the
Operations Manual (Part No. 1-920494).

NOTE:Chevron Nucleus Rel. 3.x and later contains a Pricebook Synchronization utility that will
synchronize the pricebook in Nucleus with the pricebook on the Back Office System. The Back
Office type must be set for Nlink or PDI Standard for this utility to work properly.

1.

Select the Back Office Type from the menu. NLINK should be selected for all vendors except
PDI and ACES. See Figure 7-60.

*  None

*  NLINK

*  PDI Standard
*  NAXML

*  NAXML & NLINK
*  NAXML & PDI STD

Choose the Import Frequency, either Shift or Day, to import data to the Back Office system at
the end of a shift or the end of a day.

NOTE:The reports that are chosen for export are converted to a format that is readable by the
specified back office system’s format and stored on the Nucleus system. The back office system
must still access Nucleus and download these files.

3.
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The Back Office Location No is an optional field used only by sites with a PDI Back Office
System.

Send Item Adjustment Distribution Record to Back Office - Check this box to send Price
Override data to the Back Office System using a 2001 record in the DRPIN.DAT. If it is left
unchecked, Price Override data will be sent to the BOS using a longer 2202 record. The new
record type will allow for additional data (such as the cashier who performed the price override)
to be added in the future.

Send PLU/SKU Programming Records - Check this box to send information to a Back Office
system that might not have all of the station products in the DRPIN.DAT file. This is useful for
sites that are replacing or installing a new back office system and do not yet have all of the
station product information in the price book. It's also useful for sites that have been scanning
but have not had a back office system until now and want to get all of the product information to
the back office. This box should be checked right before the End of Day is run and then all of the
information pulled to the back office. Once that process is complete then the box should be
unchecked to prevent the DRPIN.DAT file from growing too large.

FTP Server Enabled - Check this box to enable file transfers using FTP. This option is available
when any type of Back Office has been selected and the FTP server has been setup correctly.

NetBIOS Enabled - Check this box to turn on the NetBIOS over TCP/IP functionality. This
option is included here so that a station with older BOS software that requires NetBIOS to
operate, can still be used.

Back-Office is Sunrise 2005 Compliant - Check this box if the Back Office is Sunrise 2005
compliant.
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9. Use the following Check Digit Options to configure Nucleus to send or receive check digit
information from the Back Office System.

a. Back-Office Sends Check Digit to Nucleus - This is used to determine what type of UPC/
EAN the Back-Office is sending based on length.

b. Send Check Digit to Back-Office - This is used when uploading Sales Data to the Back-
Office. If the flag has been set then UPC/EAN numbers will include the check digit.

10. Blackpipe is a utility that will run on both Nucleus and the BOS. It will allow the back office
system and Nucleus to communicate with each other in a PCI-compliant manner. In order to be
PCI compliant, only Nucleus will be allowed to initiate any data transfers between Nucleus and
the BOS. To use Blackpipe communications, check the Enable Blackpipe check box and then
provide the IP Address of the BOS system,

11. Touch the NAXML Configuration button from the Back Office Configuration window to access
the NAXML Configuration options. This button will only be active when a back office type that
includes NAXML has been selected. These following options are enabled by default.

NOTE:Changes to the NAXML Configuration can be done by the manager with the proper security
level.

NAXML Configuration

MeehML Schema Yersion
- 333 v 34

FOS Maintenance

FOS Journal

v Enabled Cloge File Configuration

Mumber OF Events 1
Time [n Minutes il

FOS Movement

v Enabled Cloge File Configuration

Mumber OF Events 1
Time [n Minutes il

Ok Lancel

Figure 7-61 NAXML Configuration Window

a. POS Maintenance can be disabled which means that Nucleus no longer processes any of
the maintenance files sent to it from the BOS.

b. POS Journal can be disabled which means that Nucleus no longer creates PJR entries for
each transaction.

c. POS Movement can be disabled which means that Nucleus no longer sends summary data
for all the events that are tied to summary such as fuel or product sales.

*  Merchandise Code Movement for both station level (MCM) and "By cashier by terminal”
(MCMD) granularity. If the enable button for POS Movement is checked, all of the
movement will be enabled including this one, and vise versa.
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d. Close File Configuration settings are used to set the Number of Events which is defined
as the maximum number of Nucleus events (sales and financial transactions, EOS, or EOD)
that are written to a file before it is closed, zipped, and prepared for transport to the back
office system. Time in Minutes is set as the maximum time in minutes for a file to be open

before it is closed, zipped, and prepared for transport to the back office system.
e. Select the NAXML Schema Version to be used. Select either 3.3.3 or 3.4.

12. Touch the Export Report Archives button from the Back Office Configuration window to access

the Export window.

*  If the Shift selection was made in the Back Office Configuration window then the Export
Shift Report window will appear. See Figure Figure 7-62.

Export Shift Report

£ |wed Jul 07 16:12:03 2004 |wed Jul 07 16:13:55 2004

E=port Lloze |

Figure 7-62 Export Shift Report Window

*  If the Day selection was made in the Back Office Configuration window then the Export Day
Report window will appear. See Figure Figure 7-63.

Export Day Report

Lloze |

Figure 7-63 Export Day Report Window

From the Export Shift Report or the Export Day Report windows, select the shift/day report to export
and touch Export. Touch Close to exit.

NOTE:The Nucleus system will keep active up to 14 days of Shift and Day reports available for

export.
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7.12 Tier / Feature

The Tier/Feature section allows the programming of different Tiers of Nucleus functionality, each
with different sets of features. Different Tiers of functionality are available for purchase making it
possible for a site to choose the features of Nucleus that are desired without having to pay for the
features that are not needed. With the purchase of higher Tiers, all lower Tier features will be
available. A site can also downgrade from a higher Tier to a lower Tier if the features of the higher
Tier are not needed and therefore reduce their fee. Select System > Tier/Feature and the following
window will be displayed which shows the current Tier and a list of features and whether or not the
features are available with the current Tier.

Tier /Feature Configuration

Current Tier: |-|_

Feature Tier Available |«
Back Office Interface 2 Mo ol
Bill Acceptar in Pump 3 Mo

Car Wash Interface 2 Mo

Discount Fuel Price - Canwash ] Mo

Discount Fuel Price - Tender 3 Mo

Graphics Messaging at CAT 2 Mo

Mannate Interface 2 Mo

Multiple Indoor Terminals 2 Mo

Mucleus Back Office 4 Mo
Programmable Car W azh Prompting 3 Mo

Scanning 2 Mo

Security Camera Interface 2 Mo

 Kep/Pazsword Execution

Key: |

Password: |

Must get password

Get Key |

oK

| Lancel |

Apply

Figure 7-64 Tier/Feature Configuration Window 1

If a Tier upgrade is desired then the user presses the Get Key button and the following window wiill

be displayed.
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Tier /Feature Configuration

Current Tier: |1

Feature T

Back Office Interface 2

Bill Acceptar in Pump 3

Car Wash Interface 2

Discount Fuel Price - Canwash ] Mo

Discount Fuel Price - Tender 3 Mo

Graphics Messaging at CAT 2 Mo
2
2
1
3
2
2

ier Available |«
Mo ol
Mo

Mo

Mannate Interface Mo
Multiple Indoor Terminals Mo
Mucleus Back Office Mo
Programmable Car W azh Prompting Mo
Scanning Mo
Security Camera Interface Mo -

 Kep/Pazsword Execution

Key: |1 E583-92532-27015-32193

Password: |

Must get password

Ok | Lancel | Apply |

Figure 7-65 Tier/Feature Configuration Window 2

The Key which is displayed in the Key field is provided to the RTSC Help Desk which will provide a
password which is entered in the Password field. Press the Apply button to continue and the
following window will be displayed. If the OK button is pressed the Tier or feature will be updated
and the window closed.

Tier/Feature Configuration

Currert Tier: |2

Feature Tier Available | -
Discount Fuel Price - Canwash 2 es

Discount Fuel Price - Tender 3 es
Programmable Car W azh Prompting 3 es

Key/Pazsword Execution

Key: |

Password: |

Must get password

Ok | Lancel | Apply |

Figure 7-66 Tier/Feature Configuration Window 3

Note that in the example above that the current Tier has been upgraded to 2 and the Tier 2 functions
have now been made available. Tier 3 functions are still disabled until the site upgrades to the next
level. Press OK to close the window or Get Key to repeat the process and upgrade to the next level.
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7.13 Loyalty

The Loyalty feature is used to program the system so that a customer can receive a discount on the
unit price of fuel. The Loyalty discount is implemented so that once qualified, the customer will
automatically get a lower price per unit of fuel. Loyalty discounts can be applied to the fuel price
before or after fueling and are available to the customer for in-store fuel sales as well as sales at the
CAT.

Non-Fuel discounts can be set up, but only for Host-based Loyalty accounts. The Loyalty program is
implemented two different ways, Loyalty Accounts, and Loyalty Based on Tender or Card Type.
Select System > Loyalty and the following screen is displayed.

Loyalty

| Loyaly Accounts Setup |

Lovaly Bazed on Tender / Card Type |

Lloze

Figure 7-67 Loyalty Selection Window

7.13.1 Loyalty Accounts

Loyalty Accounts are set up as either Local or Host based accounts. Loyalty cannot be setup to use
both local and host based accounts. This means that individual accounts can be set up that are
either controlled locally at the individual store level or controlled by a host system which is located
off site.

7.13.1.1 Local Loyalty Account Setup
To setup Loyalty accounts using manual entry of an Account number, use the following procedure.

1. Goto Programming > System > Loyalty > Local Accounts. The following window will be
displayed.

Loyalty Setup

v Enable Loyalty Fuel
Limnit: [

Type Account Type ezt | PO
&+ Local v Phone Number

v Use Local Area Code
" Host Based [v Card &ccount

Local Area Code: |512

‘ I Loyaly Accounts ‘

Feceipt Meszage ‘ i [CAT Prompts £ ICAT Prompts ‘

QK LCancel

Figure 7-68 Loyalty Setup Window
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2. Check the Enable Loyalty box to enable the loyalty function.
3. Select the loyalty Type. Choose either:

*  Local - All account setup, qualifications, awards, adds and deletions will be controlled by
each individual site.

*  Host - Accounts are controlled by a host based system.
a. To set up Local loyalty, proceed with the following steps:

1) Click on Local in the type box. Thiswill enable the Loyalty Accounts button.

2.) Click the Loyalty Accounts button to display awindow where the all of the Loyalty Accounts
are shown. From this window the Loyalty Accounts can be M odified or Removed and new
accounts can be Added.

NOTE:The Loyalty Accounts function will only be available when the Loyalty Type is set to Local.
See Figure 7-68.

Loyalty Accounts

Customer Mame

Sanford, Fred GOOD
7203046920275 Douglas, Dliver GOOD

-]

Add Bemove | Modify | Lloze |

Figure 7-69 Loyalty Accounts Window

3.) Click Add to add a new entry or select an existing account and press M odify. The following
window will be displayed.

Loyalty Account

Account H: 123456

First Mame: Jane
Last Mame: Doe

Phane #: 512 - [s88 - [1212

Account Status

o+ Active

H ¢ Bad
Balance Due: [$0.00
Qg | Lancel
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Figure 7-70 Loyalty Account Detail
From this window you can enter the following information:

*  Account number - Enter by either swiping the loyalty card at the ICAT or entering it
manually.

*  Name of the Account holder.
*  Phone Number of the account holder - Used to verify the account holders identity.

Mask Account Number on Receipts - The Loyalty account number will not be
displayed on the receipt

*  Account Status of the account holder - Used to indicate whether to accept the loyalty
discounts on this account or not.

*  Balance Due - Enter the amount that the account holder owes the station due to a
customer drive off. This field will not automatically update, but will need to be modified
by the station as needed.

4.) Click OK to save and exit or Cancel to exit without saving.
b. To set up Host loyalty, proceed with the following steps:

1) Click on Host Based in the Type box. Thiswill enable the Host Setup and Card Setup buttons.

2.) Click the Host Setup button to display awindow where you configure communications with the
Loyalty Host.

NOTE:The Host Setup function will only be available when the Loyalty Type is set to Host Based.
See Figure 7-68.

 weh Service

IPAddress— [132.168.1.1

Part Mumnber: ID Request Timeout: IBD

WARMING: System must be restarted for these changes to take effect.

Ok | Lancel |

Figure 7-71 Loyalty Host Setup Window - Sockets
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" Communication Type

" Saockets o ’W’

URL |www.example.com
Part Mumnber: Igg Request Timeout: IBD
WARMING: System must be restarted for these ch to take effect.
Ok | Lancel |

|
Figure 7-72 Loyalty Host Setup Window - Web Service

The Host Setup window is used to setup the Loyalty host Communication Type using either
Sockets or Web Service:

3)

4)

5)
6.

Select Sockets to enter the | P Address, the Port Number, and the Timeout Value for the Loy-
alty Host.

_Or-

Select Web Serviceto enter the URL and the Port Number, and the Timeout Value for the Loy-
alty Host.

Press OK to save and exit or Cancel to exit without saving.

Select Card Setup to program Nucleus to accept the loyalty cards.

NOTE:The Card Setup function will only be available when the Loyalty Type is set to Host Based.
See Figure 7-68.

7)
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Loyalty Cards

Account Mumnber I ame i‘
123456789

Quick Stop Loyalty

-]

Add | Bemove | Modify | Lloze |

Figure 7-73 Host Based Loyalty Card Setup

Select Add to program a new account or select an existing account and press M odify. See the
following figure.
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Card Setup

150 Mumber:

Card Marme: |Rewards
Name on Receipt: |FwDs
v Allow Marual Entry v Mazk Account Number on Receipts

Ok Lancel

Figure 7-74 Host Based Loyalty Card Entry
8.) Enter the SO Number from the card.
9.) Enter the Card Name which isthe issuer of the card.
10.) Enter the Name on Receipt which is the name to be printed on the receipt.
11.) Select Allow Manual Entry to allow the manual entry of the card information.
12.) Select Mask Account Number on Receiptsto hide the Loyalty account number on the receipt.
13.) Press OK to save and exit or Cancel to exit without saving.
4. Program the Account Type by enabling Phone Number and/or Card Account.

*  Phone Number - Enable Phone Number to require that the account holder’s phone
number be entered at the CAT (outdoor) or ICAT (indoor) when using the Loyalty function.
The account holder’s phone number will also be used as the Account number in the case
where Phone number is enabled but Card Account is not.

*  Card Account - Enable Card Account to require the use of a Loyalty card to be swiped at
the CAT or the ICAT when using the Loyalty function.

5. Enter the Fuel Volume Limit and Discount amount if desired. Setting a limit amount means that
the dispenser will only pump up to the fuel volume limit that is set here and then stop. Setting
the fuel discount amount means that the price per unit of fuel will be discounted by the amount
set here.

6. The Use Local Area Code enable box and the Local Area Code field are used whenever the
Account Type is set to Phone Number. When Use Local Area Code is enabled and the Local
Area Code entered matches the customers area code that was used during the loyalty account
setup, then the customer only has to enter his/her 7 digit phone number to use the loyalty
function.

7. Select the Receipt Message button to display the following window.
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Footer text that will appear
on a Indoor or CAT receipt

when using Loyalty —_—

Footer text that will appear
on a Indoor or CAT receipt

when not using Loyalty —— lpm

Loyalty Receipts

Loyaly Receipt Texst

[Thark ou for Using

|Our Laovwealty Prograrm

Mon-Loyalty Receipt Text

|J0in Cur Loyalty

|Pr0gram and Sawve

Ok Lancel

Figure 7-75 Loyalty Receipts Window

Enter the Loyalty Receipt Text for the text that will appear in the footer of the Indoor and

CAT receipts whenever a customer performs a Loyalty transaction. (20 character maximum

in each line)

Enter the Non-Loyalty Receipt Text for the text that will appear in the footer of the Indoor

and CAT receipts whenever a customer performs a Non-Loyalty transaction. (20 character

maximum in each line)

8. Select the CAT Prompts button to display a window where the CAT prompts can be customized
according to language and function. There are six messages/prompts that can be modified
which are associated with Loyalty transactions. The messages/prompts can be customized
according to station requirements and CAT display hardware but the messages must still
convey the intended function of the message/prompt. The 2-line text CAT display will support 16

characters per line while the 4-Line CAT display will support 20 characters per line.

Prompt and Language

-4 selection pull-down.

Idle prompt when using
Loyalty on a 2-Line CAT

Frampt:

IDLE Prompt - English

Frompt Test
2-Line Test:
Inser Loyalty

>

display

Idle prompt when using
Loyalty on a 4-Line CAT

or Press Enter

4-Line Text/Graphic:
Insert Loyalty Card

or Press Enter

display

84

for Manual Entry

Ok | Feset to Defaults | Lancel |

Figure 7-76 CAT Loyalty Prompts
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Select the Prompt to modify from the Prompt and Language Pull down and program each
message according to station requirements.

*  Remove Nozzle Prompt
*  Select Grade Prompt

*  Push to Start Prompt

*  IDLE Prompt

*  Enter Loyalty Message
*  Invalid Loyalty Message

Modify the text to be displayed according to the type of CAT display hardware that is
installed at the CAT.

Click OK to save and exit or Cancel to exit without saving.

Click Reset to Defaults if you want to set all CAT prompt text messages back to their
default values.

9. Select the ICAT Prompts button to display a window where the ICAT prompts can be
customized according to language and function. There are three messages/prompts that can be
modified which are associated with Loyalty transactions. The messages/prompts can be
customized according to station requirements but the messages must still convey the intended
function of the message/prompt.

Idle prompt when using Prompt Test
Loyalty on a 2-Line ICAT 2.Line Test:
dlsplay -1 Insert Payment
or Loyalty Card
Ok | Fieset to Defaults | Lancel |

Loyalty P t
Prompt and Language

™ selection pull-down.

Prompt:

Figure 7-77 ICAT Loyalty Prompts

Select the Prompt to modify from the Prompt and Language Pull down and program each
message according to station requirements.

*  |dle Prompt

*  Enter Loyalty Prompt

*  |nvalid Loyalty Prompt

Click OK to save and exit or Cancel to exit without saving.

Click Reset to Defaults if you want to set all ICAT prompt text messages back to their
default values.
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10. Click OK at the Loyalty Setup Window to save and exit or Cancel to exit without saving. See
Figure 7-68.

11. Once the setup is been completed, the user can add loyalty accounts from the Nucleus

Operations screen by pressing the Special Operations button then the Account Activation
button.

12. When Account Activation button is pressed a screen will come up asking for Account number,
Customer Name and Phone Number. There will be an Activate and a Cancel button on the
Account Activation screen.

Swipe or Enter LOYALTY Card

Account Number: |
Activate
First Name: | Last Name: |

Telephone Number: |
Cancel

_—
o
o
f

I ENTER CLEAR

Figure 7-78 Loyalty Account Activation Window

*  The minimum length for account number will be 5 digits, the maximum length will be 16 -
regardless of the Unique Identifier.

On this screen the cashier will be allowed to either enter an account manually or swipe a
loyalty card.

If the account number entered is a duplicate, the cashier will receive a message 'Loyalty
Account Number already exists' Any updates to an account (e.g. change phone number)
must be done through programming.

13. Press the Activate button to save and exit or Cancel to exit without saving.

7.13.2 Loyalty Based on Tender / Card Type

Fuel discounts can be programmed in two different ways. First, the fuel price may be discounted
with the use of a particular type of electronic tender such as credit or debit card. Discounts can also
be granted based on the use of a particular brand of credit card. Secondly, the discount can be
based on the use of cash or check. See Figure 7-79. This feature can be enabled by increasing the
Tier level or if the site does not have a Tierability contract with Dresser Wayne, then this feature can
be enabled and disabled based on programming. To access this feature select System > Loyalty >
Loyalty Based on Tender / Card Type and the following window will be displayed.
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Program Loyalty Amount(s)

By Electronic Tender
Discount Level
o Bl " Tender + Card Type
|DISEDVEF| j Grade Mame Fuel Dizcount Amount
b |Diesel 0.250
Plus 0.250
[v &pply Discount To All Grades Fremium 0,250
. Fegular 0.250
Discount: {40 250
By Other Tender
[~ Enabled
| J Grade Mame Fuel Dizcount Amount
b |Diesel 0.000
Plus 0.000
[~ &pply Discount To All Grades Premium 0.000
. Fegular 0.000
Discount: {40,000
Ok Lancel

Figure 7-79 Program Loyalty Amount(s) Window

The allowable discount amount is from $0.00 to $9.99. Any amount entered which is outside of the
allowable amount will generate an error message.

If the discount based on electronic tender is needed then proceed with the following steps:

1.
2.

6.

Check the Enabled box in the Electronic Tender area.

To grant a discount based on the use of a credit card, debit card, or contactless card, select
Tender as the Discount Level type, then select credit card, debit card, or contactless from the
Card Type pull-down.

To grant a discount based on the use of any particular supported credit card, select Card Type
as the Discount Level type, then select the credit card brand from the Card Type pull-down.

To program the discount amount to be granted for all grades, check the Apply Discount to All
Grades box, then enter the discount amount.

To program the discount amount for each individual grade, select the Grade Name, then enter
the Fuel Discount Amount. Repeat for additional grades.

Select Apply, then OK to save and exit or Cancel to exit without saving.

If the discount based on the use of cash or check is needed then proceed with the following steps:

1.
2.

Check the Enabled box in the Other Tender area.

To grant a discount based on the use of cash or check, select Cash or Check from the Cash
pull-down.

To program the discount amount to be granted for all grades, check the Apply Discount to All
Grades box, then enter the discount amount.

To program the discount amount for each individual grade, select the Grade Name, then enter
the Fuel Discount Amount. Repeat for additional grades.

Select Apply, then OK to save and exit or Cancel to exit without saving.
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7.14 Site Programming
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Site Programming is where particular dispenser brands are defined for the site. (Wayne, Gilbarco, or
Tokheim) Note that only one brand of dispenser is allowed per site, which means that all the
dispensers at a site must be one brand or another and not mixed. This programming screen is also
where the Nucleus system is set to either gallons or liters. Again, the entire site is set for either
gallons or liters, mixing of measurements at one site is not supported.

NOTE:If a different dispenser brand than the currently defined one is selected then all pump and
CAT programming is deleted, requiring the new pumps and CATs to be programmed from scratch.
These settings should only be changed by trained service personnel.

1. Goto Programming > System > Site.

Pump & CAT Manufacturer: Yolume Measurement Type
+ Gallons
" Liters

I &llow 5 ales Until Battery Low Forecourt Hardware

¢ SCC Board [PC| Card]
" Fusion

-

™ Secure Payment Modules Installed

|
T

WARMING: System must be restarted for theze changes to take effect.

LCancel

Figure 7-80 Site Programming Window

2. Select the pump type from the Pump & CAT Manufacturer pull-down.
3. Select the Volume Measurement Type of either Gallons or Liters.

NOTE:Fuel measurement in liters is supported on Wayne, Tokheim, and Gilbarco dispensers. Each
individual pump must also be programmed to support either liter or gallon measurement before
communication with Nucleus can be established. This is usually accomplished by modifying the
dispenser option switch settings inside of the dispenser. Refer to your Installation and Operations
manual for your model of dispenser.

NOTE:Canadian sites programmed to support liters will have receipts which indicate “Litres”.

4. Enable the Allow Sales Until Battery Low box to allow the cashier to finalize transactions
currently in progress during a power failure event. The system can then be shut down with no
un-finalized transactions still pending. If the option is not enabled then the system will not be
able to ring up transactions from customers whose fueling was interrupted by the power failure.

NOTE:The programming selection Pumps were manufactured before 1989 is only applicable to
Gilbarco and should only be modified by a qualified Service Technician. This programming option
should only be enabled if both of the following conditions are met:

* 400, 500, or 600 Series PIE chips are installed in the Competitive Primary Distribution Box

*  The Gilbarco dispensers installed were manufactured before 1989.
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Select OK to save changes and exit or Cancel to exit without saving.

Nucleus must be shutdown and restarted before changes to this programming screen become
active.

7. Enable the Secure Payment Modules Installed option if Wayne Secure Payment Modules are
installed at the dispenser.

8. Indicate the type of Forecourt Hardware that is installed at the site. Select either SCC Board
(PCI Card) if an SCC Board is currently installed in the Nucleus server, or select Fusion if a
seperate Forecourt Controller is used to communicate to the dispensers. If the Fusion Controller
is selected, you will need to input the IP Address of the device and the Port Number.

9. Select OK to save changes and exit or Cancel to exit without saving.

10. Nucleus must be shutdown and restarted before changes to this programming screen become
active.

7.15 Mannatec Support
Nucleus supports the Mannatec proprietary card network. Mannatec cards can be used outdoors at
the CAT or indoors at the Nucleus ICAT. All Mannatec transactions will be processed through the
Mannatec Authorization Control Unit which is interfaced to the Nucleus system via the Edgeport
serial device. Once the Mannatec unit has been installed and cabled correctly, the following steps
need to be performed to properly setup the Mannatec device.
7.15.1 Enabling the Mannatec Interface

1. Goto Programming > System > Mannatec, and the following screen will be displayed.

‘ Interface |

150z ‘

Communication T est ‘

Lloze

Figure 7-81 Mannatec Window

2. Select the Interface button and the following screen will be displayed.
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Site 1d:

Store & Fonward
" Empty at End OF Shift

» Empty at End OF Day

WARMING: System must be restarted for these
changes to take effect.

Ok | Lancel |

Figure 7-82 Mannatec Interface Window
Select the Enable Mannatec Interface box to enable the Mannatec device.
Enter the Site ID which is provided by Mannatec.
Select whether to empty the Store & Forward table at the End of Shift or the End of Day.
Select OK to save changes and exit or Cancel to exit without saving.

o ok~ w

7.15.2 Manually Entering Mannatec ISO Data
ISO data for individual cards can be entered using the following steps.

1. Goto Programming > System > Mannatec > ISO’s > Add. The following window will be
displayed.

Mannatec 1SO

ISO04: I

Card Mame: |

Card Mame on Receipt: |

15150 Humber Emboszed on Card
" No + ‘ez

Iv Allow Manual Entry

‘ WARMING: Changes Will Take Effect at End of Shift ‘

Ok Lancel

Figure 7-83 Mannatec ISO Add/Modify Window

Enter the ISO number which is provided by Mannatec for their fleet cards.

Enter the Card Name using the full name of the card issuer, then the Card Name on Receipt
using the card name that will be used on the receipt which is usually a shortened version of the
actual card issuer’s name, i.e.Card Name=MNTC and Card Name on Receipt=Mannatec.
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4. Select whether or not the ISO number is Embossed on Card.
5. Select whether or not to allow manual entry of card information.
6. Select OK to save changes and exit or Cancel to exit without saving.

7.15.3 Mannatec Communication Test

Select Communication Test from the Mannatec window to test the communication between the
Nucleus system and the Mannatec device. This test does not include communications to the
Mannatec host.

7.16 Machine Configuration

The Machine Configuration window is used to easily change the SC/IPT's Machine Name, it's IP
address, and whether or not the IP address scheme will be Static or DHCP. This window makes it
easy to change all of the options from one location rather than having to navigate to the appropriate
location from within the Windows OS.

NOTE:The Machine Configuration utility is run on both the SC and on the individual IPTs to modify
the individual IPT addresses. Call the Help Desk for assistance.

/N cauton

The Machine Configuration information should not be modified except by a trained Wayne Ser-
vice technician. Changes to this area of system programming could render your system inoper-
able.

Machine Configuration does the following tasks:

e Change IP address

e Change machine name

e Change ODBC Sql Server name

e Change environment variables (SC_NAME and LOCAL_IP_ADDRESS)

The machine configuration tool has two versions, one which operates on the Store Controller and
one which operates on the IPT.
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7.16.1 Machine Configuration on the Store Controller

1. On the Store Controller, go to Programming > System > Machine Configuration and the
following window will be displayed.

Machine configuration

b achine name: |

Modify Machine Mame |

Metwark Adapter Mame DHCP Enabled |IP Address Subnet Mazk -

Local Area Connection 19216811 256,255, 255.0

Il

The system must be rebooted for any changes to take effect.

Modify Metwaork Adapter Configuration Cloze

Figure 7-84 Machine Configuration Window on Store Controller

2. Click the Modify Machine Name button and enter the desired machine name, then click OK.
See the following window.

Modify Machine Configuration

M achine name: |

Mew maching name: |_5[;1

Force IPT name changes bazed on the naming —

convention used above.
Cancel

Figure 7-85 Modify Machine Configuration Window

3. Next, click the Modify Network Adapter Configuration button, select either Static IP Address
or DHCP depending on station requirements. If Static Address is selected then enter the IP
address, Subnet Mask and Default Gateway then click OK. See the following figure.
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Modify Network Adapter Paramets

Hetwark Adapter Mame: ILocaI Area Connection

IP Address:
Subnet Mask:

Drefault Gateway:

QDK |

" DHCP address

|192.188.1.1

|255.255.255.0

|192.188.1.254

Cancel

Figure 7-86 Modify Network Adapter Parameters Window

Close the main configuration window.
Reboot Nucleus.

Nucleus will reboot and then run some scripts to change the configuration and automatically

reboot the system.

7. Wait until Nucleus is up and running again. Go to Programming > System > Machine

Configuration to check the settings again. Close the window.

7.16.2 Machine Configuration on the IPT

NOTE:If an IPT starts up and cannot locate the server then it will automatically start the Machine

Configuration utility.
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The user interface for Machine Configuration when running on an IPT will have a different

programming window. It has a “Modify Store Controller Name” button. To change the settings,
perform the following steps.

1. Onthe IPT, go to Programming > System > Machine Configuration and the following window
will be displayed.

Machine configuration k

Machine name: |

todity Machine Mame

Store controller machine 1P
| Modify Store Contraller [P

Metwork ddapter Hame DHCF Enabled |IP Addiess Subnet Magk -

Local Area Connection 192168.1.2 25h.255.255.0

=]

The system must be rebooted for any changes to take effect.

Modify Metwark Adapter Configuration Close

Figure 7-87 Machine Configuration Window on IPT

2. If the machine name of the IPT is not correct, click the Modify Machine Name button, enter the
desired machine name and then click OK. See the following window.

Modify Machine Configuration k

b aching name: |

MNew maching name: |NL|[:|_EL|S_IPT2

DK ool

Figure 7-88 Modify Machine Configuration Window

3. Click the Modify Store Controller IP button (even if the store controller IP is correct) and the

SC configuration will pop up. Check the box Using Static IP Addresses and then enter the IP
address of the store controller. Click OK. See the following figure.
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Modify Store Controller Name

[

|192_1se.1.1

Store Controller [P Address:

ak. ‘ Cancel

Figure 7-89 Modify Store Controller Name Window

4. |If the IP address of the IPT is not correct, click the Modify Network Adapter Configuration
button. If the site is using DHCP addressing then uncheck the Using Static IP Addresses box.
If Static IP Addresses are going to be used then select Static IP Address and enter the correct
IP address. See the following window. Click OK to continue.

Modify Network Adapter Parameters

Metwark. Adapter Mame: |

" DHCP address

IF &ddress: |192.1 £3.1.2
Subret bask: |255.255.255.u
Default Gateway: |En0r i}

oK ‘ Cancel

-k

Figure 7-90 Modify Network Adapters Parameters Window

Close the main configuration window and reboot the IPT.

When Nucleus restarts, it will run some scripts to change the configuration and automatically
reboot the system a second time.

7. Wait until IPT is up and running.

95

August 2008 Part No. 2-920494 Rev. G



7.17 Port Configuration
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Nucleus has a port mapping function which allows a site to modify it's port mapping for the COM,
USB, and TCP ports. Nucleus provides a default port mapping configuration which is set by the
application and resides on each SC/IPT or IPT. If changes are required the user must use the Port
Mapping screen described below to make any changes to the port mapping file. If the number of
ports changes, the user enters the correct number of COM, USB, or TCP ports, then after the
screen refreshes, types the name of the port then assigns the device to the port. A reboot of the
Store Controller and/or IPTs is required for changes to take effect. The Port Configuration function is
security level protected which prevents unauthorized modifications of the port map file.

WARNING:Use of the Port Configuration function should be limited to trained personnel only.
The Port Configuration window is accessed from System > Port Configuration.

The example configuration window below shows drop down list boxes for the ports and the devices.
In other words, if the system indicates the machine has 14 COM ports, then only entries for 14 COM
ports are shown. If the site is programmed to have 8 USB ports, then only entries for 8 USB ports
are shown. However, these ports can still be set to have nothing connected.

The menu displayed will reflect the configuration of that machine only. To make port mapping
changes on other terminals, the Port Configuration utility must be executed on those particular
machines.

Use the Restore Defaults button to restore to the default (factory) configuration. See Figure 7-91
below.

Port Configuration i

Number of COM Parts: — [14 Number of USB Poits [0 Mumberof TCPPaits ~ [1_|
|cOM1 = | |TOUCH_SCREEN | [COMI0 > | |RPT_PRINTER =1

jcoMz = | Jups x| oMt w | [Tenk_Gause =

|COM3 = | [INTERNAL_MODEM = | [COM12 | [DIRECT_CASH_DRAWI > |

|COMS = | |RCPT_PRINTER x| |coMiz +| [sEcuRITv_CamERA |

|coMe  + | [PINPAD x| |comid -] [sEconp_METwORK x|

|COM? = | |SCaNNER x| |comis +| [MoNEY_ORDER =1

jcoMa | [cou x| |cPaP | [no_DEvICE =1

[coma =] [car_wasH = [y

h

Warning: System must be restarted for these to take effect.

()8 | Restore Defaults |

Figure 7-91 Port Configuration Window
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7.18 Money Order Interface

Nucleus has a Money Order Interface which allows communications to a Money Order device. This
feature allows a site to sell money orders, and provides tools to reconcile system money order sales
with the money order device. Go to System > Money Order Interface and click on the Retrieve
Device Data button to tell Nucleus to search for and establish communications with the Money
Order machine. This also downloads Money Order Sales limits which are set up previously on the
Money Order machine. Any time this limit is changed on the Money Order machine, the data must
be downloaded to Nucleus by using the Retrieve Device Data button.

e To use the money order machine to pay vendors for goods or services and have the money
order machine automatically print out the money order, click the Enabled for Vendor Payment
box. (Chevron does not support this function at this time)

e To sell money orders to customers and have the money order machine automatically print out
the money order, click the Enabled for Sales box then verify that the correct department is
programmed for Money Order sales.

e Use Dept Settings for Sales Item is used to program money order sales to use the department
programming for Dept Security Level, Dept Tax, and Dept Tender Restrictions.

e Use Dept Settings for Fee Item is used to program money order fees to use the department
programming for Dept Security Level, Dept Tax, and Dept Tender Restrictions.

When money orders are sold to customers, the site can charge a fee if configured to do so. Select
one of the three available fee types:

e Fixed Amount - Flat rate fee per money order
e Applied Percentage - Based upon amount of the money order
e Fee Table - Calculated from a predefined table

The Money Order Interface window is accessed from System > Money Order Interface. See
Figure 7-92.

Money Order Interface

M

Money Order Sales ltem
[ LErabledFor Sales Usze Dept Settings for Sales ltem
v Use Dept Security Level

M arimum Amount Dispensed M arimum Amourt Dispensed
2 2 v UseDept Tax
For Payment: |device in use ForSales:  |device in use v Use Dept Tender Restrictions

Department: MONEY ORDER =

Money Order Fee ltem

Fixed Amount Fee Table Usze Dept Settings for Fee |tem
: - + Enable " Enable [ Fram [To |Fee [ v Use Dept Security Level
Fixed Amount Amaunt; 130.35 | oool  smosl o ¥ Use Dept Tax
1 v Use Dept Tender Restrictions

Fee Table Applied Percentage =

(" Enable Oweride...
App“ed — | I Mirwmum Fee: [57 57
Percenta_ge Percentage: Department:

|MONEY ORDER: |
Fietrieve Device Data | Qg | LCancel |

Figure 7-92 Money Order Interface Window

To use Fixed Amount, click the Enable selection and then enter a dollar amount which will be the
amount charged per money order.
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To use Applied Percentage, click the Enable selection then enter the minimum that will be charged
per money order, then enter the percentage amount which is the percentage of the total money
order amount to be charged per money order.

To use the Fee Table:

1. Click the Enable selection and then click Add, the following window will be displayed.

New Fee Breakpoint

To [Upper Limit]: $50.00
Fee: 0.50
oK | LCancel |

Figure 7-93 New Fee Breakpoint Window

For example, enter 50.00 in the To (Upper Limit) window so that if the money order amount is
between $0.01 and $50.00, then enter 0.50 in the Fee window so that a 0.50 cent fee per money
order would be charged.

2. Click OK to save and exit or Cancel to exit without saving.
3. Repeat for additional ranges.

7.18.1 Money Order Formatting

In order for the Money Order Machine to print the Payee Information on the Money Order, the
“Reference Number Required” programming option must be enabled in Programming > Cash
Register > Tender > Money Order > Modify.

7.19 Audit Backup CD - Backup Configuration
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The Backup Configuration option allows you to specify which files get backed up when using the
Save Backup to CD function. Access this function by going to Programming > System > Audit
Backup CD > Backup Configuration. See Figure 7-94 below.

Backup Configuration

Select Options to Backup:

v v Beports Iv AuditFile v Pop-up Reminder
Sales Log Backup
Salez Log Options
1 Year
[v SalesLog -

o

Start D ate End Date

May 2005 May 2005

Ok Lancel

Figure 7-94 Backup Configuration Window
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Nucleus will always backup the Database which is not programmable, but you can additionally
select the Reports or the Audit file by checking the box for each.

Select Sales Log from the Sales Log Backup section and the system will enable the different
programming options for backing up the Sales Log.

1. 7 years as the time span for Sales Logs to backup. The options available are:

a. 7 years for COS, Jobber, and Franchise sites.
b. 1 year for Rent sites.
c. TBD for Canadian sites.

2. Select Use Dates to enable the Start and End date selections to define the time period that the
system will search when backing up the Sales Log.

3. Enable Pop-up Reminder to activate the reminder pop-up which will alert the store manager
that a backup is due. The reminder will occur at the closing of the first EOD at the first of the
month and continue until the system detects that a successfully backup has been performed.

7.20 Audit Backup CD - Save Backup to CD

The station data can be backed up to a Compact Disc (CD) for safe keeping in the event of data
loss. The Nucleus system will backup the database and optionally back up the sales logs, reports,
and the audit file. The Nucleus system can write data out to a CD-R disc using the cd writer built into
the system. Access this function by going to Programming > System > Audit Backup CD > Save
Backup to CD. Perform the following steps to save station data to a CD.

1. Configure the Backup options. See Section 7.19, Audit Backup CD - Backup Configuration.
2. Goto Programming > System > Audit Backup CD > Save Backup to CD.

Save Backup to CD

Insert CD and close CD-ROM drive door.

Lancel |

Figure 7-95 Save Backup to CD
3. Unlock the keylock on the front panel then press the three bumps on the panel to open.

Figure 7-96 Opening the Front Panel
4. Open the CD-R by pressing the button on the CD-R tray.
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Figure 7-97 Opening the CD-R Tray

5. Puta blank CD in the drive with the writing facing up.
6. Push the CD-R tray back into the system until you hear a click.
7. Touch the OK button and the system will display the following messages.

Confirm Save Backup to CD

This Operation will Backup Station
Data to CD. Are you Sure 7

Continue I Cancel I

Figure 7-98 Insert CD Message

8. Touch Continue and the following message will be displayed.

Confirm Save Backup to CD

This operation may take 30 minutes.
Are you Sure ?

Cancel Continue

Figure 7-99 Are You Sure Message

9. Touch Continue and the following message will be displayed.

CD Backup

Frepare CD

Cancel |

Figure 7-100 Prepare CD Message

10. Touch OK to begin the backup, the following message will be displayed.
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CD Backup

Complete CO Backup

Cancel |

Figure 7-101 Complete CD Backup Message
11. Touch OK to complete the CD backup.

Save Backup to CD

Data successfully written.

CD can now be removed for safe storage.

Figure 7-102 Data Backup Success Message

12. Remove the CD and put in a safe place.
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8 CASH REGISTER PROGRAMMING OVERVIEW

Cash register programming allows you to set up the cash register to handle and record transactions.
This section includes diagrams, windows, and instructions that explain how to program Nucleus to
manage fuel and non-fuel activities at your site.

NOTE: System programming should be performed on IPT #1

/N WARNING

Certain programming functions should not be performed on a multiple terminal system if one of
the terminals is still used to ring up sales. Deletions, Additions, or Modifications to the data-
base on one terminal while the other terminals are accessing the database for product or tax
information is not recommended. Deleting, Adding, or Modifying Groups, Departments, Grades,
Products, PLU/SKUs, Car Washes as well as Taxes and Service Charges is not recommended if
another terminal is being used to ring up sales. Doing so can result in corruption of the data-
base or yield unpredictable results.

Access the Cash Register Programming window by selecting Cash Register from the Programming
Access window. Notice the cash register programming options that appear in the pull-down menu.
See Figure 8-1. The features and options available within Cash Register Programming are
described below. Specific instructions on how to program these features will be discussed later in
this section.

Programming Access[ 4]

File Security System NSEEREEWEES Reporks  Metwork
Fuel 3
Mon-Fuel r
Tender
Financial 3
Discount: Classifications  »
Tax
Price Modification
Service Charge
Housefccounts
Yendor Accounts
Currency Setup

Figure 8-1 Programming Access Window

8.1 Fuel Programming

e Group programming enables you to gather information over a broad range of transactions. By
creating and naming fuel groups, you establish the most basic level for separating and reporting
fuel transactions.

e Department programming allows the Nucleus system to track and report fuel sales on a level
more detailed than that offered by groups. Each department reports to a group, but more than
one department may report to a single group.

e Grade programming allows the Nucleus system to track and report fuel sales on a level more
detailed than that offered by departments. Each grade reports to a department, but more than
one grade may report to a single department.
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8.2 Non-Fuel Programming

Use Non-Fuel Group programming to gather information over a broad range of transactions. By
creating and naming groups, you establish the most basic level for separating and reporting
transactions. Groups usually represent wide categories of items such as tobacco sales, fountain
sales, etc. There is no effective limit to the number of Groups that can be programmed except
that of available hard drive space.

Non-Fuel Department programming allows the Nucleus system to track and report non-fuel
sales on a level more detailed than that offered by groups. Each department reports to a group,
but more than one department may report to a single group.

Use Non-Fuel Product programming to add or modify product names, prices, PLUs and SKUs
(UPCs), number quantities, and department numbers.

Use Car Wash programming to set up the car wash controller and to access car wash sales,
awards, and discounts for 12 types of car washes. Car washes can be purchased or awarded
with the purchase of something else (for example, fuel) and/or they can be discounted with a
fuel purchase. Car washes can also be purchased as an upgrade from the basic wash. The first
9 car washes can be purchased at the CATs.

The PLU programming window displays a list of the currently programmed PLUs.

Time Restrictions programming allows a site to restrict the purchasing of products through the
definition of a restriction schedule. This time restriction is a list or chain of start and end times for
which the product cannot be sold.

8.3 Tender Programming

Tender programming allows you to set the type of tender method allowed for product payment.
Tender restrictions may also be programmed.

8.4 Financial Programming

Financial programming allows you to set up Nucleus to maintain the following operations as
required by your site.
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Use Fuel Prepay programming to set up security levels, a high amount limit, and allowable
tender types.

Use Opening Balance programming to set up security levels, service charges, a high amount
limit for your starting cash requirements, and whether a reference number is required.

Use Closing Balance programming to set up security levels, service charges, a high amount
limit for your closing balance requirements, and whether a reference number is required.

Use Safe Drop programming to set up security levels, service charges, a high amount limit, and
whether a reference number is required.

Use Paid In programming to set up security levels, service charges, a high amount limit for paid
in operations, and whether a reference number is required.

Use Paid Out programming to set up security levels, service charges, a high amount limit for
paid out operations, and whether a reference number is required.

Use Cash Back programming to set up security levels, service charges, high amount limit, and
allowable tender for cash back operations.

Use BAC Refund programming to set up security levels, service charges, high amount limit,
and allowable tender for BAC refund operations.

Use A/R Collect to program the allowable tender types, security levels required, limits, and
whether reference numbers and account numbers will be required for A/R Collect transactions.
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8.5

8.6

8.7

8.8

8.9

8.10

e Use Safe Loan to program the allowable tender types, security levels required, limits, and
whether reference numbers will be required for Safe Loan transactions.

Discount Classifications Programming

Discount Classifications programming can be reached from different entry points within Nucleus
programming. Discount programming can be done from within the Discount Classifications
programming window or the department or product programming window,

e Offerings Programming - For details about Offerings programming see Section 13.1 on page
154.

e Mix-N-Match Programming - For details about Mix-N-Match programming see Section 13.2 on
page 155.

e Combo Programming - For details about Combo programming see Section 13.3 on page 159.

e Item List Programming - For details about Item List programming see Section 13.4 on page
164.

e Promotion Time Programming - For details about Promotion Time programming see Section
13.5 on page 166.

Tax Programming

The Tax Programming window allows you to Modify tax parameters set up for system operation. The
tax types that are programmable are Percents, Fixed Amounts, or from a Breakpoint Table.
Breakpoint tables are tables supplied from tax authorities, used to designate tax rates for certain
dollar amount ranges. Some Breakpoint tables use a combination of breakpoint and percentage
programming. Support for multiple taxes for use in Canada is now included. Tax Programming will
be explained in further detail later in this section on page 169.

Price Modification Programming

Price Madification programming allows you to establish discounts needed for the operation of your
site. Using the Price Modification option, you can Add, Remove, or Modify discounts for use with the
system. Price Modification Programming will be explained in further detail later in this section on
page 174.

Service Charge Programming

Service Charge programming allows you to establish service charge amounts needed for the
operation of your site. Using this option, you can Add, Remove, or Modify discounts for use with the
system. Service Charge Programming will be explained in further detail later in this section on page
176.

House Accounts Programming

A House Account is used by large commercial or individual customers to put all of their purchases of
goods or services into one account that can be paid off in the future.

Vendor Accounts

Vendor Accounts are used to keep track of money paid for goods and services to the different
commercial suppliers of products such as the soft drink supplier or the newspaper delivery.
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8.11 Currency Setup

Currency Setup is where Nucleus is programmed to use alternate currency types as well as United
States currency.

9 FUEL PROGRAMMING

The following window shows the Fuel Programming options Group, Department, and Grade. From
the Programming Access window select Cash Register > Fuel.

Programming Access[ 4]

Reports  Metwork
Mon-Fuel 3 Department
Tender Grade
Financial L
Discount: Classifications  »

Tax
Price Modification
Service Charge

File Security System

Housefccounts
Yendor Accounts

Figure 9-1 Programming Access Window

9.1 Group Programming

In order to set up fuel programming parameters you will have to start by creating and naming fuel
groups. Groups are used to gather information over a broad range of transactions. By creating and
naming groups, you establish the most basic level for separating and reporting transactions. Fuel
and Non-Fuel are two commonly used groups. In the following example of a Fuel Group
Programming window, Fuel is the only previously programmed group.

Group Programming

Group # Group -

Add... | Bemove |

Modity selected entry

Figure 9-2 Group Programming Window

From the Group Programming window, you can Add a new fuel group, Remove a fuel group, or
Modify an existing fuel group. See Figure 9-2.

e To add a new fuel group, select Add.
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9.2

e To remove a fuel group, highlight the group that you want to remove and select Remove.
e To modify a fuel group, highlight the group that you want to change and select Modify.

e To add an entry with duplicate programming, highlight the entry that you want to duplicate, then
select Clone.

e To exit the Group Programming window, select Close.
When you select Add or Modify, the Fuel Group window appears. See Figure 9-3.

Fuel Group

Marme:
Group Murnber: 1
External Reference [d: [4

Offerings... |

Qg | Lancel |

Figure 9-3 Fuel Group Window
From this window you can add or modify the following.

e Name - To change the name of a selected group, type the desired nhame in the Name field.

e Group Number - Assigning a Group Number aids in sorting groups when the site is doing End-
of-Day reports. To enter the group number, type the desired unique number in the Group
Number field.

e External Reference ID - Use this field to assign a number to the particular group that
corresponds to the group number that the Back Office System may use to identify a particular
group. When the Back Office type is set to NAXML, this field will be viewable only.

You can also access the Offerings window from here. See Figure 13-3.

9.1.1 Fuel Group Offerings

Group offerings are discounts or rewards set up for customers that meet or exceed a minimum
purchase amount. Offerings are usually discounts on other goods or services. For details on
Offerings programming refer to Section 13.1.

Department Programming

Departments allow the Nucleus system to track and report fuel sales on a level more detailed than
that offered by groups. Each fuel department reports to a group, but more than one fuel department
may report to a single group.

The Fuel Department Programming window lists the departments that report to the Fuel group.
Access the fuel Department Programming window by selecting Cash Register > Fuel >
Department.
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Department Programming

Department # | Department Group Cashier Rpt [ay Rpt Shift Bpt
82 Fig-Plus-Self Fuel es es es
83 Fropane-Self Fuel es es es
g4 Gasahol-5elf Fuel es es es
95 UI-Plus-Self Fuel es es es
86 Supreme-Full Fuel Ves Yes es
a7 Feg-Ful Fuel Yes Yes es
ot Unl-Full Fuel es es es
83 Digsel-Full Fuel es es es
a0 Fig-Plus-Full Fuel es Yes es
91 Sp-Pluz-Full Fuel es es es
92 Fropane-Full Fuel es es es
93 Gasahal-Full Fuel es es es
Bemove | Modify... | Clone... | Lloze |

Add a new entry into the database

Figure 9-4 Department Programming Window

From the Fuel Department window, you can add a new department, remove a department, modify
an existing department, or view grades associated with a department. See Figure 9-4.

To add a new department, select Add.

e To exit the Department Programming window, select Close.

9.2.1 Department Programming Modifications
Select the Modify button to open the Modify Department window shown in Figure 9-5 below.

sModify Department

M ame: Dieze Tax Rate
Department #: |72
Group: Fuel P

Extemnal Reference Id: |72

Wariable Tracking
[ Cashier Repart

Offerings...
Bestrictions. ..

|v DayReport
[v Shift Report

Ok Lancel

Figure 9-5 Modify Department Window

To remove a department, highlight the department you want to remove then select Remove.
To modify a department, highlight the department you want to change then select Modify.

To add an entry with duplicate programming, highlight the entry that you want to duplicate, then
select Clone.

From the Modify Department window you can enter the fuel department name, and number. You can
also assign the department to a group, select discount offerings, program restrictions and choose
the reports that should be tracked.

e Name - To enter the fuel department name, type the desired name in the Name field.
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e Department # - Assigning a Department # aids in sorting departments when the site is
processing End-of-Day reports. To enter the department number, type the desired unique
number in the Department # field.

e Group - To assign the desired fuel group, select the fuel group name from the fuel Group pull-
down menu.

e Sales Tax - Check the Sales Tax box to enable the appropriate sales tax. Normally, fuel taxes
are included in the fuel grade price.

e External Reference ID - Use this field to assign a number to the particular department that
corresponds to the department number that the Back Office System may use to identify a
particular department. When the Back Office type is set to NAXML, this field will be viewable
only.

e Variable Tracking - The Variable Tracking option controls the reports that contain the
department information. To assign a department to a report, check the box to the left of the type
of report (Cashier, Day, or Shift). See 'Variable Tracking’ on page 169 for more information.

e Offerings - Select Offerings to access the offerings programming section. For details about
Offerings programming see the Introduction section on page 154.

e Restrictions - When you select Restrictions, the Fuel Department Restrictions window in
Figure 9-6 appears.

Department Restrictions

Lockouts
Credit Card i
Deehit Card o [o

High: G

¥ | &llovs Fract Gty

I~ wihale dallar B stret

Security Level: ILeveI‘I = l
Ok | Lancel |

Figure 9-6 Department Restrictions Window

The following programming options are available from the Department Restrictions window:

*  Allow Tender - This option allows you to restrict a department to certain types of
transactions, such as Cash and Manual Credit tender media.

*  Lockouts - The Lockouts option sets the maximum (High) and minimum (Low) transaction
amounts for a department. For example, in Figure 9-6 the maximum value is $501.00 per
transaction and the minimum value is $0.00. If the minimum value is set to $0.00, that
means that there is no lower limit for transactions in this department.

*  Allow Fract Qty - Check this option for the system to allow units of fuel to be sold in 0.000
increments. This is normally checked. If not, only whole units can be purchased.

*  Security Level - This option allows you to set the security level required to perform
transactions for a fuel department. The security in Figure 9-6 is Level 1. To complete a
transaction for the department, an employee must have a security level that gives access to
Level 1 transactions.
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*  Time Restriction - Use the Time Restriction pull-down to assign a time restriction to this
department. A Time Restriction will dis-allow the purchase of any item within this
department during the restricted hours that have been previously programmed. Refer to
Section 10.6 on page 137 for information on programming Time Restrictions.

*  Select OK to save and exit or select Cancel to exit without saving.

9.3 Grade Programming

Fuel grades are the third level of the fuel programming parameters. Grades allow the Nucleus
system to track and report fuel sales on a level more detailed than that offered by departments.
Each grade reports to a department, but more than one grade may report to a single department.
Note that it is necessary to program fuel departments before you can program fuel grades.

NOTE:Grade programming must be done prior to the Tank and Pump programming.

Access Grade programming by selecting Cash Register > Fuel > Grade. See Figure 9-7.

Grade Programming
Grade Type i‘

Plus Unlead Blended
Plus Unlead Pure
Supreme Pure

Unleaded Pure FPrices

-]

Bemove | Modify... | Clone... | Lloze |

Figure 9-7 Grade Programming Window
NOTE:The system displays all grades programmed, pure and blended.
e To change grade prices, select Prices.
e To add a new grade, select Add.

e To remove a grade, highlight that grade and select Remove. Remove will not be allowed if a
grade is used in Tank or Pump programming.

e To modify a grade, highlight the grade you want to change and select Modify.

e To add an entry with duplicate programming, highlight the entry that you want to duplicate, then
select Clone.

e To exit the Grade Programming window, select Close.
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9.3.1 Prices

1. To change the fuel prices select Prices. Depending upon whether Tiers and Service Levels
have been enabled in the Pump Site programming window (Figure 8-11), one of the following
Grades windows will appear.

Grade IMethod of Payment i -

Plus Unlead Cash 2.599

Supreme Cash 2 599
Unleaded Cash 2,499
Diezel Credit 2.699
Plus Unlead Credit 2.699
Supreme Credit 2799
Unleaded Credit 2.599

FEuture Price... | Lloze |

Figure 9-8 Grades Window

Grade M;;r;g:: [ray Might
Plus Unlead Cash 2.599 2.699
Supreme Cash 2699 2799
Unleaded Cash 2,499 2.599
Diesel Credit 2639 2799
Plus Unlead Credit 2.699 2.799
Supreme Credit 2799 2899
Unleaded Credit 2.599 2.699

Future Price... | Lloze |

Figure 9-9 Grades Window with Tiers Enabled
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2.

Grade

Plus Unlead

Method of
Payment

Plu nlead

a3l
Supreme Cash
Unleaded Cash
Digzel Credit
Plus Unlead Credit
Supreme Credit
Unleaded Credit
Future Price... | Lloze |

FPayment
Method

FULL

Supreme

Unleaded

Diezel

Plus Unlead

Supreme

Unleaded

Credit

2633

2733

Future Price... |

Lloze |

Figure 9-11 Grades Window with Tiers and Service Levels Enabled

Mew Price:

o |

Lancel |

Figure 9-12 Diesel Window

In this example, choose Modify to access the Diesel window, where you can change the prices.
Depending upon whether Tiers, Service Levels, or Price Levels have been enabled in the Pump
Site programming window (Figure 8-11), one of the following Diesel windows will appear.
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Day Might
| |

|$1.?99

Mew Price:

Ok | Lancel |

Figure 9-13 Diesel Window with Tiers Enabled

Mew Price:

|$1.?99

Ok | Lancel |

Figure 9-14 Diesel Window with Service Levels Enabled

Day Might
FULL SELF FULL
Mew Price: ]$1 799 l$1 799 l$1 893
ok ‘ LCancel ‘

Figure 9-15 Diesel Window with Tiers and Service Levels Enabled

3. Enter the new price and then select OK to save and exit or Cancel to exit without saving.

9.3.2 Future Price

This function allows changes to existing fuel grade price programming to allow the user to program
a price change to take place at some time in the future.

1. Access the Future Price Programming window by selecting Programming > Cash Register >
Fuel > Grade > Prices.

2. Click on the fuel grade that you want to modify the price for, then click Future Price to access
the Future Grade Price programming window.
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(ET] Might

CREDIT SELF  CREDIT FULL  CREDIT SELF  CREDIT FULL

|$2.499 |$2.499 |$2.599

Mew Price:

BifectiveDate and Time: [41,14/2008 11:384M | - @ | Effective Date and

Time pull-down

Ok ‘ Lancel |

Figure 9-16 Future Grade Price Programming Window

3. Click the price that you want to modify then enter the new grade price which is the price that will
be changed when the Future Price goes into effect.

4. Click on the Effective Date and Time pull-down to open up a calendar where a date can be
selected. See Figure 10-18

4| Augustzoo6 _»|

1 2 3 4 5

ET e 8 1011z

13 14 15 16 17 18 19
0002 2 023 M B XK
2028 028 3 0A

T Today: 8/7/2006

Figure 9-17 Future Price Calendar
5. Select a future date by clicking on the desired date. You can then select the desired time that
you want the price change to occur.
6. Press OK to save and exit or Cancel to exit without saving.

9.3.3 Add/Modify Grade
The Modify Grade window allows you to name the product, assign a department, determine pricing,
select feedstock. Access this window by selecting Add or Modify from the Grade Programming

window.

114
Part No. 2-920494 Rev. G

August 2008



Modify Grade
) = Feedstock. ..
Grade Type
p
p [ e
Qfferings...
Department

Diezel-Self =
Host Code:
| Diesel 1/Low Sulfur ~|

External Reference |d:

Ok | Lancel |

Figure 9-18 Modify Grade Window

e Name - To change the name of a selected grade, type the desired name in the Name field.

e Grade Type - To select the appropriate grade type, click on the box to the left of the desired
grade (Pure or Blend).

e Department - Select the desired department from the Department pull-down menu.

e Host Code - Host Code is used to track fuel sales by the Chevron host. Each item that can be
purchased must be assigned a Host Code. The list of Host Codes is provided by the host
network.

*  To assign a Host Code, select the desired Host Code from the pull-down menu.

*  To ensure that the system reports all fuel codes correctly, verify that the Host Code settings
for all fuels are set to the appropriate Fuel Host Product Code.

Table 9-1 Host Code Definitions

Product Displayed Name Chevron Host Product Code

Code

000 Not Used

001 Unleaded 1/Supreme 1 Supreme Unleaded

002 Unleaded 2/Plus Unl D Plus Unleaded

003 Unleaded 3/Reg Unl 3 Regular Unleaded

004 Unleaded 4 6 Supreme Plus

011 Gas/Ethanol 1 B Gasohol

018 Leaded 2 Regular Leaded, 5 Regular Plus
019 Diesel 1/Low Sulfur 4 Diesel (on-road/low sulfur)
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020 Diesel 2/Off Road F Diesel (off-road/high sulfur)
022 Compressed NaturalGas A Natural Gas
023 Liquid PropaneGas 9 Propane
100 Gen Auto Merchandise 1TBA
101 Motor Oil 2 Oil
115 Labor 3 Labor
150 Jet Fuel/Jet-A 8 Jet
151 Aviation Fuel 1/AvGas 7 Avgas
225 Marine Fuel 1/TwoStrk C Marine Two Stroke
300 Kerosene E Kerosene
400 General Merchandise 4 Other
e External Reference ID - Use this field to assign a number to the particular fuel grade that
corresponds to the fuel grade ID number that the Back Office System may use to identify a
particular grade of fuel.
e Feedstock - To access this feature, select the Feedstock button. If the grade you are modifying

is a pure grade type, then the Pure Grade window will appear. See Figure 9-19. If the grade you
are modifying is a blend grade type, then the Blended Grade window will appear. See Figure 9-

20.

Figure 9-19 Pure Grade Window

Feedstock
" High

Ok | Lancel |

*  The Feedstock window for a Pure Grade type indicates a grade’s status (High, Low, or

None). Select the desired level to program the pure grade’s status.

NOTE:In order to program blenders, you must ensure that you have 2 Pure Grade tanks defined.
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Blended Grade

HanFee TR -]

Low Feed: Eoon P

High/Low R atio: [T

Ok | Lancel |

Figure 9-20 Blended Grade Window

*  The Feedstock window for a Blended Grade type has definitions for High Feed, Low Feed
and High/Low Ratio. The High/Low ratio is the percentage of High Feedstock that the
blended grade will contain.

/A WARNING

Be aware that Gilbarco uses a different way of defining the blend ratios than does Wayne or
Tokheim. Gilbarco pumps define the blend ratio as a percentage of Low grade whereas Wayne
and Tokheim pumps define the blend ratio as a percentage of High grade. If blend ratios pro-
grammed at a Wayne or Tokheim pump do not match the programming in Nucleus then the
pump will not operate. However, If blend ratios programmed in a Gilbarco pump do not match
the programming in Nucleus, the pump will still operate using the blend ratios that are pro-
grammed at the dispenser. This programming should be done by a qualified service technician
only

e Restrictions - The Restrictions option is not available for the current release.

e Offerings - Select Offerings to access the Offerings programming section. For details about
Offerings programming see the Introduction section on page 154.

10 NON-FUEL PROGRAMMING

From the Programming Access window select Cash Register > Non-Fuel. See Figure 10-1.

Programming Access[ 6]

File Security System | Cash Register Reporfs  Nebwork

Fuel L4 |

horn-Fuel Group

Tender Department
Financial »  Product
Discount Classifications  »  Car Wash

Tax PLU

Price Modification Time Resfrictions
Service Charge Lottery
HolseAccounts

Wendor Accounts
Currency Setup

Figure 10-1 Programming Access Window
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10.1 Group Programming

In order to set up Non-Fuel Programming parameters you will need to begin by creating and naming
Groups. Groups are used to gather information over a broad range of transactions. By creating and
naming groups, you establish the most basic level for separating and reporting transactions. Groups
usually represent wide categories of items such as tobacco sales, fountain sales, etc.

1. Access the Group Programming window by selecting Cash Register > Non-Fuel > Group. See
Figure 10-2.

Group Programming

Group # Group -
<] Beer

4 Tobacco

5 Automative

7 Labor

a Sales Promo

9 Spare 1

10 Spare 2

11 Spare 3

12 Spare 4

13 Spare 5

14 Spare B

15 Spare 7

1R Snare A j

Modify... | Clone... | Lloze |

Femove selected entry from the databaze

Figure 10-2 Group Programming Window

From the Non-Fuel Group Programming window, you can Add a new group, Remove a group, or
Modify an existing group.

e To add a new group, select Add.

e To modify a group, highlight the group that you want to change and select Modify. When you
select Add or Modify, the Non-Fuel Group window appears. See Figure 10-3.

Non Fuel Group

Name: MON FLEL
Group Murnber: 2
External Reference |d: |2

Offerings... |

Ok | Lancel |

Figure 10-3 Non Fuel Group Window
*  Name - To enter the group name, type the desired name in the Name field.

*  Group Number - Assigning a Group Number aids in sorting groups when the site is doing
End-of-Day reports. To enter the group number, type the desired unique number in the
Group Number field.
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*  External Reference ID - Use this field to assign a number to the particular group that
corresponds to the group ID number that the Back Office System may use to identify a
particular Non Fuel group.

*  Offerings - To make modifications to the Offerings, select Offerings to access the Offerings
Programming section. See Figure 13-2. For details about Offerings programming see the
Introduction section on page 154.

e To remove a group, highlight the group that you want to remove and select Remove.

e To add an entry with duplicate programming, highlight the entry that you want to duplicate, then
select Clone.

e To exit the Group Programming window, select Close.

10.2 Department Programming

Non-Fuel Departments are the second level of the Non-Fuel programming parameters. Departments
allow the Nucleus system to track and report non-fuel sales on a level more detailed than that
offered by groups. Each department reports to a group, but more than one department may report to
a single group.

NOTE:In order to program the departments, you will need to link the department to a parent group.
The department name can be up to 12 characters long. You may also specify the taxes, if any, that
are applied to the department.

Access the Department Programming window by selecting Cash Register > Non-Fuel >
Department. The Non-Fuel Department Programming window lists the departments that report to
the Non-Fuel group. See Figure 10-4.

Department Programming

Department # | Department Group Cashier Rpt [ay Rpt Shift Bpt -

1 Beverage | | !

2 Beer Beer es es es

& Fourtain Other es es es

4 Misc. Other es es es

5 Grocery Other es es es

B Fatar il Automative es es es

g TBA& Automative es es es

£ Labor Labor es es es

10 Fast Food Other es es es

1Al Snhacks Other es es es

13 Sales Promo Sales Promo es es es

14 Gift Card Other es es es

15 Spare 2 Other Yes Yes es j

Bemove | Modify... | Clone... | Lloze | Products... | Sub-Categories... |

Add a new entry into the database

Figure 10-4 Department Programming Window

Options available from the from the Non-Fuel Department Programming window are Add a new
department, Remove a department, Modify an existing department, Clone a department,
Products, and Sub-Categories programming.

10.2.1 Adding Departments

Select Add to add a new department or highlight an existing department and select Modify to
change the features of that department. When you select the Add or Modify buttons, the Modify
Department window appears. See Figure 10-5.
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sModify Department

Mame: Tax FRate Apply Tax Before Dizcount

B v
Department #: |5
Giraup: NON FUEL -

External Reference Id: |5

Offerings...
Host Code:
| 400-General Merch =| I" Hegative Price Mix-N-Match...

Wariable Tracking : Restrictions...
% Cashier Report [ Reference Mumber Required i

Minimum Purchase Age: [ g

|v DayReport

[v Shift Repaort
Scratchpad Options

" Do not show

% |z an open department

™ Mot an open department aK | LCancel |

Figure 10-5 Modify Department Window

From the Modify Department window you can enter the department name, and number. You can
also assign the department to a group, assign a host code, select discount offerings, enter Mix-N-
Match programming and program restrictions, choose the reports that should be tracked and assign
a minimum age for purchase.

Name - To enter the department name, type the desired name in the Name field.

Department # - Assigning a Department # aids in sorting departments when the site is doing
End-of-Day reports. To enter the department number, type the desired unique number in the
Department # field.

Group - To assign the desired group, select the group name from the Group pull-down menu.
Tax Rate - Check the Sales Tax box to enable the appropriate sales tax.

Apply Tax Before Discount - Check the Sales Tax box to force the system to calculate the
appropriate sales tax on items in the department before any discount is applied. The 'Apply Tax
Before Discount' flags can be set at the Department level, but the Dry Product screen tax
programming can override the department setting.

External Reference ID - Use this field to assign an external reference number to the particular
department that corresponds to the department ID number that the Back Office System may use
to identify the department.

Host Code - Assign a Host Code to allow the network to keep track of certain product types by
linking them to a host product code. Select the Host Code name from the Host Code pull-down
menu.

Negative Price - Check Negative Price when the department being programmed is a negative
department or other items that reduce the price of a product. (i.e. negative price).

Variable Tracking - The Variable Tracking option controls the reports that contain department
information. To assign a department to a report, check the box to the left of the type of report
(Cashier, Day, or Shift). See 'Variable Tracking’ on page 169 for more information.

Reference Number Required - Check Reference Number Required to track specific
transactions.
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e Scratchpad Options - Use the Scratchpad options to control how the department appears on
the Scratchpad. If Do not show is selected then the department will not be displayed on the
Scratchpad. If Is an open department is selected, then the department will be displayed on the
Scratchpad as an open department. If Not an open department is selected then the
department will not allow open department purchases but will allow access to the products
under that department.

e Minimum Purchase Age - For age restriction programming use the Minimum Purchase Age
field to enter a valid minimum age to purchase products from this department.

e Offerings - For Offerings programming refer to the Introduction in Section 13.1.
e Mix-N-Match - For Mix-N-Match programming refer to the Introduction in Section 13.2.
e Restrictions - Select Restrictions and the window in Figure 10-6 appears.

Department Restrictions

Allow Tender———— Lockouts
Credit Card i
Deehit Card o [

High: 1m

¥ Allow Fract Gty

I~ wihale dallar B stret

Security Level: m
Time Restriction INDne ;I
oK | LCancel |

Figure 10-6 Department Restrictions Window

*  Allow Tender - This option allows you to restrict a department to certain types of
transactions, such as Cash and Manual Credit tender media. For example, the Lottery may
not allow Credit Card and Debit Card transactions.

*  Lockouts - The Lockouts option sets the maximum (High) and minimum (Low) transaction
amounts for a department. For example in Figure 10-6, the maximum value is $501.00 per
transaction and the minimum value is $0.00. The 0 value in the Low field means that there is
no lower limit for transactions in this department.

*  Allow Fract Qty - This option is only for use with fuel.

*  Security Level - This option allows you to set the security level required to perform
transactions for a department. The security level in Figure 10-6 is Level 1. To complete a
transaction for the department in this example, an employee must have a security level that
gives access to Level 1 transactions.

*  Time Restriction - Use the Time Restriction pull-down to assign a time restriction to this
department. A Time Restriction will dis-allow the purchase of any item within this
department during the restricted hours that have been previously programmed. Refer to
Section 10.6 on page 137 for information on programming Time Restrictions.

*  Select OK to save and exit or select Cancel to exit without saving.

e Select OK to save and exit or choose Cancel to exit without saving.
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10.2.2 Removing Departments

To remove a department from the Department Programing window (Figure 10-4), highlight the
department that you want to remove then select Remove.

10.2.3 Cloning Departments

To copy a department’s programming into a new entry, highlight the selected department then select
Clone.

10.2.4 Products Programming

Program individual products from within their department grouping by selecting Products from the
Department programming window. Procedures for this feature are detailed in the following section
titted Product Programming on page 124.

10.2.5 Sub-Categories Programming

A department sub-category is a grouping of products within a Non-Fuel department. Sub-categories
are used to program the Mix-N-Match and Combo Discount Classifications. To access the
Department Sub-Categories programming select Sub-Categories. See Figure 10-7.

Department Sub-Categories
I ame -~

Add | Bemove | EhangeErice| Lloze |

Modity selected entry

Figure 10-7 Department Sub-Categories Window

This window provides a view of all sub-categories currently programmed in the system for the
selected department. Options available from this window are Add, Remove, Modify and Close.

NOTE:The Change Price option is only active whenever None has been selected as a Back Office
type. Refer to the "Back Office Configuration” section on page 73.

Choose Add to display the window in Figure 10-8 below. The department products can be sorted by
clicking on the different headers above the Department Products. A vertical scroll bar has also been
added to navigate the product listing easier.
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Modify Sub-Category Products

Department: | Sub-Category: |[IEENEY

Click on Depart t Product col headers to sort
grid by column.

| Department Products | Sub-Category Products
I ame LIFC/PLU Pack Sz |Unit Prc | «

Pack Sz |Unit Prc
313

1% G 47

-
1 319

T/2galMILE, [ 1 199 GALWHOLE [ 319

2% GALLON 48 1 319 SKIM GALLON 43 319

25%1/260L. 4 1 189

GALWHOLE 4 1 319

MILK PINTS 40 1 0.99

BUARTS MILK 4 1 113

SKIM 1/2GL. 5 1 189

SKIM GALLON 43 1 319 o =

Add - <- Delete
oK. Eae | MisH-Match |

Figure 10-8 Add Sub-Category Products

e Use the Add Sub-Category Products window to associate products within a department to a
particular sub-category.

*  Add - Select the product from Department Products on the left and click Add to associate
them to the sub-category on the right.

*  Delete - Highlight products from Sub-Category Products on the right and click Delete to
remove them from the sub-category.

e Enter the Sub-Category name in the field provided then select OK to save and exit or choose
Cancel to exit without saving.

e Upon completion of defining the sub-category, select Mix-N-Match to program criteria for the
discount.

e For Mix-N-Match programming see the Introduction section on page 155.
Use the Change Price button from the Department Sub-categories window to perform a mass

change of all the prices of the products listed within the selected Sub-Category. Press the Change
Price button and the following window will be displayed.

w. Sub-Category Price Change g@]g|

Department: |

Sub-Category: |

0ld Price:
Mew Price: 765

Ok | Lancel |

Figure 10-9 Sub-Categories Price Change

The window above shows the current Department, Sub-Category, and current price. The new price
for all the products within the listed Sub-Category is entered in the New Price field.
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10.3 Product Programming

Non-fuel product programming allows you to add or modify product names, prices, PLUs and SKUs
(UPCs), number quantities, and department numbers. There is also a feature that allows you to set
a time and date to introduce a new product or a new price on an existing product.

10.3.1 Product Database Search

The Product database can be searched to locate specific products when performing product
updates like price changes.

1. Access the Product Programming window by selecting Cash Register > Non-Fuel > Product.

See Figure 10-10.

2. To do a search of the database for a product you can:

*  Select Search on Product Number then enter the product number of the item in the

window.

*  Or select Search on Product Name then enter the name of the item in the window

*  Or Search on PLU/UPC and scan the product at the scanner.

3. The product database listing can also be sorted by department by clicking on the Department

heading.

10.3.2 Adding New Products

1. Access the Product Programming window by selecting Cash Register > Non-Fuel > Product.

See Figure 10-10.

" Search on Product #
" Search on Product M ame
+ Search on PLU/UPC

Product Programming

Product # Froduct Mame Frice Gty | Department Cashier Bpt| Day Rpt | Shift Bpt [ =
.05 CRY 0.05 1 [R5 es es es
10 COPIES 0.00 1 Misc Serv 1 es es es
15 CRY 015 1 ¥ es es es
.25 NEWSPAP 0.25 1 Misc Serv 2 es res es
.30 CRY 0.30 1 i) es es es
.35 NEWSPAP 0.35 1 Misc Serv 2 es es es
80 NEWSPAP 0.50 1 Misc Serv 2 es es es
80 NEWSPAP 0.75 1 Misc Serv 2 es es es
.55 NEWSPAP 0.55 1 Misc Serv 2 res es es
.90 0.90 1 Misc Serv 2 es es es
.99 RUFFLES 0.99 1 Snhacks 2 es es es
.99 RUFFLES 0.99 1 Snhacks 2 es res es
1 0FF LG 5P 4.89 1 Food Serv 2 es es es
1 0FF SM SP 2.49 1 Food Serv 2 es es es
1.00 NEWSPA 1.00 1 Misc Serv 2 es es es
1.00 SCRATC 1.00 1 Lattery es Yes es j
Add... Bemove ‘ Modify... ‘ FEuture Price... ‘ Clone... ‘ LCloze ‘

Figure 10-10 Product Programming Window

2. To add a new product select Add to access the Modify Product programming window.
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Modify Product

Name:  [5unnyD 200z Product # [v AddLater  Effective Date and Time: | Effective Date and

08/07/2006 12:00 Pt T| me

Fricing Codes
$1.69 B Oty 1
FLU: il
'17 for Department: [~ Add Later bOX
$0.00 Hty: 2 |Beverage |
il u Host Code:
Bestrictions
= ] Type: ’—_| | General Grocerny j
v Use Dept Security Level -be
v UseDept Tax Multi Pack Code: Wariable Tracking
v Use Dept Tender Restrictions ’7 [v Cashier Report
1

[v Use Dept Fract. Gty Allowed v Day Report

v Usze Dept Min Purchaze Age UPFC: 00050200001 260 i t
v Use Dept Time Restriction W

v Use Dept Tax Before Discount I :Show on Serslchpad

Link. Infarmation

Link Code: Link Mame: Link Code Type: |NOME -

— UPC Data Field

Ok | Lancel |

Figure 10-11 Add/Modify Product Window

3. Click the Add Later box then select a date and time to make this product active by selecting
from the Effective Date and Time pull-down. If Add Later is not selected then the product will
be added when product programming is complete.

4. Fillin the Name, Pricing, PLU, Department, Host Code, and other information in the Modify
Product window.

The following options are available in the Modify Product window:
e Name - To change the name of the product, type the desired name in the Name field.

e Product # - Product # is any number greater than zero. These numbers are used to sort the
product on the reports. Please note that this sorting feature, is not restricted to just Products, but
is also available by Fuel and Non-Fuel Group and Department. However, only Non-Fuel will
display the Product option.

*  If you want a product to be the first one on your report then it should have the lowest
number.

*  Products that are created, but not assigned a product number, will appear in alphabetical
order after numbered products.

*  If a duplicate product number is used, then those items are sorted alphabetically by name.

e Pricing - To add or modify a per unit price and multiple price, type the desired prices in the
corresponding fields. This is used for pricing on more than one item of the same type but less
than the price for a bundle.

e Restrictions - Restrictions may be added for each product by enabling any of the following
options

*  Use Dept Security Level

*  Use Dept Tax

*  Use Dept Tender Restrictions
*  Use Dept Fract. Qty Allowed

*  Use Dept Minimum Purchase Age
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*  Use Dept Time Restriction
*  Use Dept Tax Before Discount

e Link Information - This information is used to enable Nucleus to ring up Linked items. Linked
items are items that are automatically rung up along with the original item. Link Code and Link
Code Type are required entries. Link Name will be automatically filled in by Nucleus.

*  Example: Link a product called Bottle Deposit to any beverage that comes in a bottle that
requires a bottle deposit fee to be charged.

1.) First program the item (Bottle Deposit) to be linked, then assign a PLU number to it.
2.) Go to the Modify Product window of the product that you want the item to link to.

3.) Select the Link Code type of PLU.

4.) Enter the PLU number of the linked item into the Link Code window.

5.) Select OK to save and exit or Cancel to exit without saving.

* Reports: The Day Report will list the original item and the linked item separately. Reports
using the example above will print the original item such as a Coke Product and the Bottle
Deposit which is the linked item under the Non-Fuel Products heading of the Day Report.

e Select Override to access the Product Restrictions programming window. See Figure 10-12.

Product Restrictions

Tax Rate: Tender Allowed

| Cash

w| Credit Card
/| Debit Card
| Mon EPOS
| Check

v| Coupon

| Fuel Memao
v A/ Sales
M oney Order

Security Level: | Lewvel 1 j

Minimum Purchaze Age il [ Allow Fract Gty

Time Restriction |None j

Ok Lancel

Figure 10-12 Product Restrictions Window

From the Product Restrictions window, you can program restrictions on a product or set a security
level that limits operational access, restrict certain tender types and tax rates, set time restrictions,
minimum purchase ages, or allows sales of fractional quantities. For example, you could restrict the
cashier from being able to accept credit cards for the purchase of lottery tickets.

*  |f there are restrictions on a department and an item is programmed to that department,
then check the Use Dept. box to use that department’s programming restrictions.

e Codes - Enter product PLU codes and UPC numbers in the Modify Product window.
*  Products can be scanned using PLU codes for single items and multi-packs.

m  Assign a single item PLU code to price a single item, such as a bottle of water. See
Figure 10-13.
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Modify Product

Name: [ FYETEEI Product #
Fricing Codes
$0.99 Oty 1
Each BLL: ’07
1 |
far
Qty:
$0.00 y 2
FLU: il
Restrictions Tone:
v Use Dept Security Level A :‘
bl D Multi Pack Code:
v Use Dept Tender Restrictions
]71
W Use Dept Fract. Gty Allowed
v Use Dept Min Purchaze Age UPC: 002259200701 4
v Use Dept Time Restriction
v Use Dept Tax Before Discount
Link. Infarmation
Link Code: Link. Mame:

Department:

| Beverage _ﬂ
Host Code:

| General Snacks _ﬂ

Wariable Tracking
[ Cashier Repart

[v Day Repart
[v Shift Report

[v Show on Scratchpad

Offerings...

Link Code Type: |NOMNE >

Figure 10-13 Product Code Programming Example for a Single Bottle of Water

m  Assign a multi pack PLU code to price a multi-pack, such as a six-pack of water. Multi-
pack programming tells the system that there are 2 different products attached to one
SKU. See Figure 10-14.

NOTE:To enable multi-pack scanning you must have “Scanning Defaults to Minimum Pack Size for
UPC” unchecked in Programming > System > IPT > Site.

Mame: Product #
Fricing Codes
$2.99 Oty 1
Each BLL: ’07
1 |
far

Qty:
$0.00 y 2

FLU: il
Restrictions Tone:
v Use Dept Security Level A :‘
bl D Multi Pack Code:
v Use Dept Tender Restrictions

g
W Use Dept Fract. Gty Allowed
v Use Dept Min Purchaze Age UPC: 002259200701 4
v Use Dept Time Restriction
v Use Dept Tax Before Discount
Link. Infarmation
Link Code: Link. Mame:
Ok Lancel

Modify Product

Department:

| Beverage _ﬂ
Host Code:

| General Snacks _ﬂ

Wariable Tracking
[ Cashier Repart

[v Day Repart
[v Shift Report

[v Show on Scratchpad

Offerings...

Link Code Type: |NOMNE >

Figure 10-14 Product Code Programming Example for Multiple Bottles of Water

m  When the cashier scans the SKU from the side of one of the items in the six pack, the
selection screen prompts the cashier to choose whether the item is being rung up is the
single or the multi-pack. See Figure 10-15.
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Select the item you are ringing up

Quantity Price

Press Item or Use Arrows to Select

Figure 10-15 Product Selection Screen for Multi-Pack Programming

*  Enter the UPC number from the product bar code or Click the mouse in the UPC data field
then scan the product. This will import the UPC scan code information from the product.

Department - Assign the department from the Department pull-down menu.
Host Code - Assign the host code from the Host Code pull-down menu.

Variable Tracking - This option controls the reports that contain the department information. To
assign a department to a report, check the box to the left of the type of report (Cashier, Day, or
Shift). See ” on page 151 for more information.

Show on Scratchpad - Check Show on Scratchpad to enable the product name to appear on
the Scratchpad in the Sales/Operation screen. See Figure 5-1.

Offerings - See Offerings Programming on page 154 of the Introduction section.

10.3.3 Modifying Existing Products

1.

128

Access the Product Programming window by selecting Cash Register > Non-Fuel > Product.
See Figure 10-10.

To modify an existing product, select the desired product and then click Modify to access the
Modify Product programming window. See Figure 10-16.
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Modify Product

LELCR PR N T 1202 Product #

Fricing Codes
$0.79 B Oty 1
FLU: 1
1 for Department:
$0.00 Oty 2 | Fourtain _ﬂ
il o Host Code:

Restrictions Type: ’—_| | General Merchandise _ﬂ
v Use Dept Security Level

v UseDept Tax Multi Pack Code: Wariable Tracking

ich |v Cashier Report
v Use Dept Tender Restrictions ’17 il
v Use Dept Fract. Gty Allowed ¥ DayReport

v Usze Dept Min Purchaze Age UPLC:
[v Shift Report

v Use Dept Time Restriction
v Use Dept Tax Before Discount

[v Show on Scratchpad
Q Offerings...
Link. Infarmation

Link Code: Link Mame: Link Code Type: |NOME -

Ok Lancel

Figure 10-16 Modify Product Window

3. Make changes to the price, department, restrictions, etc. as needed and then press OK to save
and exit or Cancel to exit without saving.

10.3.4 Modify Future Prices

This function allows changes to existing product programming to allow the user to program a price
change to take place at some time in the future.

1. Access the Product Programming window by selecting Cash Register > Non-Fuel > Product.
See Figure 10-10.

2. To modify the future price of a product, select the desired product and then click Future Price to
access the Modify Product programming window. See Figure 10-17.
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Modify Product

Mame:  [FOUNT 120z Praduct 8 || Effective Date and Time:
08/08/2006 02:22 AM j\ .
Picing Codes | . Effective Date and
W Ean 2 11 Time pull-down
1 for Department:
$0.00 Oty 1] |F0untain j
il o Host Code:

Bestrictions i

= ] Type: ’—_| | General Merchandise hd
v Use Dept Security Level -be

v UseDept Tax Multi Pack Code: Wariable Tracking

[v Use Dept Tender Restrictions ’17 [w Cashier Report
v Usze Dept Fract. Gty Allowed ¥ DayRepatt

v Usze Dept Min Purchaze Age UPLC:
[v Shift Report

v Use Dept Time Restriction

v Use Dept Tax Before Discount I :Show on Serslchpad

Link. Infarmation

Link Code: Link Mame: Link Code Type: |NOME -

Ok Lancel

Figure 10-17 Future Price Modify Product Window

3. Enter the new product pricing which is the price that will be charged for the product when the
Future Price goes into effect.

4. Click on the Effective Date and Time pull-down to open up a calendar where a date can be
selected. See Figure 10-18

4| Augustzoo6 _»|

1 2 3 4 5

ET e 8 1011z
13 14 15 16 17 18 19

0 02 2 023 24 45 X%
27028 23 30 3

T Today: 8/7/2006

Figure 10-18 Future Price Calendar

5. Select a future date by clicking on the desired date. You can then select the desired time that
you want the price change to occur.

6. Press OK to save and exit or Cancel to exit without saving.

NOTE:AIl of the product programming in the Modify Product programming window can be changed
at the same time that the future price change is made and will go into effect when the price change
occurs.

10.4 Car Wash Programming

Car Wash programming allows you to set up car wash sales, awards, and discounts for 12 types of
car washes. Future Price programming allows a price modification to occur at a later date. Car
washes can be purchased or awarded with the purchase of something else (for example, fuel) and/
or they can be discounted with a fuel purchase. Car washes can also be purchased as an upgrade
from the basic wash. The first 9 car washes can be purchased at the CATs.

Access the Car Wash programming window by selecting Cash Register > Non-Fuel > Car Wash.
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[Mum [Mame [ Price| Department | Enable | «
Car Y azhl $1.95| Car'w/ash Dept ez
C 2 $1.96|C ept

3 Car 'wazh3 1.97| Carwash Dept es
4 Car 'wazhd 1.98| Carwash Dept es
5 Car 'wazhb 1.99| Carwash Dept Mo
E Car 'wazhG 2.00| Carwash Dept Mo
7 Car 'wazh? 1.95| Carwash Dept Mo
8 Car 'wazhg 1.96| Carwash Dept Mo
9 Car 'wazh3 1.97| Carw/ash Dept Mo
10 Car 'wazh10 1.98| Carwash Dept Mo
11 Car'wazhl1 1.99| Carwfash Dept Mo
12 Car'wazhl2 2.00| Carwfash Dept Mo j

Future Price... | Site Setup... | Lloze |

Modity selected entry

Figure 10-19 Car Wash Window

The Car Washes programmed must match the Car Wash Controller settings.

The Car Wash programming options that are available are Modify, Future Price, Site Setup and
Close.

10.4.1 Modify Car Wash Programming
Select the Modify button to display the Modify Car Wash window in Figure 10-20 below.

Modify Car Wash

M ame:
Fricing Codes
1.9 Each PLU: |0
Bestrictions

Controller Code:

v Use Dept Security Level
Iv Use Dept Securty Leve e

[v UseDept Tax
[v Use Dept Tender Restrictions

Departmert:
™ Use Dept Tax Before Discount (EREIHIE]

Carwash Dept j
Link Code and Type

Link Code: Link. Mame:
Link Code Type:  [yoNE P

Host Code:
| Car'wash j

|v Enable

Ok | Lancel |

Figure 10-20 Modify Car Wash Window

The Modify Car Wash programming window allows you to enter a car wash Name, Number,
establish un-discounted Pricing, set Restrictions, assign PLUs, Controller Codes, Departments,
and Host Codes.

e Use Dept Security Level - Select Use Dept Security Level to allow car wash sales based on
the Security Level programmed for the department that the particular car wash is linked to.
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e Use Dept Tax - Select use Dept Tax to program each carwash type to use the tax rate from the
Department that the particular car wash is linked to.

e Use Dept Tender Restrictions - Select use Dept Tender Restrictions to program each carwash
type to use only the tender types that have been programmed for that particular car wash.

e Override - Choose Override to enter the Car Wash Restrictions programming window in
Figure 10-21. Car Wash Restrictions programming allows you to enable sales tax, or apply tax
before a discount, set security levels, and define the tender types allowed.

Car Wash Restrictions

Tax Rate: Appl Tax Before Discount:  Tender Allowed:

v/ Debit Card rS

| Mon EPOS
| Check

v| Food Stamps
v| Coupon

| Fuel Memao
v &/ Sales

v EBT

Security Level:

Lewvel 1 j

Ok | Lancel |

Figure 10-21 Car Wash Restrictions Window

e Link Information - This information is used to enable Nucleus to ring up Linked items. Linked
items are items that are automatically rung up along with the original item. Link Code and Link
Code Type are required entries. Link Name will be automatically filled in by Nucleus.

e Enable - Check the Enable box and select OK to activate the changes that you made in this
window.

10.4.2 Future Price Car Wash Programming
Select the Future Price button to display the Modify Car Wash window in Figure 10-22 below.
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Modify Car Wash

M ame:
Fricing Codes
1.9 Each PLU: |0
Bestrictions

Controller Code:

v Use Dept Security Level
Iv Use Dept Securty Leve e

[~ Use Dept Tax
[v Use Dept Tender Restrictions

. Department:
[ Use Dept Tax Before Discount e J
-

Carwash Dept
Owerride. ..

Link Code and Type

Link Code: Link. Mame:

Link Code Type: ’m
Hast Cade: Click the Effective
[Cartwash El | Date and Time pull-down

|v Enable

Effective Date and Time:  [g5,08/2006 0319 AM -

Ok | Lancel |

Figure 10-22 Modify Car Wash Window

The Modify Car Wash programming window shown in Figure 10-22 allows changes to the car wash
programming just as in the previous section. However, the Future Price programming adds the
Effective Date and Time pull-down which is used to program a price change to take effect at a future
date.

NOTE:AIl of the car wash programming in the Modify Car Wash programming window can be
changed at the same time that the future price change is made and will go into effect when the price
change occurs.

e Click on the Effective Date and Time pull-down to open up a calendar where a date can be
selected. See Figure 10-23.

4| Augustzoo6 _»|

1 2 3 4 5

ET e 8 1011z
13 14 15 16 17 18 19

0002 2 023 M B XK
2028 028 3 0A
T Today: 8/7/2006

Figure 10-23 Future Price Calendar

133

August 2008 Part No. 2-920494 Rev. G



10.4.3 Site Setup Car Wash Programming

Select Programming > Cash Register > Non-Fuel > Car Wash > Site Setup to access the Car
Wash Site Setup window. The Car Wash Site Setup window contains the car wash controller type
programming, car wash code programming, car wash prompt and timeout programming. Nucleus
supports external standalone Car Wash Terminals such as Unitec or Ryko. These Car Wash
Terminals have their own card readers, printers, CAT keypads and bill acceptors. They
communicate with the Chevron host for credit card approvals and generate their own customer
receipts. Car Wash codes are not needed and are not printed on the receipts generated by external
Car Wash Terminals because the car wash is directly connected to the controller. External Car Wash
Terminals which are interfaced to Nucleus require one CAT address from Nucleus therefore a site
can have a maximum of 23 CATs plus one Car Wash Terminal. See Figure 10-24 for the Car Wash
Site Setup Window.

NOTE:Nucleus is configured to allow for programming of up to twelve types of car washes at the
site. Sites can offer all twelve of the car washes in the store, however only the first 9 car wash types
can be offered at the CAT.

NOTE:In order for the car wash changes in programming to take full effect, you must perform an
End-of-Day (EOD) or an End-of-Shift (EOS) then restart the system. For instructions on performing
an EOD or EQOS, refer to the Operation section of the Operation Manual Part No. 1-920494.

Car Wash Site Setup

— Controller Type r Car'wazh Code Expires — CarWash Timeouts (in seconds]
" None " Mever Expires Car Wash W anted Prompt | 25
(" Fixed Code
e ' Espires in I?D‘ days Mezzage to Customer | 3
rline :
~ Contioller 2-Line Select Car Wash Pass 1 | 4
Only 2-Line Select Car Wash Pass 2 | 2
Unitec with
("' S
oW Allow Coar Woash to be Sold 4-Line Select From 3 Car Washes | o5
[~ ‘when Car ‘Wash Terminal / Touch Screen Pass 2 00
Controller Out of Service =

WARMING: System must be restarted for ANY of the ABOYE changes to take effect.

[~ Dizable Outdoor Car 'Wash Sale [V Show Prices at CAT Cw/T Cash Sales |

rCar'waszh Promptng————————————————— — Car wazh Sorting
= Fined " Mo Sort
= Prompt Befare Fueling (" Least to Most Expensive
* Prompt After Fueling (+ Most to Least Expensive
€ Order by Mame

Ok Lancel |

Figure 10-24 Car Wash Site Setup Window

10.4.3.1 Controller Type

e None - Select None when no car wash controller is connected to the system.

e Fixed Code - Select Fixed Code to use a car wash controller that only generates fixed codes.
e Controller Only - Select Controller Only if an indoor car wash controller is installed.

e Unitec with CWT - Select Unitec for sites with a Unitec Car Wash Terminal.

e Ryko with CWT - Select Ryko for sites with a Ryko Car Wash Terminal.

10.4.3.2 Car Wash Code Expires
e Never Expires - Choose Never Expires for a car wash code that never expires.

134
Part No. 2-920494 Rev. G August 2008




e Expires in ## days - Choose this option to enter the number of days the car wash code will be
valid.

NOTE:Make sure that the number of days for the code to be valid is programmed in the car wash
controller the same as the number of days programmed here.

10.4.3.3 Car Wash Timeouts

In each car wash prompt field, enter the number of seconds that you want the prompt to be
displayed at the CAT.

10.4.3.4 Allow Car Wash Sales When Terminal / Controller Out of Service

Enable this option to allow Car Washes to be sold for use at a later date. This is useful when the Car
Wash is down for maintenance and the customer desires a rain check. The Controller type must be
set for Fixed Code or Online for this option to work correctly.

10.4.3.5 CWT Cash Sales Button

The CWTCash Sale button is used to access the programming options for setting up a PLU used to
track cash sales done at the outdoor Car Wash Terminal. Nucleus can track the cash sales that are
conducted at the Car Wash Terminal and report those amounts via the CWTCash product shown
under Non-Fuel Products of the Day report. Press the CWT Cash Sales button and the following
window will be displayed.

Programming the CWT Cash Sale PLU

1. Goto Programming > Cash Register > Non-Fuel > Car Wash.
2. Press the CWT Cash Sales button and the following window will be displayed.

Car Wash Terminal Cash Sale Configuration

Cw T Cash Product ltem

CwT Product Mame  [CwT Cash

PLU Humber 999

Departrnent Carwash Dept

Modify W T Cash Product | Cancel |

Figure 10-25 CWT Cash Sale Configuration Window
3. Enter CWT Cash as the CWT Product Name.
4. Enter 999 or any other unused PLU number in the PLU Number field.
5. Using the Department pull-down, select the appropriate Car Wash Department.

6. Select OK to save and exit or Cancel to exit without saving.
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Using the CWT Cash Sale PLU

Enter the PLU number for CWT Cash product at the Nucleus terminal and press the PLU/SKU
key.

Enter the dollar amount of cash retrieved from the Car Wash Terminal.
Click OK.
Press the Tender button then the Cash button

10.4.3.6 Disable Outdoor Car Wash Sale (Reboot is not required to activate this change)
Enable this option to disable Car Wash Offerings at the CAT.

10.4.3.7 Show Prices at CAT
Enable this option to show the prices of each of the enabled Car Wash offerings at the CAT.

10.4.3.8 Car Wash Prompting (Reboot is not required to activate this change)

Fixed - Not Available

Prompt Before Fueling - Enables the Car Wash prompting at the CAT to be displayed prior to
fueling.

Prompt After Fueling - Enables the Car Wash prompting at the CAT to be after fueling is
complete but before the sale is finalized.

10.4.3.9 Car Wash Sorting (Reboot is not required to activate this change)

No Sort - The car wash offerings are displayed at the CAT in no particular order.

Least to Most Expensive - The car wash offerings are displayed at the CAT in order from the
least expensive to the most.

Most to Least Expensive - The car wash offerings are displayed at the CAT in order from the
most expensive to the least.

Order by Name - The car wash offerings are displayed at the CAT in alphabetical order.

10.5 PLU Programming

Select the PLU option to view the PLU Codes programmed. Access the PLU Codes programming
window by selecting Cash Register > Non-Fuel > PLU. See Figure 10-26 below. Use the arrow
keys to scroll down the list of PLUs in the window. Use this window to display the current list of PLUs
programmed into the system.

136

PLU Codes

PLU UnitPrice Gty Gty Price Product -
$0.7 1 16 02 FOUMTA,

32 0.89 1 0.89 32 0Z FOUNTA

33 0.99 1 0.99 44 0Z FOUNTA

34 1.19 1 1.19 64 0Z FOUNTA

35 0.69 1 0.69 SMALL FOUNTA

36 0.69 1 0.69 LARGE FOUNTA

39 0.79 1 0.79 12 0Z COFFEE

40 0.89 1 0.89 16 0Z COFFEE

1 0.99 1 0.99 20 0Z COFFEE

42 0.59 1 0.59 SMALL COFFEE

43 0.59 1 0.59 LARGE COFFEE

43 1.09 1 1.09 24 0Z COFFEE

Fd nAq 1 14 N7 PARRNOT j

Figure 10-26 PLU Codes Window
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10.6 Time Restriction Programming (Blue Law)

The Time Restrictions feature or Blue Law configuration allows a site to restrict the purchasing of
products through the definition of a restriction schedule. This time restriction is a list or chain of start
and end times for when the product cannot be sold. If an item is within a department that has a Time
Restriction applied to it, then the item cannot be sold and a popup will be displayed to the cashier.

Access the Time Restrictions programming window by selecting Cash Register > Non-Fuel > Time
Restrictions. See Figure 10-27. The Time Restriction Definition menu allows the user to select the
start and end times of a restriction and add that range to a chain or list. Programming a restriction to
occur every day with the same start and stop times requires that an entry be made for every day of
the week and the start and stop times for each day to be programmed.

The available size for the Time Restriction description length is 40 characters and all will be
displayed anytime the Time Restriction is used.

Time Restrictions

Description -
Mo beer after rmidnight
Mo cigs after midnight
no beer on Sunday

Add Remowve M adify Cloze

Figure 10-27 Time Restrictions Programming Window
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1. Select the Add button to program a new restriction or select an existing restriction and then
press the Modify button. The following window will then be displayed.

Time Restriction Definition

Description  [Mo beer after midnight

[ Restriction List
Start Day Start Time
Monday

M

Tuesday 12:00:00 Ak Wednesday 10:00:
Wedneszday 12:00:00 Ak Thurzday 10:00:00 Ak
Thurzday 12:00:00 Ak Friday 10:00:00 Akd
Friday 12:00:00 Ak Saturday 10:00:00 Ak
Saturday 12:00:00 Ak Sunday 10:00:00 Akd
Sunday 12:00:00 Ak Monday 10:00:00 Akd
=
Add Femove Modify Cloze

Figure 10-28 Time Restrictions Programming Window

2. Select one of the existing time restrictions listed and then press Modify or select Add to create
a new Time Restriction. The following window will then be displayed.

S
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w| Time Restriction Window:

Select Start of Restriction

Start Day Start Time

Saturday j 12[T00 A =

Select End of Restriction

End Day End Time
Sundyy | [10:00:002M =
Qg Cancel

Figure 10-29 Time Restrictions Window

Enter a End Day using the pull-down then enter a End Time in the End Time field.
Click OK to save and exit or Cancel to exit without saving.

Repeat from step 2 to add another day to the restriction.

Enter a Start Day using the pull-down then enter a Start Time in the Start Time field.
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10.7 Lottery Sale Setup

The Lottery Sale Setup section is where lottery sales are configured. The programming options in
this screen allow you to define the product name of the lottery offering and the department that it
belongs to. Program the Lottery State according to where the store is located, and define the IP
address of the Lottery Server that Nucleus will communicate with when performing Lottery
transactions.

You can also enable or disable lottery sales from this screen. If the Enable For Sales option is
selected, the Nucleus system will add Lottery to the product programming window and enable the
Lottery Sales button in the Financial Operations screen. From the Programming Access window
select Cash Register > Non-Fuel > Lottery. See Figure below.

Enable or Disable \

Lottery sales -L0t|t;r}'

Product Mame: W

Department: LOTTERY ¥

Lattery State Configuration

Server Address \ Lottery State: [Toc =
Setup BUtton i Server Address WARMING: Spstem must
Setup hf restarted for State

to take effect.

Modify Button
\T Moty | oK | [ |

Figure 10-30 Lottery Sales Setup Window

Press the Server Address Setup button to enter the Lottery Server Setup window where the IP
address of the G-Tech Lottery server is entered. See Figure 10-32.

Lottery Server, Setup

IF address:  |hge (24 3] 294

Ok | Lancel |

Figure 10-31 Lottery Server Setup

Enter The IP address of the G-Tech lottery server and press OK to save and exit or Cancel to exit
without saving.

Press Add to add the Lottery programming to the system. Press the Modify button from the Lottery
Sales Setup window to open the Modify Product window which will allow you to make more detailed
programming changes to the Lottery product. See Figure 10-32.
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Modify Product

Hame: | attery 1 Product #

Fricing Codes
$1.00 B Oty 1
FLU: il
1 o Department:
$0.00 iy Jz [Misc. |
il u Host Code:
Bestrictions -
= ] Type: ’—_Y_| | General Merchandise _ﬂ
[ Use Dept Security Level -be NONE
[ UseDept Tax Multi Pack Code: Wariable Tracking
™ Use Dept Tender Restrictions ]7 [v Cashier Report
1

[~ Use Dept Fract. Gty Allowed v Day Report

[ Usze Dept Min Purchaze Age UPLC:
: Al v Shift Report

]_ 4

[v Show on Scratchpad

Offerings...
Link. Infarmation
Link Code: Link Mame: Link Code Type: |NOME -

Owerride. ..

Ok | Lancel |

Shows restrictions for this product

Figure 10-32 Modify Product - Lottery
Make the necessary changes to the Lottery product such as tender and age restrictions.

NOTE:Changes to the Lottery product made from this window will override programming done from
the Lottery Sales Setup window.

Click OK to save and exit or Cancel to exit without saving.

11 TENDER PROGRAMMING

Tender programming allows you to set the type of tender method allowed for product payment. You
can also program tender restrictions with this option. From the Programming Access window select
Cash Register > Tender. See Figure 11-1 below.

Tender, Programming

b aximumn | Security

1
1
1

Coupon 1

Credit Card 2m 1 es

Cebit Card 501 1 es

Crive0ff 501 1 Mo

MHon EPOS m 1 es

Prepaid Card a1 1 Mo

Sparel 1] 1 Mo

Spared 1] 1 Mo -

Lloze |

Modity selected entry

Figure 11-1 Tender Programming Window

The options available in the Tender programming window are Modify, Assign Key and Close.
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11.1 Modify Tender Programming

The Modify Tender window can be used to modify the function of the existing tender types or to
create new tender types.

/N cauton

Duplication of existing pre-programmed tender buttons is not recommended and will cause
undesirable results.

Select the tender type to be changed and choose Modify. The Modify Tender window will appear.
Figure 11-2 shows an example of the Cash tender key programming.

Modify Tender,

Type:

Tender Options

[v Open Cash Drawer on Tender
v Allow on Negative Tranzactions
Iv Apply to Safe Drop Categories
[v Allow on Split Tenderings

<1717

Tender Amount Options

% hay or may not enter amount
" Must enter amount

" Cannhot enter amont

|v Enable

Bestrictions. .. |

External Reference [d: [4

Ok | Lancel |

Figure 11-2 Modify Tender Window

1. The Tender Options available are:

*

*

*

Open Cash Drawer on Tender - Opens the cash drawer whenever this tender type is used.
Allow on Negative Transactions - Use this tender type for refunds or returns.

Apply to Safe Drop Categories - This option allows the operator to record the dropping of
that specific tender within a Safe Drop transaction.

Allow on Split Tenderings - This allows the specified tender media to be used during split
tender transactions.

Amount Requires Customer Approval - The customer will be prompted with a message
on the ICAT asking to approve the final sales amount.

Reference Number Required - Check this box to require a reference number to be entered
for sales using the specific tender type.

Adjust Drawer Total - Adjust the running drawer total based on current sales. Usually
enabled for cash tender type.

2. The Tender Amount Options available are:

*

May or may not enter amount
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*  Must enter amount
*  Cannot enter amount

NOTE:It is recommended that the Tender Amount Options for the Coupon tender type, not be
changed from the “Must Enter Amount” setting. Any other setting for this tender type increases the
risk of fraud.

3. Check the Enable box to activate the tender type selected.

4. Choose Restrictions to open the Tender Restrictions window. See Figure 11-3 below.

Tender, Restrictions

Security Level

Usze:

Defeat Over Tenders: Level 2 2
b aximums
Tender: $300.00
Ower Tender: $99.00

Alt Over Tender: $39.00

Ok Lancel

Figure 11-3 Tender Restrictions Window

Tender Restrictions programming allows you to program the system with limits that restrict the use
of the tender keys.

*  Security Level - Security level programming at the tender restriction level allows you to set
a security level that must be assigned in order for an employee to Use the tender key.
Security level programming also allows you to set a Defeat Over Tenders security level.
The over tender amount may be overridden if an access level with a high enough value is
entered at the time of over tender. For example, using the settings in Figure 11-3, if
someone with a security level of Level 2 or higher signed on, she or he would be allowed to
enter a tender amount greater than $99.00 over the tender amount of the purchase.

*  Maximums - You may also set Tender limits, Over Tender limits, and Alternate Over Tender
limits.
m  Tender - Setting a Tender limit restricts the allowable maximum tender amount.
m  Over Tender - Over Tender limits set an amount an employee can enter over the tender
amount. By setting the Over Tender limit to O (zero), the system does not accept any

tender amount over the total price of a purchase. Note that the Over Tender limit should
be set to 0 (zero) for credit cards.

m Alt Over Tender - By setting an Alternate Over Tender amount, you can limit the
amount a cashier may accept after a particular time. This tender restriction is tied
directly to the alternate tender limits timer. Many stations do this to discourage robbery
attempts by refusing to accept any bills with a face value over 20 dollars after 10:00
p.m.

NOTE:AIlt Over Tender limits are controlled by the Alternate Drawer limits set at the System/IPT/
Site/Limits window.

5. Click OK to save and exit the Tender Restrictions window or Cancel to exit without saving.
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6. Assign an External Reference ID to assign an external reference number to the current tender
type. It should corresponds to the tender type ID number that the Back Office System uses to
identify the tender.

7. Touch OK to save and exit or Cancel to exit without saving.

11.1.1 Programming a Food Stamps Tender Type

The programming and processing of Food Stamps is handled as a Tender type. There are two
different types of Food Stamp transactions that can take place. The first is the standard tender which
involves the use of Food Stamp coupons. The second is the use of EBT (Electronic Benefits
Transfer) which is a separate authorization network that electronically pays for Food Stamp
purchases similar to a credit card network. The tax-exempt flag is enabled for the Food Stamp
tenders since Food Stamps are exempt from all taxes on the allowable items.

NOTE:Food Stamp processing is not supported for Canadian sites.

Items are designated to allow the food stamp tender through the existing Tender restriction
programming at the department or product level.

The database upgrade of existing sites will have the Food Stamp tender and EBT added but each
site must:

1. Enable the Food Stamp tender.

2. Add a Food Stamp tender key.

3. Program the appropriate department restrictions to allow or disallow both Food Stamps and
EBT.

If a department has some products that are not to be used with food stamps, the products can
override the department tender restrictions on the Product programming screen. For example, there
is a department of Grocery items that include all food items. The Food Stamp tender and EBT is
enabled for the Grocery department. One of the products is a hot pretzel. The hot pretzel product
must override the department's Tender Restrictions. Then Food Stamps and EBT must be turned off
as allowable tender types. If Food Stamps and EBT are not both turned off then either of those
tender types would allow the Food Stamp tender to be accessed.

Food Stamps cannot be used to buy the following products: (according to the USDA Food Stamps
rules and regulations):

e Dbeer, wine, liquor, tobacco, or cigarettes
e foods that are hot at the point of sale

e food to be eaten in the store

e vitamins or medicines

e petfoods

It is the site's responsibility to properly set/update their pricebook, department, product list to enable
the Food Stamp tender.

11.2 Assign Key Programming

Use Assign Key programming to assign additional tender keys to be available when the cashier
presses the TENDER button from the Operations Screen. The additional tender keys will be
assigned to any of 8 locations above the cash speed keys.
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Access the Assign Key programming window by selecting Cash > Tender > Assign Key. See
Figure 11-4 below. To program a key, touch the key to be assigned and then touch the tender to be
assigned to that key.

NOTE:The user must logoff or press the Tender key for changes in the programming to take full
effect.

Assign Key i
(None) (None) (None) (None) gg:;gg
Spared
Spareh
Spareb
PumpTest | A/R Sales | Coupon | Fuel Memo Spare?
Spared
Spared
Pump
Test Assign a tender type to the current key by selecting a tender

from the list. Selecting "(None)" will unassign the key.

Warning: Changes will not take effect at the IPT until you
logoff or press the TENDER key.

Ok Lancel

Figure 11-4 Assign Key Window

Once the tender types have been assigned to the appropriate tender keys, these keys will be
available to the cashier from the Operations Screen. When the cashier presses the TENDER button
from this screen, the additional tender keys will appear above the cash speed keys shown in
Figure 11-5 below.

AfR Fuel
PumpT es Coupon
Sales Memo

$50 $100  CHECK DEBIT

CREDIT $1 $5 $10 $20

CANCEL CASH $100.00

Figure 11-5 Secondary Tender Buttons
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12

11.2.1 Pump Test

A tender type called Pump Test can be assigned from the Assign Key programming window. Pump
Test is used when tendering out an amount of fuel that gets dispensed by a technician while testing
a dispenser. Normally this fuel is put back into the tank and therefore the current reporting
components will ignore all pump test transactions. See Figure 11-4.

NOTE:To track Pump Test activities add the Pump Test Totals component to the End of Shift and
End of Day reports. Go to Programming > Reports > Setup > Component.

NOTE:For more information on the operation of the Nucleus system, refer to the Operation Manual
(Part No. 1-920494).

FINANCIAL PROGRAMMING

Financial programming allows you to set up Nucleus to maintain the following operations as
required by your site. From the Programming Access window select Cash Register > Financial.
The window in Figure 12-1 appears.

Programming Access[ 4]

File Security System NSEEREEWEES Reporks  Metwork

Fuel 3

Mon-Fuel r

Tender |

Discount: Classifications Opening Balance
Tax Closing Balance
Price Modification Safe Drop
Service Charge Paid In
HouseAccounts Paid Cut:

Yendor Accounts Cash Back
BAC Refund
AlR Collect
Safe Loan

Figure 12-1 Programming Access Window

12.1 Fuel Prepay Programming

Use Fuel Prepay programming to set up security levels, a high amount limit, and allowable tender
types for fuel prepays. Select Fuel Prepay to display the window in Figure 12-2 below.

145

August 2008 Part No. 2-920494 Rev. G



Fuel Prepay:

Security Level:

R -

Allow Tender

w/| Credit Card
High Limit [s00000 /| Diebit Card

| Check

v| Coupon

v|EF5

v Comndata
| T-Check v

Ok | Lancel |

Figure 12-2 Fuel Prepay Window

e Security Level - Choose the lowest security level that you will permit a cashier to have to use
the fuel prepay tender. Select the level from the Security Level pull-down menu.

e High Limit - The High Limit feature allows you to set the maximum monetary amount the station
can accept on a fuel prepay.

e Allow Tender - Allow tender determines which tender types the system will accept. Check the
types of allowable tender in the box next to the tender type. For example, the Fuel Prepay
programming window in Figure 12-2 above shows all of the allowable tender types that can be
used for a fuel prepay.

NOTE:For Fuel Prepays to function properly the Fuel Memo box must be checked to allow fuel
overruns to be cleared from the system

12.2 Opening Balance Programming

Use Opening Balance programming to set up security levels, a high amount limit for your start cash
requirements, and whether a reference number is required. Select Opening Balance to display
Figure 12-3 below.

146

Part No. 2-920494 Rev. G August 2008



Opening Balance

Security Level: il Tl
>
w/| Credit Card
High Lirit: $150.00 v Debit Card
| Check
[ Reference Mumber Required | Coupon

v|EF5
v Comndata
| T-Check v

Ok | Lancel |

Figure 12-3 Opening Balance Window

e Security Level - Choose the lowest security level that you will permit to have access to the
opening balance feature. Select the level from the Security Level pull-down menu.

e High Limit - The High Limit feature allows you to set the maximum monetary amount the
cashier can have in the cash drawer when she or he enters the opening balance.

e Reference Number Required - The option to require an opening balance reference number
should be disabled. A Reference number should not be required for the cashier to enter an
opening balance.

e Allow Tender - Allow tender determines which tender types the system will accept. Check the
types of allowable tender in the box next to the tender type.

12.3 Closing Balance Programming

Use Closing Balance programming to set up security levels, a high amount limit for your closing
balance requirements, and whether a reference number is required. Select Closing Balance to
display the window in Figure 12-4 below.

Closing Balance

Security Level: il Tl
>
w/| Credit Card
High Lirit: $101.00 v Debit Card
| Mon EPOS
[ Reference Mumber Required | Coupon
v| Prepaid Card
v A/ Sales
v Adjust v
ak | LCancel |

Figure 12-4 Closing Balance Window
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12.4

Security Level - Choose the lowest security level that you will permit to have access to the
closing balance feature. Select the level from the Security Level pull-down menu.

High Limit - Set the maximum monetary amount the cashier may have in the drawer when she
or he enters the closing balance.

Reference Number Required - The option to require a closing balance reference number
should be disabled. A Reference number should not be required for the cashier to enter a
closing balance.

Allow Tender - Allow tender determines which tender types the system will accept. Check the
types of allowable tender in the box next to the tender type.

Safe Drop Programming

The cashier uses the Safe Drop feature to put money into the safe when she or he has reached the
maximum allowable cash in the cash drawer. Use Safe Drop programming to set up security levels,
a high amount limit, and whether a reference number is required. Select Safe Drop to display the
window in Figure 12-5 below.

Safe Drop

Security Level:

=
High Limit: $901.00

[ Reference Mumber Required

Use Tender Programming to set Safe Drop tenders

Ok | Lancel |

Figure 12-5 Safe Drop Window

Security Level - Choose the lowest security level that you will permit to have access to the safe
drop feature. Select the level from the Security Level pull-down menu.

High Limit - Set the maximum monetary amount the cashier may make in a safe drop.
Reference Number Required - Check this option to require a safe drop reference number.

12.5 Paid In Programming

148

Use Paid In programming to keep track of money received by the site when a vendor makes
payments to the store such as bottle deposits. Paid In programming options are Security Levels, a
High Limit, and whether a Reference Number or Account Number is required. Select Paid In to
display the window in Figure 12-6 below.
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12.6

Paid Out Programming

Use Paid Out programming to pay a vendor for goods and services such as the ice or snack vendor.
Paid Out programming options are Security Levels, a High Limit, and whether a Reference Number
or Account Number is required. Select Paid Out to display the window in Figure 12-7 below.

Security Level: il Tl
>
Credit Card
High Limit $500.00 Debit Card
Coupon
I™ Reference Mumber Required Fuel Mema

[ Account number required

Ok | Lancel |

Figure 12-6 Paid In Window

Security Level: il Tl
>
Credit Card
High Limit: $501.00 Dehit Card
Coupon
Iv Reference Mumber Required Fuel Mema

v Account number required

Qg | Lancel |

Figure 12-7 Paid Out Window

Security Level - Choose the lowest security level that you will permit to have access to the paid
in feature. Select the level from the Security Level pull-down menu.

High Limit - Set the maximum monetary amount the cashier may make in a paid in operation.

Reference Number Required - Check this option to require a paid in reference number. Using
reference numbers enables the system to find a particular transaction faster.

Account Number Required - Check this option to require a paid in account number. Using
account numbers enables the system group particular transactions together.

Allow Tender - Allow tender determines which tender types the system will accept. Check the
types of allowable tender in the box next to the tender type.
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12.7

NOTE:

150

Security Level - Choose the lowest security level that you will permit to have access to the paid
out feature. Select the level from the Security Level pull-down menu.

High Limit - Set the maximum monetary amount the cashier may make in a paid out operation.

Reference Number Required - Check this option to require a paid out reference number. Using
reference numbers enables the system to find a particular transaction faster.

Account Number Required - Check this option to require a paid in account number. Using
account numbers enables the system group particular transactions together.

Allow Tender - Allow tender determines which tender types the system will accept. Check the
types of allowable tender in the box next to the tender type.

Cash Back Programming

Use Cash Back programming to set up security levels, service charges, high amount limit, and
allowable tender for cash back operations. Select Cash Back to display the window in Figure 12-8
below.

Cash Back (Over) Transactions will be allowed using Discover cards. Discover card holders will
be able to receive cash back (over) with their purchase at Chevron & Texaco stations. Once this
feature is implemented, and the card table modifications have been made then Nucleus
programming will need to be modified to support this feature.

Cash Back

Security Level: Allow Tender
>
Credit Card
High Limit: $50.00 w/| Debit Card
Coupon
Fuel temo
Service Charge Product
&+ Mone
" Select From List
|v Enabled
Ok | Lancel |

Figure 12-8 Cash Back Window

Security Level - Choose the lowest security level that you will permit to have access to the
cash back feature. Select the level from the Security Level pull-down menu.

High Limit - Set the maximum monetary amount the cashier may issue in a cash back
operation.

Service Charge Product - This programming selection lets you select the service charge (if
any) that you want to use for cash back.

Allow Tender - Allow tender determines which tender types the system will accept. Check the
types of allowable tender in the box next to the tender type.

Enabled - Check this box to turn on the cash back programming.
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12.8

12.9

BAC Refund Programming

Use BAC Refund programming to set up security levels, a high amount limit, and whether a
reference number is required. A BAC Refund is needed when a customer deposits for example
$10.00 in the bill acceptor at the pump but only pumps $9.00 worth of fuel. Select BAC Refund to
display the window in Figure 12-9 below.

BAC Refund

Security Level: il Tl
>
Credit Card
High Limit $501.00 Debit Card
Coupon
I™ Reference Mumber Required Fuel Mema
ak | LCancel |

Figure 12-9 BAC Refund Window

e Security Level - Choose the lowest security level that you will permit to have access to the BAC
refund feature. Select the level from the Security Level pull-down menu.

e High Limit - Set the maximum monetary amount the cashier may make in a BAC refund
operation.

e Reference Number Required - Check this option to require a BAC refund reference number.
Using reference numbers enables the system to find a particular transaction faster.

e Allow Tender - Allow tender determines which tender types the system will accept. Check the
types of allowable tender in the box next to the tender type.

A/R Collect Programming

Use A/R Collect programming to set up security levels and a high amount limit for transactions using
the House Accounts function. Select A/R Collect to display the window in Figure 12-10 below. For
details on House Accounts functions see the House Accounts Programming section on page 177.
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AR Collect

Security Level:

Allow Tender

| Credit Card
High Limit: $501.00 /| Debit Card

v| Coupon
Iv Reference Mumber Required | Fuel Mema

v Account number required

Ok | Lancel |

Figure 12-10 A/R Collect Window

e Security Level - Choose the lowest security level that you will permit to have access to the
Accounts Receivable feature. Select the level from the Security Level pull-down menu.

e High Limit - Set the maximum monetary amount the cashier may make in an A/R Collect

operation.

e Reference Number Required - Enable this option to require a reference number for all A/R

Collect transactions.

e Account Number Required - Enable this option to require an account number to be entered for
all A/R Collect transactions. Refer to the House Accounts Programming section on page 177.

e Allow Tender - Allow tender determines which tender types the system will accept. Check the

types of allowable tender in the box next to the tender type.

12.10Safe Loan Programming

A Safe Loan is a loan in which the cashier borrows money from the safe to add to the cash drawer.
Select Safe Loan to display the window in Figure 12-11. The Safe Loan window allows you to
program the security level needed to perform this operation.
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Security Level: il Tl
Credit Card
High Limit $501.00 Debit Card
v| Coupon
I™ Reference Mumber Required | Fuel Mema
ak | LCancel |

Figure 12-11 Safe Loan Window

e Security Level - Choose the lowest security level that you will permit to have access to the Safe

Loan feature. Select the level from the Security Level pull-down menu.

e High Limit - Set the maximum monetary amount the cashier may make in a Safe Loan
operation.

e Reference Number Required - Enable this option to require a reference number for all Safe
Loan transactions.

e Allow Tender - Allow tender determines which tender types the system will accept. Check the
types of allowable tender in the box next to the tender type.

13 DISCOUNT CLASSIFICATIONS PROGRAMMING

Discount Classifications programming lets you select special options that allow the system to handle
offerings associated with a discounted product. From the Programming Access window select Cash
Register > Discount Classifications. Figure 13-1 shows the options that are available from the

Discount Classifications programming menu.

Programming Access[ 4]

File Security System NSEEREEWEES Reporks  Metwork

Fuel
Mon-Fuel
Tender
Financial

Discount: Classifications

Tax

Price Modification

Service Charge
Housefccounts

Offerings
Mi-M-Match
Combo

Item List

Yendor Accounts

Figure 13-1 Programming Access Window
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13.1 Offerings Programming

Offerings are discounts or rewards set up for customers that meet or exceed minimum purchase

amounts. Offerings are usually discounts on other goods or services. Programming for this feature is
accessible at different points within the system. Offerings can be accessed from the Fuel, Non-Fuel,
and Discount Offerings sections of Nucleus programming.

1. Access Offerings programming by selecting Cash Register > Discount Classifications >
Offerings.

Discount Offerings

Group

Fuel

Bemove |

Discount

Qffer Type [ Dffer
C E

Modiy... | Close |

Add a new entry into the database

Figure 13-2 Discount Offerings Window

2. Select Add or Modify to program Discounted Offerings or modify existing Discount Offerings.
The Discounted Offering window will appear. See Figure 13-3.

Search on Buy

Field  —__ |

Scroll Bar — |

Discounted Offering
Buy Offer
* Oty [0 * Free
e $4¢ oo " Amaunt OFf ! ‘\
" Percent Off
[~ AutoRing Up

\

Search on Buy

Buy Type |Buy -~
»

Fuel AltGas 2 »-

Group i
//‘Dﬁ AUTO/TRA

Dept BAGELS NT

Dept BAGELS T

Dept BEERAWINE

Group Beer\wine

Dept BRKFSTSNDW

Dept BLULK PROPANE

Dept CAMDY NT ~|

ok

loyee Discount

——

Digzount Type

Search on Offer:

zh
Express ' asf
product 1
Super Wazh
Ultimat ' ash

Car'wash
Product

Car'wash
Car'wash

Lancel

Figure 13-3 Discounted Offering Window

Discount Value:
Either Discount
Amount, Discount
Percent, or Dis-
count Price

Discount Type

Search on Offer
Field

Scroll Bar

3. Use the arrow keys to scroll down the list of items in the Buy Type and Offer Type fields.
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From the Discounted Offering window, you can program the following options:

e Buy - The Buy option allows you to select the minimum purchase required to earn a discount.
You may choose either a minimum quantity requirement (Qty) or a minimum dollar amount
requirement ($.$$).

*  No Fractional Quantities are allowed with this option. For example, if you set the Buy option
for Qty and Fuel, the amount must be a whole gallon amount, like 8 for 8 gallons.

*  If you choose a minimum quantity requirement, enter the number of items (or gallons when
the discount is based on fuel) to be sold in the Qty field.

* If you choose a minimum dollar amount requirement, enter that amount in the $.$$ field.

e Search on Buy - Enter the item that you are searching for in this field and the listing will display
the closest match to your search criteria.

e Buy Type - The Buy Type feature allows you to select the item that must be purchased to
qualify for the discount.

e Offer - The Offer option allows you to select the discounts that the system will offer.
e Free/Amount Off/Percent Off - This option allows you to choose the nature of the discount.
*  To make the discount a gift, choose Free.

*  To make the discount a price reduction, choose Amount Off and enter the amount of the
reduction in the field to the right.

*  To make the discount a percentage discount, choose Percent Off and enter the percent of
the reduction in the field to the right.

e Auto RingUp - This option allows you to program the system to automatically ring up the
offering whenever the required amount and item is purchased.

e Discount Type - Select the Discount Type from the pull-down to be assigned to this Discount
Offering.

NOTE:The Discount Type option is only available when a NAXML compliant Back Office
System has been selected. See Section 7.11 on page 67

e Search on Offer- Enter the item that you are searching for in this field and the listing will display
the closest match to your search criteria.

e Offer Type - The Offer Type feature allows you to select which items will be discounted.

The example in Figure 13-2 shows an Offering in which the group Fuel is set up to offer a $1.00
discount on a Deluxe Car Wash to a customer that makes a purchase of $10.00 or more from items
in this group.

NOTE:You can set up more than one offering for a single group. In addition to the offering already
associated with the example group Fuel, you could set up an offering to give a free Car Wash to a
customer that purchases $20.00 worth of an item in the Fuel group.

4. To delete an item from the Discount Offerings programming window, highlight the item, then
select Remove.

13.2 Mix-N-Match Programming

A Mix-N-Match Classification consists of a selection of products from a similar product group that
have the same price. (i.e. All products must come from the same department or department sub-
category).
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A department sub-category is a grouping of products within a Non-Fuel department. Sub-categories
are used to program the Mix-N-Match and Combo Discount Classifications. To access the
Department Sub-Categories programming select Cash Register > Non-Fuel > Department > Sub-
Categories. See Figure 13-4.

Department Sub-Categories
I ame -~

Add | Bemove | EhangeErice| Lloze |

Modity selected entry

Figure 13-4 Department Sub-Categories Window

This window provides a view of all sub-categories currently programmed in the system for the

selected department. Options available from this window are Add, Remove, Modify, Change
Price, and Close.

NOTE:The Change Price option is only active whenever None has been selected as a Back Office
type. Refer to the "Back Office Configuration” section on page 73.

Choose Add to display the window in Figure 13-5 below. Nucleus allows the department products to
be sorted by Name, UPC/PLU, Pack Size, or Unit Price by clicking on the different headers located
at the top of the grid. The vertical scroll bar can be used to help navigate the product listing making
it easier to locate products within the database when programming sub-categories.

Modify Sub-Category Products

Sort Department: | Sub-Category: [[IEENEM
Criteria ]
Click on|Depart t Produgt col hedders to sort
grid by golumn.

| v Departn!ﬂ Products v | Sub-Category Products
Pack Sz |Unit Prc

28

1% GALLON 47

-
1 319

T/2galMILE, [ 1 199 GALWHOLE [ 319

2% GALLON 48 1 319 SKIM GALLON 43 319

25%1/260L. 4 1 189

GALWHOLE 4 1 319

MILK PINTS 40 1 0.99

BUARTS MILK 4 1 113

SKIM 1/2GL. 5 1 189

SKIM GALLON 43 1 319 o =

Add - <- Delete
oK Eae | MisH-Match |

Figure 13-5 Add Sub-Category Products
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Use the Change Price button from the Department Sub-categories window to perform a mass
change of all the prices of the products listed within the selected Sub-Category. Press the Change
Price button and the following window will be displayed.

w. Sub-Category Price Change Q@E|

Department: |

Sub-Category: |

0ld Price:
Mew Price: 765

Qg | Lancel |

Figure 13-6 Sub-Categories Price Change

The window above shows the current Department, Sub-Category, and current price. The new price
for all the products within the listed Sub-Category is entered in the New Price field.

1. Access Mix-N-Match programming by selecting Programming > Cash Register > Discount
Classifications > Mix-N-Match. The window in Figure 13-7 below shows the present Mix-N-
Match classifications.

Mix-M-Match Classifications

W alue Promotion Time -~

$ 020 Drefault

Add Eemene | Modity |

Cloze the current programming windows

Figure 13-7 Mix-N-Match Classifications Window

2. Select Add or highlight an existing item and touch the Modify button to display the Mix-N-Match
programming window. See Figure 13-8.
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Scroll Bar

Mix-M-Match Programming,

Minimum Requirement to Qualify

‘& [Meme Promotion Time...
™ Transaction Total: Department;

" Department Total: | 2 J

[Fountain e ~ Promotion Time
&+ Department Qity: .
0 Btz Programming
[ Buy Options Quantity: [ 2 Walue: [0 20
Type I ame -
Dizcount Type Distribution
Dept Mizc. o Amount OFf
Dept Grocery/ P O o Even
Dept Itetar Ol il  wWeighted
Bt Spare 7 J " Disc. Price
/ Ment TR& =
Ok | Lancel |

Figure 13-8 Mix-N-Match Programming Window

Enter a Name for the offering of up to 12 characters including spaces.

Define the Minimum Requirement to Qualify for the promotion. This means that you can
program particular purchase minimums that must be met prior to consideration for the
programmed Mix-N-Match discount. Select one of the following requirements:

*

None - No purchase minimums are required before consideration of the Mix-N-Match
discount.

Transaction Total - The current transaction must have a minimum dollar amount before
consideration of the Mix-N-Match discount. Enter the minimum transaction dollar amount
that must be met.

Department Total - The current transaction must have a minimum dollar amount from the
defined department before consideration of the Mix-N-Match discount. Enter the minimum
transaction dollar amount and the department that the products must come from.

Department Quantity - The current transaction must have a minimum quantity of products
from the defined department before consideration of the Mix-N-Match discount. Enter the
minimum quantity of products and the department that the products must come from.

Select a department or department sub-category from the Buy Options list.

Enter the Quantity that will comprise the Mix-N-Match classification for the department or
department sub-category in the previous step.

Select the Discount Type: Amount Off, Percentage Off, or Discount Price.

*

The Amount Off options allows you to program the dollar amount to be discounted in the
Value field to the right.

The Percentage Off option allows you to program the percentage to be discounted in the
Value field to the right.

The Discount Price option instructs the system to set the total price of all the items sold to
the price shown in the Value window. As an example, when the promotion is ‘buy 5 sodas
for $1.00’. The Quantity would be 5, the Value would be $1.00 and the Discount Type would
be Disc. Price. Buying any 5 sodas would cost $1.00..
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8. Check the Distribution type, either Even to apply the discount amount or percentage evenly,
based on the number of items in the Quantity field, or Weighted to apply the discount amount or
percentage based on the items’ price as a percentage of the total offering amount.

9. Check the Enable box to activate this Mix-N-Match programming entry.

10. Click the Promotion Time button to access the Promotion Time programming which is where
the times are programmed that the discount promotions will be available. See Section 13.5 on
page 166.

11. Press the OK button to save the data and exit.

NOTE:Before the save can be completed, the system will validate the data. If any errors are found
a message will pop-up describing the error and focus will shift to the field containing the error. At this
point, the user can choose to fix the error and attempt to save again or exit the window without
saving. Press the Cancel button to exit the window without saving.

In the example in Figure 13-8, the Mix-N-Match classification is named Cola special. For the Cola
special, the Quantity programmed is 2, the Buy Options type is set to the Fountain department, and
the Discount Price is set to $0.20. Therefore, when a customer buys 2 items from the Fountain
department, the system will automatically apply the Cola special to this purchase by deducting
$0.20 from the total price.

The Cola special will appear on the Electronic Cash Register Display in the Sales/Operations
screen, as in Figure 13-9, below.

Fountain 0.99
Fountain 0.99
Cola special -0.20

I Quantity 3 l
Cancel
Tax 0.00
Total 1.78 v
Yiew

Figure 13-9 Cola Special in the Electronic Cash Register Display

12. To delete an item from the Mix-N-Match Classifications programming window, highlight the item
then select Remove.

13.3 Combo Programming

A Combo Classification programming consists of selected products that can span different product
groups (i.e. Items selected can be Dry Products and/or department sub-categories). Combo
selections can be selected from items within the same department if desired.

A department sub-category is a grouping of products within a Non-Fuel department. Sub-categories
are used to program the Mix-N-Match and Combo Discount Classifications. To access the
Department Sub-Categories programming select Programming > Cash Register > Non-Fuel >
Department > Sub-Categories. See Figure 10-7.
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Department Sub-Categories

Add

| Bemove |

Change Frice |

I ame -~

Lloze

Modity selected entry

Figure 13-10 Department Sub-Categories Window

This window provides a view of all sub-categories currently programmed in the system for the
selected department. Options available from this window are Add, Remove, Modify, Change

Price, and Close.

NOTE:The Change Price option is only active whenever None has been selected as a Back Office
type. Refer to the "Back Office Configuration” section on page 73.

Choose Add to display the window in Figure 10-8 below. Nucleus allows the department products to
be sorted by Name, UPC/PLU, Pack Size, or Unit Price by clicking on the different headers located
at the top of the grid. The vertical scroll bar can be used to help navigate the product listing making
it easier to locate products within the database when programming sub-categories.

Sort
Criteria

Department: |

Click on Dep

t Produgt col h

to sart

grid by column.

[ v D epartmaht Products v

Sub-Category: |

Modify Sub-Category Products

Sub-Category Products

ALLOM
ALLOM

Pack Sz |Unit Prc | «

28

-
1 319

T/2galMILE, [ 1 199 GALWHOLE [ 319

2% GALLON 48 1 319 SKIM GALLON 43 319

25%1/260L. 4 1 189

GALWHOLE 4 1 319

MILK PINTS 40 1 0.99

BUARTS MILK 4 1 113

SKIM 1/2GL. 5 1 189

SKIM GALLON 43 1 319 o =

Add - <- Delete
oK Eae | MisH-Match |

Figure 13-11 Add Sub-Category Products

Use the Change Price button from the Department Sub-categories window to perform a mass
change of all the prices of the products listed within the selected Sub-Category. Press the Change

Price button and the following window will be displayed.
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w. Sub-Category Price Change EIE'E'

Department: |

Sub-Category: |

0ld Price:
Mew Price: 765

Ok | Lancel |

Figure 13-12 Sub-Categories Price Change

The window above shows the current Department, Sub-Category, and current price. The new price

for all the products within the listed Sub-Category is entered in the New Price field.

Access Combo programming by selecting Programming > Cash Register > Discount

Classifications > Combo. The window in Figure 13-13 shows the Combo Classifications window

that appears.

Combeo Classifications )

Fromotion Time
$ 050 Default
% Dizcount at Item Level | free stuff —

free stuff

=1

Bemove | Todify | Lloze |

|Add a new entry into the database

Figure 13-13 Combo Classification Window
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1. Select Add or highlight an existing item and press Modify to access the Combo Programming
window. See Figure 13-14.

Combo Programming jl
Name: [Dirink & Snak Promation Time... | Discount Value:
— Minimum Fequirement ta Qualify Tupe: Value: I— E |th er D iSCO unt
" Mone * Amount Off Total - [$0.50 ¥ Show Outdoors Amount Discou nt
i : . " Percent Off Total R _ ' |
" Tranzaction Total: Department;  Total Price Distribution CAT Promo Message: Percent' or Dis-
9 D el |$2'DD |G'°Ce'-'r' LI " Percent OFf ltem 0 B INone LI count Price
' s Ay " weighted
epartment Hnty: = Amount OFf lkem ¥ Enable
— Buy/Combo Selection:
' Search on Mame
" Search on UPC/PLU
Buy Options Combo Selection:
Pack a Type Mame LPC/PLU Pack alue Gty | -
h |C 3 0 Product  [FOUNT 120z |1 a 0.00 1 —
Carwazh | Car ‘W ash: 1] Product | pretzel 1 0.00 1 —
Carwash | Car'wash3 I —
Dept Carwash Dept 1]
Fuel Diezel 1]
Product  |[FOUNT 120z |1 1]
Group Fuel 1]
Product | lottery sale 1 LI LI
adds> | <-Delete
o [ Gowd |
|Add selected entru to list

Figure 13-14 Combo Programming Window

e Enter a Name for the offering of up to 12 characters including spaces.

o Defi

ne the Minimum Requirement to Qualify for the promotion. This means that you can

program particular purchase minimums that must be met prior to consideration for the
programmed Combo discount. Select one of the following requirements:

*

*

None - No purchase minimums are required before consideration of the Combo discount.

Transaction Total - The current transaction must have a minimum dollar amount before
consideration of the Combo discount. Enter the minimum transaction dollar amount that
must be met.

Department Total - The current transaction must have a minimum dollar amount from the
defined department before consideration of the Combo discount. Enter the minimum
transaction dollar amount and the department that the products must come from.

Department Quantity - The current transaction must have a minimum quantity of products
from the defined department before consideration of the Combo discount. Enter the
minimum quantity of products and the department that the products must come from.

e Select the Discount Type: Amount Off Total, Percentage Off Total, Total Price, Percentage Off
Item, or Amount Off Iltem.

*

The Amount Off Total option allows you to enter the dollar amount to be discounted off of
the price of the total combo offering. Enter this dollar amount in the Value field.

The Percentage Off Total option allows you to enter the percentage amount to be
discounted off of the price of the total combo offering. Enter this percentage amount in the
Value field.

The Total Price option allows you to enter the total amount to be charged for the combo
offering. Enter this dollar amount in the Value field.
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*  The Percentage Off Item option allows you to enter the percentage amount to be
discounted off of the price of any of the items in the Combo Selections area. Enter the
discount percentage in the Value column of any or all of the items listed in the Combo
Selections area.

*  The Amount Off Item option allows you to enter the dollar amount to be discounted off of
the price of any of the items in the Combo Selections area. Enter the discount dollar amount
in the Value column of any or all of the items listed in the Combo Selections area.

Enter the Value of the discount in dollars or percentage.

Select the Distribution type, either Even or Weighted. Even distribution will divide up the
discount amount or percentage based on the number of items in the combo offering. Weighted
distribution divides up the discount amount or percentage based on the each items’ price as a
percentage of the total combo offering amount. This option is used only if the distribution value
has not been programmed in the combo selections area.

Enable the Show Outdoors option to make the Combo Offering available to customers at the
CAT.

NOTE:If a Combo offering is made available at the CAT using the Show Outdoors option, then one
of the products in the Combo offering must be fuel.

Use the CAT Promo Message pull-down to select one of the CAT Promotions programmed
earlier which matches the Combo offering being programmed. See "Promotions” section on
page 45.

Check the Enable box to activate this Combo programming entry.

Click the Search On Name field to perform a search of the products based on the first few
letters that are entered.

Click the Search On UPC/PLU field to perform a search of the products based on the UPC or
PLU code that is entered.

Select an item from the Buy Options list (department sub-category or product) by selecting the
item from the left-hand side and pressing the Add button. Repeat as many times as necessary.
To remove an item from the combo selection list, select an item on the right-hand side and press
the Delete button.

Tab to the Combo Selection list. The Value field can be modified to distribute the percentage or
amount across all items. If you choose Amount Off, the sum of the Combo Selections Value
fields must equal the amount.

*  For example, if a combo is created with an Amount Off of 1.00, and it contains three items,
the $1.00 can be distributed $0.25, $0.25, and $0.50.

NOTE:If no value is defined for each of the products in the Combo Selection then Nucleus
will apply the discount equally.

*  If you select Percent Off, the sum of the Combo Selection Value fields must equal 100%.

*  If Discount Type is set to Discount Price or if the Amount Off and Percentage Off fields are
left at 0, the discount will be distributed evenly among all items. For example, if the discount
is $3.00 and three items are purchased, then $1.00 will be discounted on the first item,
$1.00 will be discounted on the second item, and $1.00 will be discounted on the third item.

Click the Promotion Time button to access the Promotion Time programming which is where
the times are programmed that the discount promotions will be available. See Section 13.5 on
page 166.
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2. Select the OK button to save the data.

NOTE:Before the save can be completed, the system will validate the data. If any errors are found,
a message will pop-up describing the error and focus will shift to the field containing the error. At this
point, the user can choose to fix the error and attempt to save again or exit the window without
saving. Press the Cancel button to exit the window without saving.

In the example in Figure 13-14, the Combo classification is named Drink & Snak. For the Drink &
Snak combo, the Combo Selection includes the products Cheetos and Sprite 200z and the Amount
Off is set to $0.50. Therefore, when a customer buys a Sprite and also buys 1 bag of Cheetos, the
system will automatically apply the Drink & Snak combo to this purchase by deducting $0.50 from
the price of the items.

The Drink & Snak combo will appear on the Electronic Cash Register Display in the Sales/
Operations screen, as in Figure 13-15, below.

CHEETOS 0.7ET
SPRITE 120z 0.59T
Orink & Snak —-0.50
| Cash 0. 87
! Cash change Oue: 0.0

Figure 13-15 Drink & Snak Combo on the Electronic Cash Register Display

3. To delete an item from the Combo programming window, highlight the item then select Remove.

13.4 Item List Programming

164

Item List programming is used to create lists of items to be available for selection as a Buy Option in
Mix & Match and/or Combo Classifications programming. Iltem List is similar to the sub-categories
feature, except that the items in the list do not have to belong to the same department, and the items
can have different prices. Carwash products are available for inclusion in an Item List.

Access Item List programming by selecting Programming > Cash Register > Discount
Classifications > Item List. The window in Figure 13-16 shows the Item List window that appears.
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Item Lists

I ame -~
List2
Add Bemove Modify LCloze ‘

Figure 13-16 Item List Window

1. Select Add to create a new ltem List or select an available list from the selection window and
press Modify. The following window then will be displayed.

Aidd Item List Products
Item List Mame: [|jst 2
' Seach on Name

 Seach an UPC/PLL |

" Search on Unit Price

Products Itern List Froducts
Name UFC/PLU Pack Sz |Unit Pre | = Name UFC/PLU Pack Sz |UnitPre =
2 MILK 00041 27100023 1 $0.89 A3VINEGA 00021 90005101-| |$0.93
25 ARRID 0002260073031 $2.99 1 1/2WHT IJDEI?DB?EDDU-‘.S!! |$1.69
Z0ICRAY 000Z240001832(1 $2.18 1/4 BURGER 0000831300004
200CT FIL 0007575512110 1 $2.49 1202 SLING 0002871400165
22qt codl 188 [1] $4.99 1602 PUNCT |
a2 0002487000070 |1 $1.99 27ct Choco
2402 1 §2388
27 1 3

o] 551
|000Z360001546 1 ]
Add-» <- Dedete

o | Cancel |

Figure 13-17 Add Item List Products Window

2. Use the Search on Name function to sort the product list by name, or use the Search on UPC/
PLU function and enter the UPC/PLU to find the item, or use the Search on Unit Price function
to sort the product list by price.

3. Select the product that you wish to add and press Add to move it to the Item List Products area
of the window.

4. Repeat step 3 to add more products or press OK to save and exit or Cancel to exit without
saving.
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5. The Item List will now be available to select when programming Mix- n-Match or Combo
offerings.

13.5 Promotion Time

The Promotion Time programming is used to define the time period that Combo/Mix-N-Match/Price
Modification discounts are available. This programming option is very flexible and allows for a wide
range of scenarios to be set up depending on the circumstances of the promotion. The Promotions
Time function is available from the Combo, the Mix-N-Match, and the Price Modification
programming screens and once displayed, the Promotions Time programming screen looks and
operates the same.

Depending on the entry point, any programming done from the Promotion Time screen is associated
with the discount offering from where the Promotion Time programming screen was entered. The
following examples will illustrate the different uses of the Promotion Time programming.

13.5.1 Default Setting

The below example shows the default settings for the Promotion Time option. The screen displayed
is when the Recurrence is set for None.

Promotion Time

Description: |M0ming Promo

Recurence: |IHIE %

/m: B/9/2006
Recurrence End Date
& Indefirit Start Time End Time
+  |hadennite
s |12:DDAM = |11:59PM =

" End after: of |1 OCCUTENCEs
 Endby: 8/9/2006 «

Figure 13-18 Default Promotion Time

These settings are used whenever a Combo/Mix-N-Match/Price Modification discount is enabled but
the Promotion Time programming has not been done.

e The Recurrence is setto None
e Start Date is set for today’s date, or any future date
e End Date can be set for:
* Indefinite which means that it has no end date
*  End after which can be set to end the promotion after it has occurred x number of times

*  End by which can be set to end on a specific date
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13.5.2 Recurrence Setting - Daily
The below example shows the screen displayed when the Recurrence is set for Daily.

Promotion Time

Desariptin: [Morring Promo Start and End
Times are
Fecurnence: enabled
/%‘! B/9/2006
Recurrence Erd Date
&+ Indefinite Start Time : End Time ]
¥ Enabled 1) [12008M =] [1153PM =
" End after: of 1 OCCUTEnces
[ Enabled 2] | = | =]
C Endby | B/9/2006
[ Enabled 3 | = | =11

Daily is enabled

\ Draily

& Every |1 ﬂda}l[s]

Figure 13-19 Daily Promotion Time

These settings are used whenever a Combo/Mix-N-Match/Price Modification discount is enabled
and the Promotion Time recurrence has been set for Daily.

The Recurrence is set to Daily

Start Date is set for today’s date, or any future date

End Date can be set for:

* Indefinite which means that it has no end date

*  End after which can be set to end the promotion after it has occurred x number of times
*  End by which can be set to end on a specific date

Daily can be set to 1 for the promotion to occur everyday or 2 for the promaotion to occur every
two days, etc.

Start Time and End Time can be used to program up to three separate time periods within a
calendar day that the promotion will be active.

13.5.3 Recurrence Setting - Weekly
The below example shows the screen displayed when the Recurrence is set for Weekly.
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Description: [Morming Promo Start and End
Times are
Recurence: IWEEH}' o l enabled
o
/ Start Date: IS.-"S.-"2DDB vl
Recurrence e
Start Timne End Time
* Indefinil
RIS ¥ Enabled 1) [12008M  —] [11:53PM

Weekly is
enabled T [ weeks

© End after: L of | OCCUITENCES
¢ Endby: I 8/9/2006 vl

[~ Enabled 2) ]12:DDAM :I |11:59PM

BEL EEF EL

[~ Enabled 3) ]12:DDAM :I |11:59PM

{* Ewvery |1_i||week[s] or:

[~ Sunday [ Monday | Tuesday [ Wednesday [V Thusday [ Fridapy [ S

|

Figure 13-20 Weekly Promotion Time

These settings are used whenever a Combo/Mix-N-Match/Price Modification discount is enabled
and the Promotion Time recurrence has been set for Weekly.

The Recurrence is set to Weekly

Start Date is set for today’s date, or any future date

End Date can be set for:

*  Indefinite which means that it has no end date

*  End after which can be set to end the promotion after it has occurred x number of times
*  End by which can be set to end on a specific date

Weekly can be set to 1 for the promotion to occur every week or 2 for the promotion to occur
every two weeks, etc. The days of the week are selected for when the promotion is supposed to
be active during the week.

Start Time and End Time can be used to program up to three separate time periods within a
calendar day that the promotion will be active.

13.5.4 Recurrence Setting - Monthly
The below example shows the screen displayed when the Recurrence is set for Monthly.
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Promotion Time

Deseription: |M0ming Fromao Start and End

Times are
Recurmence: 'm enabled
/%‘! 8/9/2008
Recurrence Erd Date

&+ Indefinite Start Time : End Time ]

¥ Enabled 1] |12:DDAM = |11:59PM =
" End after: of 1 OCCUTEnces

[ Enabled 2] | = | =
C Endby | B/9/2006

[ Enabled 3 | = | =]

Monthly is
enabled Ty Monthy

o Day ITﬂ of every Fﬂ manth(z]

" The |Second j |M0nda}l j of every |1 ﬂmonth[s]

Figure 13-21 Monthly Promotion Time

These settings are used whenever a Combo/Mix-N-Match/Price Modification discount is enabled
and the Promotion Time recurrence has been set for Monthly.

The Recurrence is set to Monthly

Start Date is set for today’s date, or any future date

End Date can be set for:

*  Indefinite which means that it has no end date

*  End after which can be set to end the promotion after it has occurred x number of times
*  End by which can be set to end on a specific date

Monthly can be set for:

* A particular day of the month is selected, then select 1 to choose every month or 2 to
choose every other month, etc.

*  Arecurring day of the week within a recurring week of the month. Then select 1 to choose
every month or 2 to choose every other month, etc.

Start Time and End Time can be used to program up to three separate time periods within a
calendar day that the promotion will be active.

14 TAX PROGRAMMING

The Tax Programming section allows you to view and modify the tax parameters set up in the
Nucleus system. From the Programming Access window select Cash Register > Tax to access the
Tax Programming window. See Figure 14-1.
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Tax Programming,

I ame Abbrey. W alue Enabled |
: Tax
pare(2 0.000%
Sparel3 0.000%
Spare04 0.000%
Sparel5 0.000%
SparelE 0.000%
Sparel7 0.000%
Spare08 0.000%

Modiy... |

Figure 14-1 Tax Programming Window

1. To modify a tax, select the tax from the list and touch Modify. The Modify Tax window appears.

See Figure 14-2.

Modify Tax

Name: Sales Tax
Abbreviation: [T
Walue: $0.00

Tupe:
" Percent

" Fixed Amount per Unit

" BP Table with Percent

FBounding

" Truncate
& Uponi/2
" Uponany

External Reference [d: |4

oK

Figure 14-2 Modify Tax Window

e Using this window you can enter a tax Name, Abbreviation and Value.

|v Enabled

Breakpoint Table

BP # Tax To
» a 0.00 0.00
1 0.0 0.00
2 0.02 0.00
3 0.03 0.00
4 0.04 0.00
b 0.05 0.00
5 0.06 0.00
7 0.07 0.00
g 0.08 0.00
E] 0.03 0.00
10 010 0.00
11 011 0.00
12 012 0.00
Start BP #: ’1_

LCancel

e Choose the Type of tax (Percent, Fixed, or from a BreakPoint Table). Refer to the following

section on Breakpoint Programming for information about breakpoint tables.

e Select the type of Rounding from this window.

e External Reference ID - Use this field to assign an external reference number to the particular
tax that corresponds to the tax ID number that the Back Office System may use to identify the

particular tax.

170

Part No. 2-920494 Rev. G

August 2008



2. Click on the Future Rate button to open up the Modify Tax window. This window contains an
Effective Date and Time Field which is used to enter a future date when a new tax rate will go
into effect.

Modify Tax

Mame: Sales Tax Effective Date and Time: |DS.-"‘I 242006 03:20 &M j
Abbreviation: [T v Enabled \
Value: . - Effective Date and
i Time field
BP # Tax To -~
» a 0.00 0.00
1 0.0 0.00
" Fixed Amount per Unit 2 0.02 0.00
) 3 0.03 0.00
" BreakPoint Table Fl 0.04 0.00
" BP Table with Percent 5 0.05 0.00
5 0.06 0.00
7 0.07 0.00
g 0.08 0.00
FBounding 9 0.09 0.00
10 010 0.00
W e i 011 0.0
& Upan1/2 12 012 0.00 j
" Uponany i 1

External Reference [d: |4
QK LCancel

Figure 14-3 Modify Tax - Future Rate

3. Click OK to save and exit or Cancel to exit without saving.

14.1 Multiple Tax Rates for Canada

The Nucleus database for use in Canadian sites has two additional tax rates pre-programmed which
are used to support multiple taxes in some Canadian areas. The two tax rates are called GST and
PST and you can access these tax rates by going to Programming > Cash Register > Tax. The
following Tax Programming window will be displayed.

Tax Programming I

GST Tax ——

Enabled| &pply to Original Price | 15 G5T

PST P 7

PST Tax — | Sparel3 0.000%
Spare04 0.000%
Spare05 0.000%
SparelE 0.000%
Sparel7 0.000%
Spare08 0.000%

Lloze |

|M0dify zelected entry

Figure 14-4 Tax Programming Window - Canada

The Goods and Services Tax (GST) amount is calculated by applying the GST tax rate to the Sub-
Total amount.
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The Provincial Tax (PST) amount is calculated by first adding the Sub-Total amount plus the GST
amount and then applying the PST tax rate to that total. The programming of these two taxes is
shown in the examples below.

1. To modify the GST tax rate, select the GST tax and then press Modify.

2. The following window is then displayed where you enter the appropriate tax rate, type, rounding,
and breakpoint calculations, and also check the two boxes labelled Original Price Only and Is
GST. Check the two boxes to tell Nucleus to calculate the tax on the original item price(s) only.

Modify the tax value
according to the rate

Narne: GST

Abbreviation: IG

X Walue: I?:
determined by the ———® '~
taxing authorities -

Tupe:
& Percent

Check the Enable box to enable the tax rate then press OK to exit.

" Fired &mount per
" BreakPaint Table

" BP Table with Percent

Wit

— Bounding
7 Truncate
* Uponil/2
" Up on Any

oK |

Modify Tax ]

¥ Enabled

¥ QOriginal Pricx@\

M 1sG5T -————

- Breakpoint Table

EP #

Tax

To

i

0.00

$0.00

-

0.m

0.00

0.02

0.00

0.03

0.00

0.04

0.00

0.05

0.00

0.06

0.00

0.07

0.00

00| | o || e | R =

0.03

0.00

9

0.03

0.00

10

010

0.00

1

011

0.00

12

ni?

Start BF #: |.1

10

Lancel |

Enable these two
| boxes when
programming the
GST tax.

Figure 14-5 Modify GST Tax Window

To modify the PST tax rate, select the PST tax and then press Modify.

The following window is then displayed where you enter the appropriate tax rate, type, rounding,
and breakpoint calculations, and also uncheck the two boxes labelled Original Price Only and
Is GST. Un-checking the two boxes to tell Nucleus to calculate the tax by adding the original
item price(s) plus the GST tax and then apply the PST tax rate to that amount.
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Modify the tax value
according to the rate
determined by the
taxing authorities

6. Check the Enable box to enable the tax rate then press OK to exit.

Modify Tax ]

M ame: PST

Abbreviation: Ip
Walue: I?z

- Iupe:
& Percent
€ Fired &mount per Uit
" BreakPaint Table
" BP Table with Percent

¥ Enabled
-

Uncheck these two

&W‘;, boxes when
[~ s GST

programming the
PST tax.

- Breakpoint Table

EP #

Tax

0.00

0.m

-

0.02

0.03

0.04

0.05

0.06

0.07

— Bounding
7 Truncate
* Uponil/2
" Up on Any

0.03

0.03

10

010

1

011

12

ni?

Start BF #: |.1

Qg | Lancel |

Figure 14-6 Modify PST Tax Window

14.2 Breakpoint Programming

Access the Tax Breakpoint programming window by selecting Programming > Cash Register >
Tax > Modify. See Table 14-1.

Programming the system for taxes that are not straight percentage requires you to use a tax
breakpoint table supplied by your tax authorities. The following steps explain how to program the
system for breakpoints.

1. Obtain a tax breakpoint table from your taxing authority. The following example shows a tax

table.

Table 14-1 Sample Tax Breakpoint Table

To Tax
0.10 $0.00
0.22 $0.01
0.39 $0.02
0.56 $0.03
0.73 $0.04
0.90 $0.05
1.08 $0.06

To Tax
1.74 $0.10
191 $0.11
2.08 $0.12
2.24 $0.13
241 $0.14
2.58 $0.15
2.74 $0.16
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1.24 $0.07 291 $0.17

1.41 $0.08 3.08 $0.18

1.58 $0.09

2. Enter the information from the tax breakpoint table into the Breakpoint Table field. (Refer to the
following paragraphs on Tax Table Breakpoint Programming and Combination Breakpoint and
Percentage Programming for more detailed information on different types of breakpoint table
programming.)

3. Enter a Start BP# value in that field to indicate at what BP# you want the Breakpoint Table to
start calculating the taxes, based on the repeating pattern.

14.2.1 Tax Table Breakpoint Programming

1. To program a tax rate for breakpoints, select BreakPoint Table as the Type from the Modify Tax
window.

2. Enter the money values from the tax table into the To column of the Breakpoint Table field, up to
the repeating pattern.

3. Enter the Start BP# where the repeating pattern begins.
The system automatically calculates the tax based on this pattern.

5. Select OK to save and exit or select Cancel to exit without saving.

14.2.2 Combination Breakpoint and Percentage Programming
Some states have tax rates that follow a breakpoint table up to some point, and then switch to a
straight percentage. In this case, use the following steps to program the breakpoint table:

1. Select BP Table with Percent as the Type from the Modify Tax window. Enter the percent
value.

2. Enter the money values from the tax table into the To column of the Breakpoint Table field, up to
the repeating pattern.

3. Enter the Start BP# to have the system automatically complete the rest of the table.
Select OK to save and exit or select Cancel to exit without saving.

15 PRICE MODIFICATION PROGRAMMING

Price Modification programming allows you to establish discounts for use with the system. From the
Programming Access window select Cash Register > Price Modification. The window in
Figure 15-1 appears.
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Price Modification Programming

Price Mod. Securty | Promation Time
iscount b an D efault

-]

Bemove | Modify | Clone... | Lloze |

Add a new entry into the database

Figure 15-1 Price Modification Programming Window

The Price Modification Programming window allows you to Add, Remove, Modify, or Clone the
discounts as needed for the operation of your system. Select Add or Modify to access the Price
Modification window below.

Price Modification

M ame: Jizcoun
Abbreviation: ID_
Tupe Apply To:
~ .
@ By Each Item In Line
L
 Percent Line Item Total
o
¢~ Manual Subtotal
% Manual Percent
I~ Positive
|v Enable
Security Level |4 = Fromation Time...
Discount Tupe [Sigre Coupon =
Ok | LCancel |

Figure 15-2 Price Modification Window
Name - Enter a discount name of 12 characters maximum.
Abbreviation - Enter an abbreviation of one character.
Value - Enter a dollar value when the Type is set to Amount or Percent.

Type - Select Amount, Percent, Manual, or Manual Percent.

*  Amount - A preset money amount is applied to the line item or subtotal of a given
transaction.

*  Percent - A preset percentage is applied to the line item or subtotal of a given transaction.
*  Manual - A money amount is manually entered.

*  Manual Percent - A percentage amount is manually entered.
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Apply To - Select whether the discount applies to each item in line, the line item total, or the
subtotal.

Positive - Select to add the value to the price. If this item is not selected, the value is subtracted
from the price. Discounts should be a negative, therefore, this should not be selected.

Security Level - Enter a security level for operation from the Security Level pull-down menu.
Discount Type - Define the discount type here from the choices in the pull-down menu.

NOTE:The Discount Type option is only available when a NAXML compliant Back Office
System has been selected. See Section 8.11 on page 60.

Click the Promotion Time button to access the Promotion Time programming which is where
the times are programmed that the discount promotions will be available. See Section 13.5 on
page 166.

Select OK to save and exit or choose Cancel to exit without saving.

SERVICE CHARGE PROGRAMMING

The Service Charge window allows you to add, remove, or modify the service charges needed for
the operation of your site. From the Programming Access window select Cash Register > Service
Charge. The Service Charges window appears. See Figure 16-1.

NOTE:It is against current Chevron policy to assess a service charge to ATM or Credit card
transactions.

Service Charges

Cash Back

Add... | Bemove |

Modity selected entry

Figure 16-1 Service Charges Window

The Service Charges programming window allows you to Add, Remove, Modify or Clone service
charges as needed for the operation of your system. Select Add or Modify to access the Service
Charge Modify window. See Figure 16-2.
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Service Charge Modify

[ C =ch B ack] Abbrev: |C
Bestrictions Tupe
[v Use Dept Security Level % Amount
v UseDept Tax " Percent
[v Use Dept Tender Restrictions i Manual
" Manual Percent
Department: Yalue: |$0.25
|Gen. Merch j
Host Code:
|530-Gen shore servs j
Ok | Lancel |

Figure 16-2 Service Charge Modify Window

e Name - Enter a service charge name of 12 characters maximum.
e Abbreviation - Enter an abbreviation of one character.

e Restrictions - Establish the Security Level, Department Tax, and Department Tender
Restrictions required to use a service charge.

e Type - Select Amount, Percent, Manual or Manual Percent.

e Department - Assign the department to which the service charge belongs from the pulldown
menu.

e Value - Enter a dollar amount for value if the Type is set for Amount or enter a percentage
amount if the Type is set for Percent.

e Host Code - Assign a Host Code to allow the network to keep track of certain product types by
linking them to a host product code.

e Select OK to save and exit or choose Cancel to exit without saving.

17 HOUSE ACCOUNTS PROGRAMMING

A House Account is used by large commercial or individual customers to put all of their purchases of
goods or services into one account that can be paid off in the future. There are two types of House
Accounts transactions, the first is A/R Sales which is a tender key that is used to purchase
merchandise and charge the amount to a customer’s account. The second is A/R Collect which is
located under the Financial Operations button and is used to make payments to the customer’s
account.

From the Programming access window select Cash Register > House Accounts to access the
House Accounts Programming window shown below.
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House Account Programming

Credit Lirnit Balance Allow Sales Ower Limit |

$0.00

Add... | Bemove | Modify | Clone |

Cloze the current programming windows

Figure 17-1 House Accounts Programming Window

e This window shows a list of the House Accounts that have been entered in the system.

e Use the Add, Modify or Remove buttons to add a new account, modify an existing account, or
delete an account. See Figure 17-2 below.

*  Enter the Name (optional) of the new account holder.
*  Enter an Account # no longer than ten digits including blanks and spaces.
*  Enter the Credit Limit which is the amount of credit you will extend to this account holder.

*  Check Allow Sales Over Credit Limit which will enable sales over the preset credit limit
after acknowledging the “Inform Customer the Account is Over the Credit Limit” pop-up.

*  The Balance window displays the current balance of the selected House Account. This
amount is the current running balance of money owed by the account holder to the station.

Modify House Account

Account | IIEELEE

Hame: Johnny Cab

Credit Limit:  {4300.00

Jv Allow Sales Over Credit Limit

Balance:

Ok | Lancel |

Figure 17-2 Modify House Accounts Window

*  Select OK to save and exit or Cancel to exit the Modify House Accounts Window without
saving.

e Push the Close button to exit the House Account Programming Window.

NOTE:In order to use House Accounts the following options must be set up:

1. Go into Tender programming by selecting Cash Register > Tender.
2. Highlight A/R Sales and choose the Assign Key.
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3. Touch one of the eight button locations that you wish to assign to the tender type A/R Sales.
Select A/R Sales from the list to complete the assignment of the button. This creates an A/R
Sales key to allow tendering of a sale as an A/R Sale.

Touch OK to save and exit.

5. Touch Modify to program the A/R Sales tender functions in the Modify Tender window. Be sure
and check the Enable box to enable A/R Sales Functions.

6. Touch OK > Close > File > Close to exit programming.

The addition of a House Accounts balance amount which is displayed in the Modify House Accounts
window will also change the Ref Media Report where the House Accounts balance will also be
displayed. Once you have completed these steps, Nucleus will be programmed to assign an A/R
Sales key to an optional key that is available when you choose Tender from the Nucleus Sales
window.

Lastly, Verify that the Ref. Tender Media report component is included in the Day and Shift report,
also verify that the print type is set for Detailed and not Summary so that House and Vendor account
information will be in the reports.

18 VENDOR ACCOUNTS PROGRAMMING

Vendor Accounts programming is used by the site to set up accounts for it's commercial vendors to
pay for goods and services and for vendors to make payments back to the site such as bottle
deposits. There are two types of Vendor account transactions, first is the Paid Out which is for
paying a vendor for goods and services such as the ice or snack vendor. The second is the Paid In
which is used when a vendor makes payments to the store such as bottle deposits. These
transactions can be tracked by Account number or Reference number for reporting purposes.

NOTE:A detailed accounting of House and Vendor account activity can be obtained by insuring that
the Referenced Tender Media component is added to the shift and day reports and the Print Type
is set to Detailed.

From the Programming access window select Cash Register > Vendor Accounts to access the
Vendor Accounts Programming window shown below.

Yendor, Account List

Donuts-R-Us

Add.. | Eemene | Modity |

Cloze the current programming windows

Figure 18-1 Vendor Accounts Programming Window

e Use this window to see a list of the Vendor Accounts that have been entered in the system.
e Use the Add or Modify buttons to add a new or modify an existing account.
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*  Enter or modify the name of the account holder.

*  Assign or modify the account number. The account number can be no longer than ten digits
including blanks and spaces. See Figure 18-2 below.

Modify Yendor Account

Ok | Lancel |

Figure 18-2 Add Vendor Accounts Window
*  Select OK to save and exit or Cancel to exit without saving.
e Select OK to save and exit or Cancel to exit without saving.
e Use the Remove button to delete an account from the system.
NOTE:In order to use Vendor Accounts the following options must be set up:

1. Go into Tender programming by selecting Cash Register > Financial > Paid Out.

2. Check the Account Number Required box so that when a Paid Out or a Paid In is rung up,
then a selection of the different vendors will be required.

3. Check the optional Reference Number Required box to require that a reference number for the
transaction be entered.

4. Touch OK to save and exit.

Once you have completed these steps, Nucleus will be programmed to display a list of vendors for
you to choose from whenever a Paid Out or a Paid In is rung up.

Lastly, Verify that the Ref. Tender Media report component is included in the Day and Shift report,
also verify that the print type is set for Detailed and not Summary so that House and Vendor account
information will be in the reports.

CURRENCY SETUP

Currency Setup programming is used to setup the Nucleus system to accept foreign currency as
well as United States currency. This option is only available if Enable Multi Currency has been
enabled under Programming > System > IPT > Site. This programming option is only available to
a user with a level 6 security level and should only be modified by a qualified service technician. See
Section 8.6.1 on page 35.

Go to Programming > Cash Register > Currency Setup to display the following window.
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Currency Programming

I ame

uso

Add.. |

Modify | Bemove |

Lloze |

Figure 19-1 Currency Programming Window

From this window you can Add a new currency, Delete a currency, or Modify the settings of the
selected currency. Select a currency that you wish to modify and then select Modify. The following

window will be displayed.

Modify Currency

M ame:

Rate:

oK

T

Abbreviation:

84.9%

|v Enabled

| Lancel |

Figure 19-2 Modify Currency Window

From this window you can:
Modify the Name

Modify the Abbreviation of the currency

Enable or disable the selected currency

Modify the exchange rate for the selected currency

The currently installed database of the Nucleus system will determine the “home” currency that the
system uses when calculating the Exchange rate. For example, If the system is loaded with a US
database then the US dollar becomes the home currency. When entering an exchange rate for an
alternate currency, the rate is calculated as a percentage of the home currency.

In the above example the Currency rate is determined to be 1 US Dollar = 1.17851 Canadian dollars
which is 1.0 divided by 1.17851 = .848529 or an exchange rate of 84.85%. A value of 84.8529 is
entered in the rate field as the exchange rate for the Canadian currency.

NOTE:lIt is advisable to consult the current official exchange rate on a regular basis and modify the

exchange rate as needed.
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20 REPORTS OVERVIEW

Nucleus generates reports that cover financial activities and system configuration. The report types include
Current, Sales, Configuration, Period To Date, Bill Acceptor Refunds, PLU List, SKU, Hourly Sales (HS), Tank
Inventory, Mix-N-Match, PLU Z, Item Sales Query, Mail, Full Serve Attendant Reports, Carwash Cash
Reconciliation, Employee Time Tracking, and Archived.

NOTE:Reports selected from the Programming > Reports window will print immediately on selection.

Current reports are a collection of transaction information compiled and presented in a desirable format.
These reports are based on transaction information that the system collects during operation from both indoor
and outdoor terminals. Nucleus reports summarize activities for a given period for both Fuel and Non-Fuel
sales. Current reports are “X” (examine) reports that show the items and sales totals up to the point that the
report was taken. Taking an EOS or EOD report “Z"s (zero) out the totals for the Current reports, except for
PTD.

Sales Log reports may be best thought of as an “electronic journal.” All Nucleus sales are logged in this report.
Configuration reports contain software release levels, peripheral types and number and so on.

Period To Date reports contain the total products, quantity and dollar amount sold since the last PTD report
was taken. (The PTD print function can be configured via Reports > Setup > PTD Configuration.) Taking this
report “Z"s out the PTD totals.

Bill Acceptor Refunds report gives details of money refunded to customers due to the customer pumping less
fuel than was paid for at a dispenser using the bill acceptor at the pump. The report contains information about
which pump was used and how much was refunded to the customer.

PLU List reports show the list of PLUs programmed in the system, which includes the PLU number, unit price,
guantity, quantity price and product description

SKU reports list the SKU items purchased and their price since the last SKU report was run.

Hourly Sales report lists the total number of transaction and dollar amounts by hour for the last 24 hours. This
report lists both indoor and outdoor transactions. By default this report is included in the EOD report chain and
is a “Z" report. Thus the hourly information is only valid for the hours since the last time the report was taken
either manually or by EOD.

Tank Inventory report lists the tanks, grades and product volume in each tank. The report also shows the date
and the amount of the last fuel drop.

MIx-N-Match reports list the total number of Mix-N-Match discount sales that were done since the last time
that the report was taken.

PLU Z reports list the PLU items purchased and their price since the last PLU Z report was run.

Item Sales Query allows the system to search the Sales log for the number of sales of a product or range of
products within a specified period of time.

Mail is how Secured and Unsecured mail from the Chevron Host is accessed.

Full-Serve Attendant Reports track sales data for an outdoor attendant even if he is logged onto more than
one full-serve CAT. The report tracking is done by attendant and not by CAT. The report is active even if an
attendant signs off of a CAT. The report must be specifically closed by the attendant or manager from the
Nucleus terminal.

Carwash Cash Reconciliation reports details information on how much money was retrieved from the
standalone Carwash terminal.

Employee Time Tracking is used to access the Employee Time Tracking report function where reports for
individual employees can be accessed and printed.

Archived reports contain stored reports for the following areas: Cashier, Shift, Day, BAC, PTD, SKU, Hourly,
Mix-N-Match, Terminal, and PLU. Archived reports are maintained for 365 calendar days. Reports older than
365 days are purged from the system.
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21 REPORTS PROGRAMMING

Reports programming allows you to set up the reports part of the Nucleus system to record and print financial
reports. The following paragraphs include diagrams, windows, and instructions that explain how to program
Nucleus to manage the programming and printing of reports.

21.1 Item Sales Query

Item Sales Query is used to search the sales log and compile reports based on the number of sales of a
particular product or group of products within a certain time period. From the Programming Access window
select Reports > Item Sales Query.

Item Sales Query

Start Date must be within the last 32 days.

Start Time and Date

Hour: E + AM
Minute: [ " PM

Month  Day Year

(.

End Time and Date

Hour: il + AM
Minute: [ " PM

Month  Day Year

(.

Enter PLU/SKU Mumbers and/or PLU/SKU Mumber ranges
separated by commas. For example: 1, 3, 512

" PLU Mumber [

" SKU Mumber

~
~

" Dept. Mame

" Product Desc.

For Product Description use asterisk[*] as a wildoard if needed.

[~ |

[~ |

[~ |

FErint | Lloze |

Figure 21-1 Item Sales Query Window
e Start Time and Date - This parameter defines the starting time and date where the item search will begin.
e End Time and Date - This parameter defines the end time and date where the item search will stop.
e Search Qualifier Field - The parameters that the query will use to locate the desired information.

*  PLU Number - Enter a PLU number or PLU number range separated by commas. For Example: 1, 3,
5-12 would search for PLU 1 and 3 and then any PLU number between 5 and 12.

*  SKU Number - Enter an SKU number or SKU number range separated by commas. For Example: 1,
3, 5-12 would search for SKU 1 and 3 and then any SKU number between 5 and 12.

*  Product Description - Enter a Product Description. Use the wildcard asterisk (*) if needed.
*  Mix-N-Match - Select one of the Mix-N-Match discount offerings as a search parameter.

*  Combo - Select one of the Combo discount offerings as a search parameter.

*  Department Name - Select one of the Departments as a search parameter.

Once the desired selections have been made touch the Print button to begin the search or touch Close to exit.
The report will print out on the Report printer if available, otherwise it will print on the Receipt printer.
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21.2 Full Serve Attendant Reports

The Full Serve Attendant Reports window is used to close any Full Serve Attendant Reports that are currently
open. From the Programming Access window select Reports > Full-Serve Attendant Reports, and the
following window will be displayed.

Close Full-Serve Attendant Reports

l Select Ussr Name . Enter Password:
I ame -~ I

A55T MANAGER
AUDITOR
Employee 1
MaNAGER
SHIFT LEADER
TECHMICIAN
Wwis'NE ACCESS

e ]

Lancel

Save all changes

Figure 21-2 Close Full-Serve Attendant Reports Window

1. To close a Full-Serve Attendant Report that is currently open, select the user name from the listing on the
left.

2. Enter the password, then select OK to proceed or Cancel to exit.

21.3 Components Programming

Report Components programming is used to gather information over a broad range of transactions and assign
them to a particular report or set of reports. From the Programming Access window select Reports > Setup >
Components.
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Programming Access[ 4]

File Security Systemn Cash Register | Reports  Nebwork

Components

Wariable Tracking

PTC Configuration
Terminal Z

Full-Serve Attendant

Purnp Totalizers

PLU and SKIU Configuration
Day Configuration

Current

Sales

Configuration

Period To Date

Bill Acceptor Refunds

PLU List

SKLU

Hourly Sales

Tark Inventory

Mix--Match

PLUZ

Item Sales Query

Mail 4
Full-Serve Attendant Reports
Carwash Cash Reconciliation
Emplovee Time Tracking
Archived

Figure 21-3 Programming Access Window

Report Components

FPreview Report... |

Toggle Auto Print |

Cycle Location |

LCvecle Copies |

Move Up | Bemove - |

Move Down | Cycle Print Type |

LCloze

[ Reports | Componerts Assigned ta Report Components Available to Report
Auta Print Location Mame Copies = Frint Type |Name -
Fiepart Printer 1 [retailed Bill Totals

es Feport Printer |BALC Refund 1

Yes Feport Frinter |Batch 1

Mo Fieport Printer | Canwash Cazh Rec B |1

Mo Feport Printer | Cazhier 1

es Fieport Printer | Day 1

Yes Fieport Printer |Hrly S ales 1

Yes Fieport Printer | b ail 1

es Feport Printer | Mis-M-tMatch 1

Yes Feport Printer | Outdoor Attendant |1

es Feport Printer |PLU Report 1

Yes Fieport Frinter |PTD 1 j j j

<= Azzign

Figure 21-4 Report Components Window

e Reports - The Reports column displays a list of reports that are currently available.

e Components Assigned to Report - The Components Assigned to Report column contains the report

components that have been assigned to the report that is highlighted in the Reports column.

e Components Available to Report - The Components Available to Report column shows what report
components are available but not presently assigned to the report highlighted in the Reports column.

e Preview Report - Opens a window and displays an example of the selected report.

e Toggle Auto Print - Toggles the auto print function on the selected report. By touching the Toggle Auto

Print button, the systems toggles between Yes and No.

* If Yes is selected, the system will automatically print and archive the report when queued to do so.
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*  If No is selected, a report will not be printed, and only archived.
e Cycle Location - Toggles the location where the report will print. The choices are Local, Remote, and Ask.

Cycle Copies - Increments the number of copies of the report to be printed. (1through 9) This option will
only function if AutoPrint is set to Yes.

Move Up - Adjusts the position of the assigned report components within the highlighted report.
Move Down - Adjusts the position of the assigned report components within the highlighted report.
Remove - Removes the component from the report.

Cycle Print Type - Toggles the print type assigned to the highlighted report component. Print Type is the
level of detail to which a component is reported. The three Print Types are Summary, Detail, and Non-Zero.

*  Summary - Summation of detailed information.

*  Detail - Individual items printed.

*  Non-Zero - Does not print details on zero sales.

*  NO Print - Does not print the report component
e Assign - Adds the component to the highlighted report.
e Close - Exits the window.

NOTE:In order to avoid overloading system memory with unnecessary data, make sure to Remove all
Components Assigned to a Report that you will not be using. After you remove the appropriate Report
Components, you must take that report in order to zero out the data at the End of Day.

Table 21-5 shows the Report Components and their available print type.

Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
BAC Bill Totals Detailed Provides Bill Acceptor financial information such as

amounts and denominations of bills accepted

BAC Refund Bill Accpt Refunds Detailed Tracks the refunds given on bill acceptor sales

Batch Host Batch Detailed Host Batch report

Carwash Cash Rec Rpt Carwash Cash Detailed Yes Tracks cash received at the carwash terminal
Accntg

Cashier POS Oper Summary| Detailed Yes Provides breakout of Net Sales calculation; total tax

received, total tax credits, net non-fuel sales and
summary of the total voids, transaction cancels, no
sales and average sale calculation

Tendering Summary/Det | Yes This section reports on the totals for each tender type.
ailed Detail print option is generally used in Cashier reports
with Summary print on Shift and Day reports

Group Printnon-zero/ Provides sales totals by group
Detailed

Departments Printnon-zero/ | Yes Provides department sales totals. Department sales
Detailed totals are updated when a sale is finalized
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Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
Cashier Non-Fuel Products Detailed Yes Provides total sales for all the non-fuel products
including PLUs, SKUs, and Presets. Products with no
sales are not printed. Only Detail print option is
available
Carwash Sales Detailed Yes Provides sales detail for car washes sold
Other Financial Detailed
Items
Grade Prod GRADE Yes Provides totals sales for each grade of fuel. Detail print
PRODUCT options breaks out sales by Pump Indoor/Outdoor, by
DETAIL if Service Level (Self, Full, Mini, an Other), and by Tier.
"Detail" is Summary print prints only combined totals for all grades
selected and
FUEL
PRODUCTS if
"Summary" is
selected
Price Overrides Summary/Det | Yes Provides detail on sales where the <Price Override>
ailed button was used to override the wrong price of a
scanned item
MixNMatch Sales Detailed Provides summary of mix and match and combo
discount classifications
Pump Test Totals Detailed Provides details on transactions using the Pump Test
tender
Ref. Tender Media Detailed Provides detail of tender and financial items where a
reference number was recorded
Day Station Summary Detailed Yes
Ref
POS Oper Summary| Detailed Yes Provides breakout of Net Sales calculation; total tax
received, total tax credits, net non-fuel sales and
summary of the total voids, transaction cancels, no
sales and average sale calculation
Tendering Summary/Det | Yes This section reports on the totals for each tender type.
ailed Detail print option is generally used in Cashier reports
with Summary print on Shift and Day reports
Group Printnon-zero/ Provides sales totals by group
Detailed
Departments Printnon-zero/ | Yes Provides department sales totals. Department sales
Detailed totals are updated when a sale is finalized
Non-Fuel Products Detailed Yes Provides total sales for all the non-fuel products
including PLUs, SKUs, and Presets. Products with no
sales are not printed. Only Detail print option is
available
Carwash Sales Detailed Yes Provides sales detail for car washes sold
Other Financial Detailed

Items
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Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
Day Grade Prod GRADE Yes Provides totals sales for each grade of fuel. Detail print
PRODUCT options breaks out sales by Pump Indoor/Outdoor, by
DETAIL if Service Level (Self, Full, Mini, an Other), and by Tier.
"Detail" is Summary print prints only combined totals for all grades
selected and
FUEL
PRODUCTS if
"Summary" is
selected
Outdoor Term Totals | Summary/Det Provides volume and sales by Customer Activated
ailed Terminal (CAT)
Price Overrides Summary/Det | Yes Provides detail on sales where the <Price Override>
ailed button was used to override the wrong price of a
scanned item
Auto Pay Detailed
Hourly Sales Hourly/Quarter Provides total products, quantity and dollar amount sold
Hourly Indoors and Outdoors, up until the point the report is
taken. Defaulted to print in the End of Day
Host Day Detailed Host Day Report from the Host Network
MixNMatch Sales Detailed Provides summary of mix and match and combo
discount classifications
Discount Sales Detailed This section provides detail for items sold where a Line
Item Discount or Service charge was applied
Bill Accpt Refunds Detailed Tracks the refunds given on bill acceptor sales
Carwash Cash Acct | Detailed Tracks cash received at the carwash terminal
Average Transaction| Detailed Tracks the average number and amounts of
transactions by cashier
Mannatec Card Detailed Provides detail of sales using Mannatec cards
Sales
Card/Tender Loyalty | Detailed Provides details on quantity and amount of loyalty
transactions
Convert Detailed Provides details on quantity, type, and amount of
conversion transactions
Fuel Price Changes | Detailed Provides details on dates, types, prices, and who
performed fuel price changes
Loyalty Accounts Detailed Provides Loyalty account status information
Loyalty Drive Offs Detailed Provides Loyalty account drive off information
Loyalty Sales Summary/Det Provides Loyalty sales information
ailed
Manual Entry Detailed Tracks the number, date, and amount of manually
keyed transactions by cashier.
SKU Price Check Detailed Provides details of SKU price checks
MOP Totals Detailed This report component details the sale type, method of
payment, location, and totals
PLU Sales Detailed Provides detail of Price Look-Up products sold
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Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
Day Pump Test Totals Detailed Provides details on transactions using the Pump Test
tender
Pump Totalizers Summary/Det | Yes Provides a snapshot of the pump totalizers
ailed
Ref Tender Media Detailed Provides detail of tender and financial items where a

reference number was recorded

SKU Totals Detailed Provides detail of Stock Keeping Units products sold
Tank Inventory Detailed Provides detail of fuel tank volumes
User Time Tracking | Detailed Provides details of employee hours worked
Manual Entry Detailed Provides information on manual entry transactions per
cashier
Convert Detailed Provides information on payment method conversions
per pump
Hrly Sales Hourly Sales Hourly/Quarter Provides total products, quantity and dollar amount sold
Hourly Indoors and Outdoors, up until the point the report is

taken. Defaulted to print in the End of Day

Mail Mail Detailed Provides details of mail messages from host

Mix-N-Match MixNMatch Sales Detailed Provides summary of mix and match and combo
discount classifications
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Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
Outdoor Attendant POS Oper Summary| Detailed Yes Provides breakout of Net Sales calculation; total tax

received, total tax credits, net non-fuel sales and
summary of the total voids, transaction cancels, no
sales and average sale calculation

Tendering Summary/Det | Yes This section reports on the totals for each tender type.
ailed Detail print option is generally used in Cashier reports
with Summary print on Shift and Day reports

Carwash Sales Detailed Yes Provides sales detail for car washes sold

Outdoor Term Totals | Summary/Det Provides volume and sales by Customer Activated
ailed Terminal (CAT)

Other Financial Detailed

Items

Departments Printnon-zero/ | Yes Provides department sales totals. Department sales
Detailed totals are updated when a sale is finalized

Grade Prod GRADE Yes Provides totals sales for each grade of fuel. Detail print
PRODUCT options breaks out sales by Pump Indoor/Outdoor, by
DETAIL if Service Level (Self, Full, Mini, an Other), and by Tier.
"Detail" is Summary print prints only combined totals for all grades
selected and
FUEL
PRODUCTS if
"Summary" is
selected

Group Printnon-zero/ Provides sales totals by group
Detailed

MixNMatch Sales Detailed Provides summary of mix and match and combo

discount classifications

Non-Fuel Products Detailed Yes Provides total sales for all the non-fuel products
including PLUs, SKUs, and Presets. Products with no
sales are not printed. Only Detail print option is

available
Price Overrides Summary/Det | Yes Provides detail on sales where the <Price Override>
ailed button was used to override the wrong price of a

scanned item

Ref Tender Media Detailed Provides detail of tender and financial items where a
reference number was recorded

PLU Report Station Summary Detailed Yes
Ref
PLU Sales Detailed Provides detail of Price Look-Up products sold
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Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
PTD Station Summary Detailed Yes
Ref
POS Oper Summary| Detailed Yes Provides breakout of Net Sales calculation; total tax

received, total tax credits, net non-fuel sales and
summary of the total voids, transaction cancels, no
sales and average sale calculation

Tendering Summary/Det | Yes This section reports on the totals for each tender type.
ailed Detail print option is generally used in Cashier reports
with Summary print on Shift and Day reports

Group Printnon-zero/ Provides sales totals by group
Detailed
Departments Printnon-zero/ | Yes Provides department sales totals. Department sales
Detailed totals are updated when a sale is finalized
PTD Non-Fuel Products Detailed Yes Provides total sales for all the non-fuel products

including PLUs, SKUs, and Presets. Products with no
sales are not printed. Only Detail print option is

available

Carwash Sales Detailed Yes Provides sales detail for car washes sold

Grade Prod GRADE Yes Provides totals sales for each grade of fuel. Detail print
PRODUCT options breaks out sales by Pump Indoor/Outdoor, by
DETAIL if Service Level (Self, Full, Mini, an Other), and by Tier.
"Detail" is Summary print prints only combined totals for all grades
selected and
FUEL
PRODUCTS if
"Summary" is
selected

Outdoor Term Totals | Summary/Det Provides volume and sales by Customer Activated
ailed Terminal (CAT)
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Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
Shift Station Summary Detailed Yes
Ref
POS Oper Summary| Detailed Yes Provides breakout of Net Sales calculation; total tax
received, total tax credits, net non-fuel sales and
summary of the total voids, transaction cancels, no
sales and average sale calculation
Tendering Summary/Det | Yes This section reports on the totals for each tender type.
ailed Detail print option is generally used in Cashier reports
with Summary print on Shift and Day reports
Group Printnon-zero/ Provides sales totals by group
Detailed
Departments Printnon-zero/ | Yes Provides department sales totals. Department sales
Detailed totals are updated when a sale is finalized
Non-Fuel Products Detailed Yes Provides total sales for all the non-fuel products
including PLUs, SKUs, and Presets. Products with no
sales are not printed. Only Detail print option is
available
Carwash Sales Detailed Yes Provides sales detail for car washes sold
Other Financial Detailed
Items
Grade Prod GRADE Yes Provides totals sales for each grade of fuel. Detail print
PRODUCT options breaks out sales by Pump Indoor/Outdoor, by
DETAIL if Service Level (Self, Full, Mini, an Other), and by Tier.
"Detail" is Summary print prints only combined totals for all grades
selected and
FUEL
PRODUCTS if
"Summary" is
selected
Outdoor Term Totals | Summary/Det Provides volume and sales by Customer Activated
ailed Terminal (CAT)
Pump Totalizers Summary/Det | Yes Provides a snapshot of the pump totalizers
ailed
Price Overrides Summary/Det | Yes Provides detail on sales where the <Price Override>
ailed button was used to override the wrong price of a
scanned item
Shift Auto Pay Detailed
Host Shift Detailed
MixNMatch Sales Detailed Provides summary of mix and match and combo
discount classifications
Discount Sales Detailed This section provides detail for items sold where a Line
Item Discount or Service charge was applied
Average Transaction| Detailed Provides average number and amount of transactions
by cashier
Bill Accpt Refunds Detailed Tracks the refunds given on bill acceptor sales
Card/Tender Loyalty | Detailed Provides details on quantity and amount of loyalty
transactions
Carwash Cash Acct | Detailed Tracks cash received at the carwash terminal
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Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
Shift Convert Detailed Provides details on quantity, type, and amount of
conversion transactions
Fuel Price Change Detailed Provides transaction details on Fuel Discount sales
Hourly Sales Hourly/Quarter Provides total products, quantity and dollar amount sold
Hourly Indoors and Outdoors, up until the point the report is
taken. Defaulted to print in the End of Day
Loyalty Accounts Detailed Provides Loyalty account status information
Loyalty Drive Offs Detailed Provides Loyalty account drive off information
Loyalty Sales Summary/Det Provides Loyalty sales information
ailed
Mannatec Card Detailed Provides detail of sales using Mannatec cards
Sales
Manual Entry Detailed Provides details on manual entry transactions
SKU Price Check Detailed Provides details of SKU price checks
MOP Totals Detailed This report component details the sale type, method of
payment, location, and totals
PLU Sales Detailed Provides detail of Price Look-Up products sold
Pump Test Totals Detailed Provides details on transactions using the Pump Test
tender
Ref Tender Media Detailed Provides detail of tender and financial items where a
reference number was recorded
SKU Totals Detailed Provides detail of Stock Keeping Units products sold
Tank Inventory Detailed Provides detail of fuel tank volumes
User Time Tracking | Detailed Provides detail of Employee and Contractor time
tracking
Manual Entry Detailed Provides information on manual entry transactions per
cashier
Convert Detailed Provides information on payment method conversions
per pump
Fuel Price Changes | Detailed Provides list of fuel price changes, listing old and new
prices as well as dates and cashier performing change
SKU Report Station Summary Detailed Yes
Ref
SKU Totals Detailed Provides detail of Stock Keeping Units products sold
System Station Summary Tr | Detailed
Tank Report Tank Inventory Detailed Provides detail of fuel tank volumes
Terminal Cash Rec Station Summary Detailed Yes
Ref
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Table 21-5 Report Components Table

Report Name Available Report Print Type Req’'d for Description
Component Available BOS
Terminal Cash Rec POS Oper Summary | Detailed Yes Provides breakout of Net Sales calculation; total tax
received, total tax credits, net non-fuel sales and
summary of the total voids, transaction cancels, no
sales and average sale calculation
Tendering Summary/Det | Yes This section reports on the totals for each tender type.
ailed Detail print option is generally used in Cashier reports
with Summary print on Shift and Day reports
Totalizer Pump Totalizers Summary/Det | Yes Provides a snapshot of the pump totalizers
ailed
User Time Tracking User Time Tracking | Detailed Provides detail of Employee and Contractor time

tracking

Several reports contain the Grade Product Report Component within them. This component is programmable
for different levels of detail within the report. The following reports are examples of the Grade Product Detail if
Detail is selected and Fuel Products if Summary is selected.

21.3.1 Grade Product Report Component

Several reports contain the Grade Product Report Component within them. This component is programmable
for different levels of detail within the report. The following reports are examples of the Grade Product Detail if
Detail is selected and Fuel Products if Summary is selected.
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21.3.2 Detail Level - Detailed

WAYNE
AUSTIN, TX
ID #: 1234567

Cashier Report # 143

Cashier  : John Smith

Terminal :2

Start Time: Wed Oct 31 13:22:46 2001

End Time :Wed Oct 31 13:23:04 2001
Report Taker  : John Smith

GRADE PRODUCT DETAIL
FUEL PRICE TABLE

Grade SvcLvl Tier Price TimeStamp
Supreme Self Day 1.3 08-01-00
17:52
Supreme Self Night 1.3 08-01-00
17:52
Supreme Full Day 1.3 08-01-00
17:52
Supreme Full Night 1.3 08-01-00
17:52

Plus Unlead Self Day 1.3 08-01-00
17:52
Plus Unlead Self Night 1.3 08-01-00
17:52
Plus Unlead Full Day 1.3 08-01-00
17:52
Plus Unlead Full Night 1.3 08-01-00
17:52

Unleaded Self Day 1.3 08-01-00

17:52
Unleaded Self Night 1.3  08-01-00
17:52
Unleaded Full Day 1.3 08-01-00
17:52
Unleaded Full Night 1.3 08-01-00
17:52
Diesel Self Day 1.3 08-01-00
17:52
Diesel Self Night 1.3  08-01-00
17:52
Diesel Full Day 1.3 08-01-00
17:52
Diesel Full Night 1.3 08-01-00
17:52
PER PUMP FUEL TOTALS
Grade Volume Amount

PER PUMP FUEL TOTALS

Grade Volume Amount
Pump 1 (Self)
TOTAL 0.000 0.00
Pump 2 (Self)
TOTAL 0.000 0.00
Pump 3 (Self)
TOTAL 0.000 0.00
Pump 4 (Self)
TOTAL 0.000 0.00
Pump 5 (Self)
TOTAL 0.000 0.00
Pump 6 (Self)
TOTAL 0.000 0.00
Pump 7 (Self)
TOTAL 0.000 0.00
Pump 8 (Self)
TOTAL 0.000 0.00
GRAND TOTAL ALL PUMPS
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded 0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00
PUMP TIER FUEL TOTALS
Grade Volume Amount
Day
TOTAL 0.000 0.00
Night
TOTAL 0.000 0.00
GRAND TOTAL ALL TIERS
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded 0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00
PER GRADE FUEL TOTALS
Grade Volume Amount
Indoor
TOTAL 0.000 0.00
Outdoor
TOTAL 0.000 0.00
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GRAND TOTAL ALL - INDOOR/OUTDOOR
Supreme 0.000 0% 0.00

Plus Unlead 0.000 0% 0.00

Unleaded 0.000 0% 0.00

Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

PER SERVICE LEVEL FUEL TOTALS

Grade Volume Amount
Self

TOTAL 0.000 0.00
Full

TOTAL 0.000 0.00

GRAND TOTAL ALL SERVICE LEVELS
Supreme 0.000 0% 0.00

Plus Unlead 0.000 0% 0.00

Unleaded 0.000 0% 0.00

Diesel 0.000 0% 0.00
TOTAL 0.000 0.00
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21.3.3 Detail Level - Pump Detail

WAYNE
AUSTIN, TX
ID #: 1234567

Cashier Report # 143

Cashier : John Smith

Terminal :2

Start Time: Wed Oct 31 13:22:46 2001

End Time :Wed Oct 31 13:23:04 2001
Report Taker  : John Smith

GRADE PRODUCT DETAIL
FUEL PRICE TABLE

Grade SvcLvl Tier Price TimeStamp
Supreme Self Day 1.3 08-01-00
17:52
Supreme Self Night 1.3 08-01-00
17:52
Supreme Full Day 1.3 08-01-00
17:52
Supreme Full Night 1.3 08-01-00
17:52

Plus Unlead Self Day 1.3 08-01-00
17:52
Plus Unlead Self Night 1.3 08-01-00
17:52
Plus Unlead Full Day 1.3 08-01-00
17:52
Plus Unlead Full Night 1.3 08-01-00
17:52

Unleaded Self Day 1.3 08-01-00

17:52
Unleaded Self Night 1.3  08-01-00
17:52
Unleaded Full Day 1.3 08-01-00
17:52
Unleaded Full Night 1.3 08-01-00
17:52
Diesel Self Day 1.3 08-01-00
17:52
Diesel Self Night 1.3 08-01-00
17:52
Diesel Full Day 1.3 08-01-00
17:52
Diesel Full Night 1.3 08-01-00
17:52
PER PUMP FUEL TOTALS
Grade Volume Amount

Grade
Pump 1 (Self)
TOTAL

Pump 2 (Self)
TOTAL

Pump 3 (Self)
TOTAL

Pump 4 (Self)
TOTAL

Pump 5 (Self)
TOTAL

Pump 6 (Self)
TOTAL

Pump 7 (Self)
TOTAL

Pump 8 (Self)
TOTAL

Supreme
Plus Unlead
Unleaded
Diesel
TOTAL

PER PUMP FUEL TOTALS

GRAND TOTAL ALL PUMPS

Volume Amount
0.000 0.00
0.000 0.00
0.000 0.00
0.000 0.00
0.000 0.00
0.000 0.00
0.000 0.00
0.000 0.00

0.000 0% 0.00
0.000 0% 0.00
0.000 0% 0.00
0.000 0% 0.00
0.000 0.00
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21.3.4 Detail Level - Tier Detail

Cashier
Terminal

Grade
Supreme

Supreme
Supreme

Supreme

Plus Unlead
Plus Unlead
Plus Unlead

Plus Unlead

Unleaded
Unleaded
Unleaded

Unleaded

Diesel
Diesel
Diesel

Diesel

Grade

Report Taker

WAYNE
AUSTIN, TX
ID #: 1234567

Cashier Report # 143

: John Smith
12

Start Time: Wed Oct 31 13:22:46 2001

GRADE PRODUCT DETAIL
FUEL PRICE TABLE

End Time :Wed Oct 31 13:23:04 2001

: John Smith

SvcLvl Tier Price TimeStamp

PER TIER FUEL TOTALS

Self Day 1.3 08-01-00
17:52

Self Night 1.3 08-01-00
17:52

Full Day 1.3 08-01-00
17:52

Full Night 1.3 08-01-00
17:52

Self Day 1.3 08-01-00
17:52

Self Night 1.3 08-01-00
17:52

Full Day 1.3 08-01-00
17:52

Full Night 1.3 08-01-00
17:52

Self Day 1.3 08-01-00
17:52

Self Night 1.3 08-01-00
17:52

Full Day 1.3 08-01-00
17:52

Full Night 1.3 08-01-00
17:52

Self Day 1.3 08-01-00
17:52

Self Night 1.3  08-01-00
17:52

Full Day 1.3 08-01-00
17:52

Full Night 1.3 08-01-00
17:52

Volume Amount

PER TIER FUEL TOTALS

Day
Supreme 0.000
Plus Unlead 0.000
Unleaded  0.000

Diesel 0.000
TOTAL 0.000
Night

Supreme 0.000
Plus Unlead 0.000
Unleaded  0.000
Diesel 0.000

TOTAL 0.000

GRAND TOTAL ALL TIERS
Supreme 0.000
Plus Unlead 0.000
Unleaded  0.000
Diesel 0.000

TOTAL 0.000

Grade Volume

0%
0%
0%
0%

0%
0%
0%
0%

0%
0%
0%
0%

Amount

0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
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21.3.5 Detail Level - Grade Detail

PER GRADE FUEL TOTALS
Grade Volume Amount
WAYNE
Indoor
Supreme 0.000 0% 0.00
AUSTIN, - TX Plus Unlead 0.000 0% 0.00
ID ##: 1234567 Unleaded 0000 0%  0.00
. Diesel 0.000 0% 0.00
Cashier Report # 143 TOTAL 0.000 0.00
Cashier : John Smith
Termin_al 12 Outdoor
Start Time: Wed Oct 31 13:22:46 2001 Supreme 0.000 0% 0.00
. Plus Unlead 0.000 0% 0.00
End Time :Wed Oct 31 13:23:04 2001 Unleaded  0.000 0% 0.00
. Diesel 0.000 0% 0.00
Report Taker  : John Smith TOTAL 0.000 0.00
GRADE PRODUCT DETAIL
FUELPRICETABLE GRAND TOTAL ALL INDOOR/OUTDOOR
Grade SvcLvl Tier Price TimeStamp Supreme 0.000 0% 0.00
Supreme Self Day 1.3 08-01-00 PlusUnlead  0.000 0%  0.00
, 17:52 Unleaded 0000 0%  0.00
Supreme Self Night 1.3 08-01-00 Diesel 0.000 0% 0.00
17:52 TOTAL 0.000 0.00
Supreme Full Day 1.3 08-01-00
. 17:52 PER SERVICE LEVEL FUEL TOTALS
Supreme Full Night 1.3 08-01-00 Grade Volume Amount
17:52
Self
Supreme 0.000 0% 0.00
Plus Unlead Self Day 1.3 08-01-00 Plus Unlead 0.000 0% 0.00
' 17:52 Unleaded 0.000 0%  0.00
Plus Unlead Self Night 1.3 08-01-00 Diesel 0.000 0% 0.00
17:52 TOTAL 0.000 0.00
Plus Unlead Full Day 1.3 08-01-00
. 17:52 Full
Plus Unlead Full Night 1.3 08-01-00 Supreme 0.000 0% 0.00
17:52 PlusUnlead 0000 0%  0.00
Unleaded  0.000 0% 0.00
Unleaded Self Day 1.3 08-01-00 Diesel 0.000 0% 0.00
17:52 TOTAL 0.000 0.00
Unleaded Self Night 1.3  08-01-00
17:52 GRAND TOTAL ALL SERVICE LEVELS
Unleaded Full Day 1.3 08-01-00 Supreme 0.000 0% 0.00
, 17:52 PlusUnlead 0000 0%  0.00
Unleaded Full Night 1.3 08-01-00 Unleaded  0.000 0% 0.00
17:52 Diesel 0000 0%  0.00
TOTAL 0.000 0.00
Diesel Self Day 1.3 08-01-00
17:52
Diesel Self Night 1.3 08-01-00
17:52
Diesel Full Day 1.3 08-01-00
17:52
Diesel Full Night 1.3 08-01-00
17:52
PER GRADE FUEL TOTALS
Grade Volume Amount
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21.3.6 Detail Level - Pump Tier Detail

Cashier
Terminal

Report Taker

WAYNE
AUSTIN, TX
ID #: 1234567

Cashier Report # 143

: John Smith
12

Start Time: Wed Oct 31 13:22:46 2001

End Time :Wed Oct 31 13:23:04 2001

: John Smith

GRADE PRODUCT DETAIL
FUEL PRICE TABLE

Grade SvcLvl Tier Price TimeStamp
Supreme Self Day 1.3 08-01-00
17:52
Supreme Self Night 1.3 08-01-00
17:52
Supreme Full Day 1.3 08-01-00
17:52
Supreme Full Night 1.3 08-01-00
17:52
Plus Unlead Self Day 1.3 08-01-00
17:52
Plus Unlead Self Night 1.3 08-01-00
17:52
Plus Unlead Full Day 1.3 08-01-00
17:52
Plus Unlead Full Night 1.3 08-01-00
17:52
Unleaded Self Day 1.3 08-01-00
17:52
Unleaded Self Night 1.3  08-01-00
17:52
Unleaded Full Day 1.3 08-01-00
17:52
Unleaded Full Night 1.3 08-01-00
17:52
Diesel Self Day 1.3 08-01-00
17:52
Diesel Self Night 1.3  08-01-00
17:52
Diesel Full Day 1.3 08-01-00
17:52
Diesel Full Night 1.3 08-01-00
17:52
PER PUMP FUEL TOTALS
Grade Volume Amount

PER PUMP FUEL TOTALS
Grade Volume
Pump 1 (Self)
Supreme 0.000 0%
Plus Unlead 0.000 0%

Unleaded  0.000 0%
Diesel 0.000 0%
TOTAL 0.000
Pump 2 (Self)

Supreme 0.000 0%
Plus Unlead 0.000 0%

Unleaded  0.000 0%
Diesel 0.000 0%
TOTAL 0.000

GRAND TOTAL ALL PUMPS
Supreme 0.000 0%
Plus Unlead 0.000 0%

Unleaded  0.000 0%
Diesel 0.000 0%
TOTAL 0.000

PER TIER FUEL TOTALS

Grade Volume

Day
Supreme 0.000 0%
Plus Unlead 0.000 0%

Unleaded  0.000 0%
Diesel 0.000 0%
TOTAL 0.000
Night

Supreme 0.000 0%
Plus Unlead 0.000 0%

Unleaded  0.000 0%
Diesel 0.000 0%
TOTAL 0.000

GRAND TOTAL ALL TIERS
Supreme 0.000 0%
Plus Unlead 0.000 0%

Unleaded  0.000 0%
Diesel 0.000 0%
TOTAL 0.000

Amount

0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00

Amount

0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
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21.3.7 Detail Level - Pump Grade Detail

WAYNE
AUSTIN, TX
ID #: 1234567

Cashier Report # 143

Cashier  : John Smith

Terminal :2

Start Time: Wed Oct 31 13:22:46 2001

End Time :Wed Oct 31 13:23:04 2001
Report Taker  : John Smith

GRADE PRODUCT DETAIL
FUEL PRICE TABLE

Grade SvcLvl Tier Price TimeStamp
Supreme Self Day 1.3 08-01-00
17:52
Supreme Self Night 1.3 08-01-00
17:52
Supreme Full Day 1.3 08-01-00
17:52
Supreme Full Night 1.3 08-01-00
17:52

Plus Unlead Self Day 1.3 08-01-00
17:52
Plus Unlead Self Night 1.3 08-01-00
17:52
Plus Unlead Full Day 1.3 08-01-00
17:52
Plus Unlead Full Night 1.3 08-01-00
17:52

Unleaded Self Day 1.3 08-01-00

17:52
Unleaded Self Night 1.3  08-01-00
17:52
Unleaded Full Day 1.3 08-01-00
17:52
Unleaded Full Night 1.3 08-01-00
17:52
Diesel Self Day 1.3 08-01-00
17:52
Diesel Self Night 1.3  08-01-00
17:52
Diesel Full Day 1.3 08-01-00
17:52
Diesel Full Night 1.3 08-01-00
17:52
PER PUMP FUEL TOTALS
Grade Volume Amount

PER PUMP FUEL TOTALS

Grade Volume Amount

Pump 1 (Self)
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00

Diesel 0.000 0% 0.00
TOTAL 0.000 0.00
Pump 2 (Self)

Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

GRAND TOTAL ALL PUMPS
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

PER GRADE FUEL TOTALS

Grade Volume Amount

Indoor
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00

Diesel 0.000 0% 0.00
TOTAL 0.000 0.00
Outdoor

Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

GRAND TOTAL ALL - INDOOR/OUTDOOR
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00

TOTAL 0.000 0.00

PER SERVICE LEVEL FUEL TOTALS
Grade Volume Amount
Self

Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

Full
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
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Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

GRAND TOTAL ALL SERVICE LEVELS
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00

TOTAL 0.000 0.00
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21.3.8 Detail Level - Tier Grade Detail

WAYNE
AUSTIN, TX
ID #: 1234567

Cashier Report # 143

Cashier  : John Smith

Terminal :2

Start Time: Wed Oct 31 13:22:46 2001

End Time :Wed Oct 31 13:23:04 2001
Report Taker  : John Smith

GRADE PRODUCT DETAIL
FUEL PRICE TABLE

Grade SvcLvl Tier Price TimeStamp
Supreme Self Day 1.3 08-01-00
17:52
Supreme Self Night 1.3 08-01-00
17:52
Supreme Full Day 1.3 08-01-00
17:52
Supreme Full Night 1.3 08-01-00
17:52

Plus Unlead Self Day 1.3 08-01-00

PER TIER FUEL TOTALS

Grade Volume Amount

Day
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00

Diesel 0.000 0% 0.00
TOTAL 0.000 0.00
Night

Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

GRAND TOTAL ALL TIERS
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

PER GRADE FUEL TOTALS

Grade Volume Amount

Indoor
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00

' 17:52 Diesel 0.000 0%  0.00
Plus Unlead Self Night 1.3 08-01-00 TOTAL 0.000 0.00
17:52
Plus Unlead Full Day 1.3 08l—Ol—OO Outdoor
_ 17:52 Supreme  0.000 0% 0.0
Plus Unlead Full Night 1.3 O?—Ol—OO Plus Unlead 0.000 0% 0.00
17:52 Unleaded  0.000 0%  0.00
Diesel 0.000 0%  0.00
Unleaded Self Day 1.3 08-01-00 TOTAL 0.000 0.00
17:52
Unleaded  Self Night 1.3~ 08-01-00 GRAND TOTAL ALL - INDOOR/OUTDOOR
17:52 Supreme  0.000 0% 0.0
Unleaded Full Day 1.3 08_0.1_00 Plus Unlead 0.000 0% 0.00
_ 17:52 Unleaded 0.000 0%  0.00
Unleaded Full Night 1.3 08—91—00 Diesel 0.000 0% 0.00
17:52 TOTAL 0.000 0.00
Diesel Self Day 13 08'91'00 PER SEFVICE LEVEL FUEL TOTALS
. . 17:52 Grade Volume Amount
Diesel Self Night 1.3  08-01-00 Self
_ 17:52 Supreme  0.000 0%  0.00
Diesel Full Day 1.3 0801-00 PlusUnlead 0000 0%  0.00
_ _ 17:52 Unleaded 0.000 0%  0.00
Diesel Full Night 1.3 08-91—00 Diesel 0000 0%  0.00
17:52 TOTAL 0.000 0.00
PER TIER FUEL TOTALS Eull
Grade Volume Amount Supreme 0.000 0% 0.00
PlusUnlead  0.000 0%  0.00
204

Part No. 2-920494 Rev. G

August 2008



Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

GRAND TOTAL ALL SERVICE LEVELS
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded  0.000 0% 0.00
Diesel 0.000 0% 0.00

TOTAL 0.000 0.00
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21.3.9 Detail Level - Summary

WAYNE
AUSTIN, TX
ID #: 1234567

Cashier Report # 143

Cashier  : John Smith

Terminal :2

Start Time: Wed Oct 31 13:22:46 2001

End Time :Wed Oct 31 13:23:04 2001
Report Taker  : John Smith

FUEL PRODUCTS

Description Price  Volume Total
Supreme 1.299 1.130 1.47
Plus Unlead 1.259 0.968 1.22
Unleaded 1.089 1.200 1.30
Diesel 1.159 0.000 0.00

PER GRADE FUEL TOTALS

Grade Volume Amount

Indoor
Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded 0.000 0% 0.00

Diesel 0.000 0% 0.00
TOTAL 0.000 0.00
Outdoor

Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded 0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

PER SERVICE LEVEL FUEL TOTALS
Grade Volume Amount
Self

Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded 0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

Full

Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded 0.000 0% 0.00
Diesel 0.000 0% 0.00
TOTAL 0.000 0.00

PER TIER FUEL TOTALS

Grade Volume Amount
Day

Supreme 0.000 0% 0.00
Plus Unlead 0.000 0% 0.00
Unleaded 0.000 0% 0.00

Diesel 0.000
TOTAL 0.000
Night

Supreme 0.000
Plus Unlead 0.000
Unleaded 0.000
Diesel 0.000
TOTAL 0.000

0%

0%
0%
0%

0%

0.00
0.00

0.00
0.00
0.00

0.00
0.00
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21.4 Variable Tracking

Variable Tracking programming is used to assign certain products to be tracked on specific reports. From the
Programming Access window select Reports > Setup > Variable Tracking. See Figure 21-6 below.

Yariable Tracking

Department Cashier| Day Shift - Product Cashier| Day Shift -
|3 ez |Yes Yes p |AMTI FREEZE Yes Yes
Bagel ez |Yes es FILL & TOSS ez |Yes es
Bakery Pkg. ez |Yes es GAL wWaSH FLD ez |Yes es
BH/Can Dep. Yes  |Yes es TRAMS FLUID Yes  |Yes es
Candy ez |Yes es Wi COMCEN ez |Yes Yes
Car'wash es  |ves  [Yes
CASH CARDS es  |ves  [Yes
CHILDRENS es  |ves  [Yes
Cigarettes ez  |Yes es
ChdM es  |ves  [Yes
Call. Cards es  |ves  [Yes
Conv. Oven es  |ves  [Yes j j
Mazz Changes
Report Type Target Track
oA i All Departments i Yes
-
o All Dry Products " Mo

~

¢ All Dry Products of Current Department

Apply

~

Figure 21-6 Variable Tracking Window

The Variable Tracking window is used to set/clear the Cashier, Shift, and Day tracking flags for Products and
Departments. The Product field displays the dry products of the department selected in the Department field.
The entries in the current department and product can be toggled individually within the field. Mass changes
can be made using the Apply button.

e Individual Entries - The 3 columns (Cashier, Day, and Shift) of the Department and Product grids can be
toggled individually.
1. Highlight the Department that the products belong to. A list of all the products belonging to that
department will appear on the right side of the screen.
2. Highlight the Product for which you want to turn tracking off.

3. Double click on the Cashier, Shift, or Day column for that product to toggle between Yes and No. The
user can also type Yes or No in the field. These columns are the only ones in the grid that can be
modified.

4. Repeat steps 2 and 3 as many times as necessary.
5. You can repeat steps 1 through 4 for other departments.

When you are done press the Close button. Do not press the Apply key for Individual Entries. The
Apply key is used only for Mass Changes, so pressing it might undo everything you just finished
doing above.

e Mass Changes - The controls on the bottom half of the window are used to perform mass changes to
Departments and Products.

e Report Type - This section allows the user to select which combination of changes will be affected by the
mass update. If All is selected then the other values (Cashier, Day, and Shift) are not selectable. If All is not
selected then the user can select any combination of Cashier, Day, and Shift.
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e Target - This section determines which records are affected. Either all the departments, all the products, or
all the products of the current department.

e Track - This feature enables you to track or not to track on the report.
e Apply - The Apply button is used to make the mass update take place.
e Close - Select Close to apply changes and exit this window.

Refer to the following figures for examples of how a report with variable tracking will appear when it is printed
at the end of a cycle. Figure 21-7 shows an example of a cashier report with variable tracking.

NOTE:For Variable Tracking to take effect, you must have the component (Department and/or Dry Product)
assigned to the report (Cashier, Shift, Day).

NOTE: You must take an End of Day for any component or Report Tracking changes to take effect.
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Figure 21-8 shows an example of a report without variable tracking.

Outdoor Tenderings
Drawer Total

Closing Balance
Drawer Amount matches

A/R Sales

Total Tenderings
Indoor Tenderings
Outdoor Tenderings
Drawer Total

Closing Balance
Drawer Amount matches

NET Drawer Total
NET Closing Balance
NET Short Amount in D

GROUPS
Description
Fuel
Beverages
Coupon
Fountain
Gen. Mdse.
Inst Cash
Manual Fuel
Motor Oil
Other Income
Prepay Fuel
Snacks
Tobacco
Unknown

DEPARTMENTS
Description

NON-FUEL PRODUCTS

Description Price
Basic Wash 2.00
Deluxe Wash 3.00
Gen Cigs 2.25
Marlboro 3.35
Merit 3.35
The Works 4.00

No Financial Items
in this reporting per

FUEL PRODUCTS

[eNoNe]

rawer

Qty
247.651
40

0

24

20

0

0

11

Qty

Qty

RPRRRPRRPE

iod.

“Department” Component included on Cashier Report
but no departments tracked via Variable Tracking.

“Dry Product” Component included on Cashier Report

4.00

and only Car Washes and Tobacco Products are tracked
via Variable Tracking.

Figure 21-7 Cashier Report with Variable Tracking
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Outdoor Tenderings 0 0.00
Drawer Total 0.00
Closing Balance 0.00
Drawer Amount matches
A/R Sales
Total Tenderings 0 0.00
Indoor Tenderings 0 0.00
Outdoor Tenderings 0 0.00
Drawer Total 0.00
Closing Balance 0.00
Drawer Amount matches
NET Drawer Total 151.48
NET Closing Balance 100.00
NET Short Amount in Drawer 51.48
GROUPS
Description Qty Total
Fuel 247 .651 297.33
Beverages 40 78.66
Coupon 0 0.00
Fountain 24 50.76
Gen. Mdse. 20 75.75
Inst Cash 0 0.00
Manual Fuel 0 0.00
Motor Oil 11 56.26
Other Income 6 18.00
Prepay Fuel 0 0.00
Snacks 35 35.95
Tobacco 6 13.20
Unknown 0 0.00
“Department” Component not included on Cashier Report
< and all departments tracked via Variable Tracking.
Nothing reports.
No Financial Items
in this reporting period. “Dry Product” Component not included on Cashier Report
and all products tracked via Variable Tracking. Nothing
reports.
FUEL PRODUCTS o ) ) )
Description Price Volume Total No indication of variable tracking appears on the Cashier
SuprPlus 1.259 26.214 33.00 Report if the Component is removed from the Report.
Regular 1.089 111.032 120.91
Supreme 1.299 110.405 143 .42
Diesel 1.159 0.000 0.00
PER GRADE FUEL TOTALS
Grade Volume Amount
Indoor
Super Unl 26.214 33.00
Special Unl 111.032 120.91
Regular Unl 110.405 143.42

Figure 21-8 Cashier Report without Variable Tracking

21.5 PTD Configuration

PTD Configuration programming is used to tell the system when or if to print the Period To Date report. From
the Programming Access window select Reports > Setup > PTD Configuration.

NOTE:The user must logoff, a Shutdown must be performed, and the system restarted for the changes in the
programming to take full effect. For additional information on performing a shutdown and restart, see the
Countertop Reference manual (Part No. 8-920494) or Section 2 of the Operations Manual (Part No. 1-920494).
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Period To Date Configuration

Frint Report
" Weekly

™ Semi-Monthly

" Manthly

Ok | Lancel |

Figure 21-9 Period To Date Configuration Window

e To program the report printing features, select from Weekly, Bi-weekly, Monthly, or Manually. See the table
below for an explanation of options.

211
August 2008 Part No. 2-920494 Rev. G




Table 21-10 Period-to-Date Report Programming

Programming Option Print Queue
Manually On Demand Initiate via Reports | Period To Date
Weekly - First Day of the Week = Sunday

- If programmed on Wednesday,
March 8, 2003, the first Weekly
PTD Report would auto print
after the EOD Report is gener-
ated on Sunday, March 12, 2003

- 15U PTD Period

-2 PTD Period

- Subsequent periods - March 8 — March 14, or 4 days

- March 13 — March 19, or 7 days

- Each 7 day period thereafter until
changed otherwise

Bi-weekly (every fourteen days or | First half of the Month = 1% thru 15th
semi-monthly)
Report would auto print along with

the EOD Report on the 15

Second half of the Month = 16! thru
end of month

Report would auto print along with

the EOD Report on the 1%t
Monthly Report would auto print along with | Report totals based on when the
the EOD Report on the 15! of the programming was implemented
month.

Contains data collected for the entire
month.

NOTE:In order to generate the Period-to-Date report and to activate any changes made to the programming,
you must take an End-of-Day report.

e Select OK to save and exit or choose Cancel to exit without saving.

21.6 Terminal Z

Use the Terminal Z setting to program Nucleus whether or not to print the Terminal Report at the close of a Day
or Shift. To access Terminal Z, select Reports > Setup > Terminal Z from the Programming Access window.
See Figure 21-11.
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Terminal £ Configuration

Cloze Terminal £ Report

™ Auto Cloge \With Day

" Auto Cloze With Shift

Ok | Lancel |

Figure 21-11 Terminal Z Window

e Auto Close with Day - Instructs the system to close the Terminal Report at the close of a Day. To have the
system print the report at the close of day then the Auto Print option must be set to “Yes” in Reports >
Setup > Components.

e Auto Close with Shift - Instructs the system to close the Terminal Report at the close of a Shift. To have
the system print the report at the close of shift then the Auto Print option must be set to “Yes” in Reports >
Setup > Components.

e No Auto Close - Instructs the system not to close the Terminal Report at Close Shift or Close Day.

21.7 Full-Serve Attendant

The Full-Serve Attendant Report can be programmed to automatically close at End of Day or End of Shift if
desired. If auto close is enabled the system will close any Full Serve Attendant reports that are currently
running. Be sure that all outdoor attendants have signed off of all outdoor terminals prior to End of Day or End
of Shift for the auto close function to work. To access Full-Serve Attendant Report setup, select Reports >
Setup > Full-Serve Attendant from the Programming Access window. See Figure 21-12.

Full-Serve Attendant Reports Configur...

Cloze Full-Serve Attendant Reports

™ Auto Cloge \With Day

" Auto Cloze With Shift

Ok | Lancel |

Figure 21-12 Full-Serve Attendant Report Window

e Auto Close with Day - Instructs the system to close the Full-Serve Attendant Report at the close of a Day.
To have the system print the report at the close of day then the Auto Print option must be set to “Yes” in
Reports > Setup > Components.

e Auto Close with Shift - Instructs the system to close the Full-Serve Attendant at the close of a Shift. To
have the system print the report at the close of shift then the Auto Print option must be set to “Yes” in
Reports > Setup > Components.

e No Auto Close - Instructs the system not to close the Full-Serve Attendant at Close Shift or Close Day.
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21.8 Pump Totalizers Report Configuration

Nucleus now supports automatic electronic meter readings each time the fuel price is changed. This is to
ensure the correct fuel inventory valuation. Go to Programming > Reports > Setup > Pump Totalizers and
enable Auto Close With Price Change to turn the feature on or off. If the feature is turned on, a pump totalizer
report will be generated every time a fuel price change is requested from Nucleus programming, NAXML
Interface, or the NLink/PDI Interface. The current Pump Totalizer report will be changed so that it is archived
when closed so that it will be available for later viewing through the Programming > Reports > Archived
menu. Changes to fuel prices because of a fuel discount will not generate a pump totalizer report. If the report
is set to Auto Print the report will be sent to the report printer and archived. If the report is set to not Auto Print
it will be archived but not printed.

Figure 21-13 Pump Totalizer Report Configuration Window

Pump Totalizer, Re port Configuration

Close Pump Totalizer Report

" Auto Claze With Price Change

* Mo Auto Close

LCance

This feature can be enabled by selecting Auto Close With Price Change or turned off by selecting No Auto

See Figure 21-14 for an example of an automatically generated Pump Totalizer report.

Close.
Tom's Gas N Go
3814 Jarrett Way
Austin, TX
ID #: 00001100
Totalizer Report # 1
Start Time: Tue Nov 01 03:17:23 2005
PUMP TOTALIZERS
Grade Volume
Pump 1
Midgrade 253532.910
Unleaded 415527.830
Super 756735.550
Pump 2
TOTAL 0.000
Pump 3
TOTAL 0.000
Pump 4
TOTAL 0.000
Totals
Midgrade 253532.910
Unleaded 415527.830
Super 756735.550
TOTAL 1425796.290

/

Amount

861451

910233.
960264 .

861451.
910233.
960264 .
2731949.

.37

.00

.00

.00

62
08

37
62
08
07

214

Figure 21-14 Pump Totalizer Report

|_— Start Time - Time that the reporting period begins

End Time : Wed Nov 02 02:45:24 2005 ~@—— End Time - Time that the reporting period ends
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21.9 PLU and SKU Configuration

The PLU and SKU Configuration window is used to program the system to close the PLU and SKU Reports
whenever there is an End of Day or an End of Shift processed. Select Auto Close With Day to have Nucleus
close the PLU and SKU reports whenever there is a Close Day processed. Select Auto Close With Shift to
have Nucleus close the PLU and SKU reports whenever there is a Close Shift processed. To access PLU and
SKU Configuration programming go to Programming > Reports > Setup > PLU and SKU Configuration.

PLU and SKU Configuration

Close PLU and SKU Reparts

O Auto Cloze With Day
" Auto Closs With Shift

' MaAuto Close

Figure 21-15 PLU and SKU Configuration Window
This option can be turned off by selecting No Auto Close.

21.10 Day Configuration

The Day Close Configuration window is used to program the system to close the Day Report automatically for
certain days of the week. The Auto Close Day function will perform the Close Day function at the programmed
time with no user intervention as long as the lowest numbered IPT is idle. If there is a sale in progress then
Nucleus will wait until the IPT finishes the sale before initiating the Close Day.

To access the automatic Day Close Configuration window go to Programming > Reports > Setup > Day
Configuration.

Day Close Configuration

[v Auto Cloge Day

Frequency:

Close Time: 1200000 &M =

Ok | Lancel |

Figure 21-16 Day Close Configuration Window
The feature can be set up to close the Day Report automatically according to the following schedule:
e Auto Close Day - Click to enable the Automatic Day Close feature.
e Frequency - The Frequency pull-down can be used to set the following options.
*  None - This disables Auto Close feature.
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*  Monday - Sunday - This will force the system to close the Day at the same programmed time every
day.

*  Monday - Friday - This will force the system to close the Day at the same programmed time every
weekday.

*  Saturday and Sunday - This will force the system to close the Day at the same programmed time
every Saturday and Sunday.

e Close Time - Select the time that you want the system to automatically close the day.

Click OK to save and exit or Cancel to exit without saving.
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22 NETWORK PROGRAMMING

Network programming allows you to set up the Nucleus network settings as part of the system card
processing function.

Programming Access[ 4]

File Security System Cash Register Reports B

Metwork Configuration
55IMS Configuration
Echo Test

Parameter Download
Print Parameter Table
Toggle React Flag
Stick Reading

Manual Fuel Drop
Close Batch

Figure 22-1 Programming Access Window

Network Programming

The Network window is where you enter station information into the system to identify the site on the
credit card network. From the Programming Access window select Applications > Network to
display the Network window. See .

22.1 Network Configuration Programming

The Network Options window is where you enter station information into the system to identify the
site on the network. From the Programming Access window select Network > Network
Configuration.

Network Options

Facility Card Communication Type
- 12345674
Statior: T
Mame: |F|0n Chevron
ame " Bizynchronous
Address: |‘I 234 Anywhere
(= [ = Pr——

City: {Austin Password

Country T State/Pravince: [T
. ate/Province: [Tw ;

Field Poll Cade

Country: USa A WARNING: System must be restarted for

this change to take effect.

Ok LCancel

Figure 22-2 Network Options Window
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22.2

22.3

218

Station - Enter the 8-digit station ID that was obtained from the Chevron Retail Technology
Support Center (RTSC) 1-800-435-7277.

Name - Enter the station Name

Address - Enter the station Address

City - Enter the City

State - Enter the State

Country - Select the Country from the pull-down, either USA or Canada

TCP/IP - Enables TCP/IP communication protocol

Bisynchronous - Enables Bisynchronous communication protocol

TCP/IP Password - Enter the TCP/IP password whenever the TCP/IP protocol is selected

Poll Code - Enter the Poll Code as a capital letter whenever the Bisynchronous protocol is
selected

SSIMS Configuration Programming

From the SSIMS configuration window you can choose the Send Hourly Fuel Sales flag and the
Rent data flag. From the Programming Access window select Network > SSIMS Configuration.

SSIMS Configuration

WARMING: System must be restarted for
these changes to take effect.

Ok | Lancel |

Figure 22-3 SSIMS Configuration Window

Send Hourly Fuel Sales - Use the SSIMS configuration window to activate the Send Hourly
Fuel Sales option which sends the site’s hourly fuel sales to the Chevron host.

Send Rent Data - The Send Rent Data flag controls whether or not the system sends sales data

to the Chevron host.
Enable Trickle Data - Set this option to enable the network Trickle Data option.

Echo Test

Select Echo Test from the Network pull-down to test communications from the Nucleus system to
the host. The following window will be displayed following a successful Echo Test.

Echo Test g|

Passed echao test

Figure 22-4 Echo Test Passed Window
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22.4 Parameter Download

The Parameter Download selection is used to download a new credit card parameter table from the
Chevron host. This selection should only be used by a service technician or as advised by the
Chevron Retail Technology Support Center (RTSC) 1-800-435-7277.

22.5 Print Parameter Table

The Print Parameter Table selection is used to print the parameter table which is downloaded from
the Chevron Host. This selection should only be used by a service technician or as advised by the
Chevron Help Desk.

22.6 Toggle REACT Flag Programming

The Toggle React Flag window is where the react flag can be turned on or off. From the
Programming Access window select Network > Toggle React Flag.

e Each time the Toggle React Flag option is selected the system will toggle the flag from on to off
or from off to on. When the screen shows Toggle react flag on it means that the flag is currently
on.

e Toggle the react flag to on to have the system communicate with the Chevron host. See
Figure 22-5.

Toggle React Flag @

Toggle react flag on

Figure 22-5 Toggle REACT Flag On Window

e Toggle the react flag off to stop communication to the Chevron host. See Figure 22-6.

Toggle React Flag @

Toggle react flag off

Figure 22-6 Toggle REACT Flag Off Window
e Select OK to exit.

22.7 Stick Reading Programming

From the Stick Reading Capture window you can enter the volume tank stick readings. From the
Programming Access window select Network > Stick Reading.

NOTE: Stick Reading programming should be used for sites that do not have a Tank Gauge system
installed.
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Stick Reading Entry

Last Stick Readings:

Time [HH: k]

Description
Tark 1
Tank 2
Tank 3
Unuzed
Unuzed
Unuzed
Unuzed

Unuzed

Date (MM-DD -]

E ]2 [
5 ifoo

Stick Reading [Yolume]

|7594

|4153

|3606

Lancel |

Figure 22-7 Stick Reading Capture Window

Use the Stick Reading Capture window to enter the volume stick readings for each tank and the date
and time the readings were taken. Enter the stick readings by typing the data into the fields shown in
Figure 22-7. After you select OK, you will be asked if you want to send the stick readings to the

Chevron host.

22.8 Manual Fuel Drop

From the Manual Fuel Drop window you can enter the amount of a fuel drop that has been made at
the site for each of the fuel grades and the time and date of the drop. From the Programming Access
window select Network > Manual Fuel Drop.

NOTE:Manual Fuel Drop programming should be used for sites that do not have a Tank Gauge

system installed.
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Manual Fuel Drop Entry;

Last Fuel Drap:
Date MM-DDYYE B - [13 - [2004
Tirne [HH:M]: | & |
Drescription Grade Fuel Drop [Volume)]
Tark 1 | |D
Tank 2 | |E|
Tark 3 | |D
Unused | |
Unused | |
Unused | |
Unused | |
Unused | |
Ok | Lancel |

Figure 22-8 Manual Fuel Drop Window

Use the Manual Fuel Drop Entry window to enter the fuel drop volume readings for each tank and
the date and time the drop was made. Enter the fuel drop amounts by typing the data into the fields
shown in Figure 22-8. Select OK to save the entry or Cancel to exit without saving.

22.9 Close Batch

From the Close Batch window you can close the electronic credit card batch and send to the host.
From the Programming Access window select Network > Close Batch. A confirmation message
will be sent from the host to verify that the batch has been successfully closed.
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23 CARWASH PROGRAMMING OVERVIEW

The following instructions are meant as a programming aid for setting up Nucleus to sell car washes.

23.1 Introduction

1. First, you need to know:

*  How many Car Wash types are you going to sell? (Not including discounted Car Washes)

*  What are the Names of the Car Washes? (Example: Express, Deluxe, Works)

*  What is the full selling price for each Car Wash?

*  Are you going to offer a discount if a qualifier is met? (Example: If someone buys 8 gallons of Fuel

gets $1.00 off a car wash)

NOTE:If you are going to discount a Car Wash then you will need to know the following:

m What needs to be bought to qualify for the discount.

] How much of a discount you will offer once the qualifier is met.

2. If a Car Wash controller is going to be connected to the Nucleus system it needs to be a controller that
has been certified to work with the Nucleus POS such as one of the following models:

Ryko llI Ryko IV Unitec

The Car Wash controller needs to be programmed as follows:

Baud Rate 19200
Bits 8

Stop Bit 1

Parity No
XON/XOFF Yes
Alt POS Yes

3. The part numbers for the cables that will connect the Car Wash controller to the Nucleus system are as

follows:

Ryko Il Part #883664-002 = 25 Ft. Cable
Part #883664-004 = 50 Ft. Cable
Part #883664-007 = 100 Ft. Cable
Part #883664-009 = 150 Ft. Cable

Ryko IV Part #884156-025 = 25 Ft. Cable
Part #884156-050 = 50 Ft. Cable
Part #884156-100 = 100 Ft. Cable
Part #884156-150 = 150 Ft. Cable

Unitec Part #884096-025 = 25 Ft. Cable
Part #884096-050 = 50 Ft. Cable
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Part #884096-100 = 100 Ft. Cable
Part #884096-150 = 150 Ft. Cable

You will need to verify the programming on the Car Wash Controller. You must have a button programmed
for each Car Wash you will be selling and this information needs to match what is going to be programmed
in Nucleus.

Example: If button #1 on the controller is programmed as a Express Wash. Then Car Wash #1 in Nucleus
will also be programmed to Express Wash. If button #2 on the controller is programmed as a Deluxe Wash
then Car Wash #2 in Nucleus will also be programmed to Deluxe Wash. If button #3 on the controller is
programmed as a The Works Wash then Car Wash #3 in Nucleus will also be programmed to The Works
Wash.

23.2 Programming

Nucleus Car Wash programming is now done in three steps.

1. Car Wash Modify (Setting up different Car Wash types)

Nucleus will allow up to twelve (12) different Car Wash types. Do not include any discounted Car Washes.
This will include the following information:

e Car Wash Name (up to twelve (12) characters)

e The full purchased price of the Car Wash

e Controller Code (If programmed to Fixed Code in Site Setup)

e PLU number

e Restrictions (which tender types will be allowed and if any sales tax is required)

e Department assignment (which department the sales will be record in)

e The Host Product Code for network purposes

Note: The Car Washes programmed in Modify must be in the same order as on the Car Wash Controller if
there is a controller connected.

2. Car Wash Site Setup

This is where you program the following information:

e If you have connected a Car Wash controller

e The number of days the Car Wash will expire to print on the sales receipt
e Car Wash prompting Time-outs

e If there is a Unitec or Ryko Car Wash Terminal (CWT) installed at the Car Wash
e If you want to sell Car Washes at the outdoor terminals (CATSs)

3. Discount Offerings

This is when you will program any discounts for the Car Wash:

e Need to know if a qualifier is needed before discounting the Car Wash

e What the qualifier is going to be (8 gallons of fuel)

e How much of a discount the customer will get when the qualifier is met
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23.3 Car Wash Modify

How to get to this programming screen:
Press Nucleus button > Programming > Cash Mame: e |1
Register > Non-Fuel > Car Wash. Highlight Car Wash | g0 e
#01then Press the Modify button. - )
Y [+1.00 Each K
Name:
— Bestrictions

Controller Code:

[~ Use Dept Security Level I1111

[~ UseDept Tax

Enter the name that will identify the car wash

NOTE:The name can be a maximum of 12 characters.

Num—ber: [~ Use Dept Tender Restrictions b\

This enables you to change the car wash prompting D=, | Department:

sequence. |Carwash =]
NOTE:This option is not active at this time. Host Codle

Pricing: | Car Wash =
Full purchase price of the selected Car Wash before ol {E=E

any discounts are applied. e | Cancel |

Codes:

PLU: The number the cashier will enter on the IPT to |
sell the Car Wash Controller Code: A number that will identify the Car Wash type if the controller type is
programmed to Fixed Code.

Restrictions:

Use Dept Security Level. This will use the departments security level Use Dept Tax This will use the
departments sales tax programming Use Dept Tender Restrictions This will use the departments
programmed tender restrictions Override: Allows you to enable sales tax, set security levels and program
allowable tender types for just this Car Wash.

NOTE:Suggest using the Use Dept. If something has to be modified like taxes you will have only one
place to change it.

Department:

Select from the pick list the name of the department, that you want the car wash sales recorded.
Host Code:

Select the correct Host Product Code.

Enable:

Must be checked to activate the car wash.

NOTE:Need to modify additional Car Washes as needed Example: If you have three (3) Car Wash Types,
modify Car Wash #1, #2 and #3.
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23.4 Car Wash - Site Setup

Car Wash Site Setup k

How to get to this programming

Controller Type Car%ash Code Expires——— — Car'Wash Timeouts [in seconds)
screen: .
" Never Expies Car 'wazh Wanted Prompt I 5
Press Nucleus button >
) ) @+ Expitesin m days Message to Custamer | 2
Programming > Cash Register > :
2-Line Select Car Wash Pazs 1 I 45
Non-Fuel > Car Wash. Press the i Solect Cor Wach Pace 2
. “Line Select Car 'wash Pass |
Site Setup button. 0
4-Line Select Fram 3 Car wash
¥ Disshle Car'Wash Teminal (CwT) ine SelectFrom 3 Car Washes [ 45
Touch Screen Pass 2 300

Controller Type:

Online - There is a third party car
wash controller connected to the [ Disable Dutdoor Car'wash Sale
car wash communications port.

WARMING: System must be restarted for ANY of the ABOYE changes to take effect.

0K Cancel

Fixed Code - The system will use
the Controller Code programmed
under each individual Car Wash |
type.

None - No Car Wash controller is connected to the Nucleus system.

NOTE:If Fixed Code or None are selected there would not be a Car Wash Controller connected

Car Wash Code Expires:

Never Expires - Car wash code never expires.
Expires In ## days - ## = number of days code is valid.

NOTE:Make sure that the number programmed in Car Wash Code Expires field matches the car wash
controller. Note: This expiration date is printed on the outdoor receipt when a Car Wash is purchased. It
will also print when a outdoor receipt is reprinted.

Car Wash Timeouts (In seconds)

Car Wash Wanted Prompt - Prompt asking the customer if they would like a car wash
Message To Customer - This is a text message reading "Select 1-3"

2-Line Select Car Wash Pass 1 - This is for the Text 2x16 display, the car wash prompting will make two
passes prompting the customer.

4-Line Select From 3 Car Washes - This is for the Graphics 4x21 display, up to three car washes will be
displayed at one time.

Disable Car Wash Terminal (CWT)

This allows to you turn off the Unitec or Ryko Car Wash Terminal.

NOTE:If the site does not have a Unitec or Ryko Car Wash Terminal, this option must be checked.

Disable Outdoor Car Wash Sales
This allows to you turn off Outdoor Car Wash sales
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23.5 Cash Register - Discount Offering

How to get to this programming screen: ~Bup _ it
Press Nucleus button > Programming > . oF
. . * b * Free
Cash Register > Discount - [a B B —
age . . oL 3
Classifications > Offerings Press the C e [50.00 P
ercent
Ad d bUtton ' I~ Apply Tax to Free Product
BUy I~ &uta Ring Up
P . . . Euy T B
This is the qualifier it can be either QTY or Domt——— [Dnknamm Dok e Wosh
. Fuel Dieszel Car'wash |Ewpress Wash
$$$ (dO”ar) not bOth Fuel Fiegular Unl Car'wash |Super'wash
Fuel Special Unl Car'wash |Ulirate '\Wazh
QTY - Number of Items or Gallons of Gas Fad ™ {Somer Ul Froduct 2002 Dk
i Giroup Beverages Product 320z Drink,
re_qUIre to be purChased to get the Group Coupon Product 440z Drink
d ISCOU nt. Giroup Fountain Product Almond Joy
Product ghigi

$$$ - Dollar amount that has to be
purchased to get the discount.

ok Lancel |

Offer
This allows you to choose the nature of the discount:

Free - No charge, the item is discounted 100%

Amount Off - This will use the full purchase price of the item and discount the dollar amount programmed

Percent Off - This will use the full purchase price of the item and discount the percentage amount
programmed.

Amount Box - This is the box displayed next to Amount Off.This is to enter the $$$ or percentage of the
discount.

Apply Tax to Free Product

This applies the normal tax amount if the product is Free. This is only active when Free is selected in the
Offer options.

Auto RingUp
This option allows the system to automatically ring up the offering once the qualifiers required are met.
Buy Type

This is a product classification, used to help separate and identify the items in the list. It is broken as
follows: Dept., Group, Fuel, Product and SubCatg.

Buy
This is a list of possible products. You will need to select the item to be purchased by highlighting it.

NOTE: You must use the up and down arrow keys to maneuver inside the list

Offer Type

This is a product classification, used to help separate and identify the items in the list. The list is separated
as follows: Car Wash, Combo, Group, Product and SubCatg. The Offer Type heading groups the different
offer types together to help identify them.
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Offer

This is a list of possible products to choose from. You will need to select the item to be purchased and
highlight it.

NOTE: You must use the up and down arrow keys to maneuver inside the list.
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A GLOSSARY

Amount Amount refers to a monetary amount. The currency units will depend on the
application/country.

Attendant A store employee who conducts fuel sales transactions outdoors at the pumps. If
outdoor terminals are present, the attendant is the terminal operator, and may also
perform non-fuel transactions. The attendant may or may not actually perform the
fueling.

Authorize An operation that enables a pump to dispense fuel. After a successful authorization,
no further input is necessary to the pump for dispensing (though the pump itself may
require local actions to take place, like nozzle out and push-to-start).

Bill Acceptor (BAC)  An outdoor terminal element that can accept and recognize paper currency.
Batch Batches are collections of credit and debit sales to be sent to the host.
Card Handling System

The subsystem within Nucleus that reads and interprets magnetic cards, validates
them via internal structures and card processing host communications, and sends
transaction information to the Chevron host.

Cashier A store employee who conducts sales and non-sales transactions at an indoor
terminal.

Customer Activated

Terminal (CAT) An outdoor terminal containing a card reader. Transactions can be initiated by using a
magnetic card at the terminal.

Customer Display Unit(CDU)
An indoor display unit visible to the customer, used to display sales transaction data
including item names and prices, fuel sale data, amount due, tendered, and change due

data.
De-authorize Cancellation of a pump authorization command.
Department A categorization unit for all items and services sold at a store. All line items in an ECR

transaction are attributed to exactly one department in the set of departments. Each
department has its own name and programmable characteristics.

Discount A line item in an ECR transaction representing a discount to the customer. Discounts
may apply to specific items or a sales transaction in general.

Electronic Cash

Register (ECR) The system within Nucleus responsible for conducting sales and non-sales
transactions. May be controlled by a cashier indoors or an attendant outdoors.

Expiration Date (card) A 4-digit date after which the card is no longer valid. It is embossed or printed on the
plastic card and encoded on the magnetic stripe. It is usually expressed as MMYY.

Fallback Limit If the network is unavailable and a sale is less than this amount, the card can be
authorized locally. Typically, processing is disallowed if this value is 0.

Financial Operations

Keys Keys on an indoor payment terminal used by the ECR for non-sales transactions.
Examples are safe drop, paid in, paid out, and safe loan.
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Floor Limit If a sale is less than this amount, the card can be authorized locally. No attempts are
made to contact the network for authorization. Typically, all card accounts are sent to the
host for authorization if this value is 0,

Fueling Point See Pump.
Fueling Position See Pump.

Full Service Terminal An outdoor payment terminal configured for operation by store attendants. At a full
service terminal an attendant may conduct fuel and/or non-fuel transactions.

Full-Serve See Full Service Terminal.

Grade (fuel) A categorization of fuel types available at a store. Grades may come straight from
tanks or may be generated by blending two “pure” grades. Fuels that are treated in more
than one way are also considered separate grades; e.g., filtered and un-filtered diesel
fuel.

Group A categorization unit for all items and services sold at a store. All line items in an ECR
transaction can be attributed to exactly one group in the set of groups. Each department
in the system reports to one group. Groups are a more aggregate categorization of
items. See Department.

Header A logo that is printed at the top of a customer receipt, typically used for station
identification and advertising messages.

High Amount Lockout

(HALO) An amount programmed independently for each department which puts an upper limit
on the amount of any line item attributed to that department. HALOs may also be
programmed for tendering and non-sales operations.

Host Limit If a sale is greater than this amount, a voice authorization is required. Also called a
purchase limit.

ICAT Indoor Card Authorization Terminal - The in-store unit that a customer uses to swipe a
credit card.

Inclusive Tax A type of taxation in which one tax rate must be applied to a sale prior to the

calculation of any other tax. It is used in some Canadian provinces.

Incomplete Prepay A state of a fuel operation in which the customer has begun a prepay fuel sale, but
dispensing has stopped prior to dispensing the total amount and the customer is due a
refund. See Prepay Fuel Sales.

Indoor Payment

Terminal (IPT) An industry-standard computer that acts as a cashier terminal to process transactions.
The Primary IPT acts both as a cashier terminal and as Store Controller. Other IPTs are
necessary if more than one cashier terminal is needed.

Issuer An organization in charge of distribution and billing of cards; e.g., Visa, American
Express, Maestro, etc.

Journal A printed copy of all transactions. Journals may represent single or multiple terminal
activities.

Level In the context of fuel pricing, levels represent degrees of service, which may reflect

distinctive unit pricing. Each tier in Nucleus contains four price levels: Self, Mini,
Full-Serve, and Other.

Line Item A single entry for a sales transactions. Each line item has at least a description and a
price extension associated with it. Example of line items are open department sales,
PLU sales, fuel sales, and discounts.

230
Part No. 2-920494 Rev. G August 2008




Logos Generic term used for store-specific alphanumeric text descriptions programmed into
the system. For example, header logos are programmable text lines that are printed at
the top of each receipt.

Low Amount Lockout

(LALO) An amount programmed independently for each department which puts a lower limit
on the amount of any line item attributed to that department.

Master Security

Module That part of the network host that decrypts Personal Identification Numbers upon
receiving them from Point of Sale terminals.

Mini-Serve A dispenser configuration in which an attendant performs the fueling operation and
the customer pays for the sale either at an outdoor or indoor payment terminal.

Negative Department A negative department causes the system to subtract an amount from the total of the
transaction. An example of a negative department would be bottle returns paid out
during the course of the day.

Nozzle In This is the state in which the nozzle and any slide or lever has been placed in its
resting position at a dispenser.

Nozzle The physical device on a dispenser through which the operator dispenses fuel.

Nozzle Out This is the state in which the nozzle has been removed from its resting position at a

dispenser and all slides or levers have been set to the “on” position.

Off-line A non-communicating state of a Nucleus device or peripheral. The off-line state may
be due to device problems or due to intentional programming or disconnection of the
device. See On-line.

On-line The normal and communicating state of a Nucleus device or peripheral. See Off-line.

Operator In Nucleus context, an operator is the person in control of a Nucleus payment terminal
(indoor or outdoor) or dispenser. Operators may be cashiers, attendants, or customers;
other lower frequency operators may be store vendors, tank truck drivers, and
inspectors.

Paid In An ECR non-sales transaction in which funds are transferred into the system. An
example is a customer making a payment on a store account.

Paid Out An ECR non-sales transaction in which funds are transferred out of the system. An
example is a payment to a vendor (e.g., “bread man”).

Personal Identification

Number (PIN) A 4 to 12 digit number known only to a customer for use in validating debit card
transactions.

Personal Account

Number In card processing, the number that identifies the cardholder account to the Issuer. It
is embossed or printed on the plastic card and encoded on the magnetic stripe. The
maximum length is 19 digits.

PIN Keypad Numeric keyboard used for entry of Personal Identification Numbers

Point of Sale (POS) A terminal or other device at which sales transactions can take place. For example,
indoor payment terminals and outdoor payment terminals are considered a Point of
Sale.

Postpay Fuel Sales A fueling operation in which fuel is dispensed prior to tendering the corresponding
sale.
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Pre-Authorization In card processing at indoor terminals, a method of inputting card data (usually by
card swipe) prior to the tendering phase, in order to allow time overlap between host
card authorization and the sales transaction.

Pre-Cutoff Same as Slowdown Point. A volume amount remaining to be pumped at which fuel
flow is reduced at the fueling point.

Prefix The first “N” digits of a credit card number. Typically, N ranges from 4 to 11. Note that
these first digits of a card number may or may not be embossed on the card (but always
appear on the magnetic strip).

Prepay Fuel Sales A fueling operation in which the customer tenders a deposit prior to fueling. After
fueling, the customer may be due a partial refund. See Incomplete Prepay.

Preset Key A key on an indoor payment terminal used by the ECR subsystem for allowing the
cashier to perform a one-key selection of a specific item for use as a line item in a sales
transaction.

Preset Fuel Sales A postpay fuel sale on which a volume or amount limit has been placed that is lower

than the default.

Price Lookup (PLU) A system used at a site for numeric identification of merchandise. An ECR can use
Price Lookup for determining pricing and restrictions for items.

Price Extension The total contribution of a line item to a sales transaction. For example, if a line item
represents the sale of 2 items, the price extension is 2 times the item’s unit price.

Primary Account
Number See Personal Account Number.

Pulser The unit in a dispenser responsible for measuring fuel delivery in units of pre-defined
pulses. The pulse count in US pumps is used by Nucleus along with a calibration factor
from the pump to determine the volume of fuel delivered in a fueling operation.

Pump Pump refers to an independently controllable fueling point. Two or more dispensers
may be physically housed together.

Pump Positions The possible ways in which one or more nozzles can dispense fuel. For multi-grade
dispensers, each position corresponds to a nozzle. For blending dispensers that have a
single nozzle, each position corresponds to an available blend selection.

Push to Start (PTS) A type of pump configuration and operation in which a button must be pushed on the
pump in order for fueling to commence. Used primarily with US Vista pumps.

QWERTY Keyboard In this document, a PC-compatible alphanumeric keyboard.
Security Access Levels

A system of protection that allows the system to restrict access to various
programming, reporting, and operational features depending on the access rights given
to specific personnel.

Self-Serve A dispenser configuration in which the customer himself performs the fueling
operation and pays for the sale either at an indoor or outdoor payment terminal.

Slowdown Point See Pre-Cutoff.
Stock Keeping Unit (SKU)

An inventory classification number assigned to a product for price lookup and tracking
purposes.

Subtotal The sum of all line items within a sales transaction. This includes all discounts or
service charges but not applied taxes.
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Tank A tank is an individual container for fuel to which the dispensers are connected. If
multiple tanks are plumbed together they are considered a single tank.

Tax Shift An ECR sales transaction feature in which an individual item’s taxability is altered; if
the item is normally taxable then tax is exempted for that item. If the item is not taxable,
tax is applied. Used mainly by the cashier for open department sales in which almost all
items reporting to the department are taxed (or all are not), and a non-taxed (or taxed)
item must be rung up to the department.

Tax Exempt An ECR sales transaction feature in which either individual items or the entire sale can
be excused from taxation that would normally apply.

Tax Breakpoint Table A schedule of tax amounts created by a taxing entity (usually in hard copy form), and
programmed into the ECR database. Each entry in the table has a “from” amount, a “to”
amount, and the tax amount to be applied for sales subtotals that fall within the “from”
and “to.”

Tendering The ECR sales transaction phase in which all line items have been created and
money is now received from the customer.

Tier Tiers reflect fuel product unit pricing. Typically tiers would be used for day/night pricing
and/or altered mode of operation for a dispenser (e.g., full service during the day and
self service during the night).

Trailer A logo that is printed at the bottom of a customer receipt; usually used for advertising
messages.
Unit Price For fuel, Unit Price is the price per unit volume; e.g., dollars per gallon. For non-fuel

items, unit price is the price per single item.
Universal Product Code (UPC)

The standard bar code symbol for retail food (and non-food) packages in the United
States.

Volume Volume usually denotes a quantity of fuel dispensed from a pump. Units of volume are
either liters, gallons, or imperial gallons.

Wayne Plus/3 The previous Wayne Dresser USA product family which includes pump control, ECR,
and card processing capabilities.

Weights & Measures (W&M)

Weights & Measures refer to the governing regulators for fuel dispensing
equipment; e.g., the National Institute of Standards and Technology in USA, and
Physikalisch-Technische Bundesanstalt (PTB) in Germany.

B LIST OF ACRONYMS

ANSI American National Standards Institute.

BAC Bill Acceptor

CHS See Card Handling System.

CAT See Customer Activated Terminal.

Cbhu See Customer Display Unit.

CPS See Card Processing System.

DEA Data Encryption Algorithm.

DES Data Encryption Standard. Adopted by the National Bureau of Standards for unclassified
applications.
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DSC Discount / Service Charge. See Discount or Service Charge.

ECR See Electronic Cash Register.
HALO See High Amount Lockout.

IPT See Indoor Payment Terminal.
LALO See Low Amount Lockout.

PC Personal Computer. Usually refers to an IBM PC or compatible computer system.
PIN See Personal Identification Number.
PLU See Price Lookup.

POS See Point of Sale.

PTS See Push to Start.

SKU See Stock Keeping Unit.
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